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MiCONTACT CENTER for SKYPE
MiContact Center for Skype is a streamlined contact center solution that integrates with Microsoft
Skype for Business. This voicemedia communication system supports soft phone and integrated
hard phones and enables sophisticated ACD routing, agent presence, instant messaging, and real-
time and historical reporting for the 100 - 200 seat contact center.

The familiar Microsoft look and feel inherent in MiContact Center for Skype helps make it an ideal
contact center solution. Reports are produced inMicrosoft Excel and proficiency is quickly gained by
both agents and supervisors due to the familiar and easily navigable user interface. As your business
grows, MiContact Center for Skype grows with you; it is easy to expand by adding agent seats and
functionality.

ABOUT THIS USERGUIDE
To report an issue with this document, please email micctechpubs@mitel.com.

The following describes the information included in each section of the user guide.

MiContact Center for Skype

This section describes

l The features and benefits of MiContact Center for Skype
l The layout of the user guide
l Document conventions

Contact Center Planning and Management

This section provides information on how to plan andmanage your contact center, including how to

l Establish a corporate Service Level objective
l Collect data
l Forecast the Call Load
l Calculate the resources required
l Schedule agents
l Determine contact center costs

Services and Database Administration

This section describes how to perform database andmaintenance functions

Management Console resides in the Contact Center Client real-time application. UsingManagement
Console, you can

l Back up and restore YourSite database configuration data.
l Update the server IP address
l Import configuration data used to configure the YourSite database
l Run themaintenance routine
l Summarize data for running reports
l Create a support package
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Configuration

This section describes how to

l Configure contact center devices so you can view real-time activity and generate reports on
these devices

l Perform Active Directory Synchronization
l Configure alarms
l Create Business Hour Schedules
l Implement security measures to restrict user access to specific application areas and devices

Real-Time Monitors

This section describes how to

l View real-time agent and queue statistics on real-timemonitors
l Configure alarms for agent and queue performance
l Customizemonitor display characteristics
l Chat online with agents or supervisors
l Silent monitor calls

Skype for Business and Ignite for Skype

This section describes Skype for Business and Ignite for Skype functionality and details how to

l Handle calls
l Request help
l Send instant messages
l View agent status and availability
l View agent and queue statistics
l Communicate using the Emergency Routing Chat IVR

Reports

This section describes how to

l Generate on-demand reports
l Set up timetables for generating reports

Forecasting

This section describes how to

l Create forecasts
l Export forecasts to Excel

Data Mining

This section describes how to

l Search for agent and ACD queue event records
l Search for specific contact center events
l View the historical real-time events that occurred on a particular date, in the sequence they
occurred
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Data Collection

This section describes how to

l View data and system alarms
l Verify media servers are receiving telephone system data

Interactive Contact Center

This section describes how to

l Control the availability of agents and ACD queues

LOCATING THE LATEST VERSIONSOF OURGUIDES
Mitel recommends you obtain the latest version theMiContact Center for Skype guides from the
Resource Center at http://micc.mitel.com.

DOCUMENT CONVENTIONS
This document uses the following conventions.

UI syntax

The following terms apply to actions you perform on the UI:

l Click precedes options you select with themouse, such as buttons, menus, and items in list
boxes.

l Press precedes keys you use on the keyboard.
l Select or clear precedes options you turn on or turn off, such as check boxes.
l Select precedes options you select in combo boxes (text boxes with attached list boxes)

For example,

1. Click OK.
2. Press Enter.
3. Select thePFdatabase check box.
4. Drag and drop the name to theAvailable list.

Italics

Italic typeface is used

l For emphasis (for example, hot desking)
l To set off words, letters, and numbers referred to as themselves in the text (for example,
overflow is the routing of calls to more than one queue; the application saves text files as
MMDDYYYY.sql)

Bold

Bold typeface designates paths you select in your root directory and items you click, press, type, or
select.

http://www.prairiefyre.com/
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For example,

1. Click OK.
2. Delete 50 and type 60.
3. Select theCheck database integrity check box.

UI menu items

UI menu items you select are separated by an arrow [=>]. For example, File=>Open tells you to
select the Open submenu on the File menu.

Note

The wordNOTE: designates essential user information.

SEARCHING FORKEYWORDSANDDEFINITIONS
The Help Documentationmenu displays the user guides and installation guides available. The
documents are in .pdf format and will open in your browser in Adobe Reader or Adobe Acrobat. The
first time a key word or acronym is used in the guide it is defined.

To search for a key word or definition in the guide, such as ACD

1. Click Help=>Documentation.
2. Select theMiContact Center for Microsoft Skype User Guide.
3. On the Adobe toolbar, click theBinocular icon to search for key words or definitions.
4. AfterWhat word or phrase would you like to search for? typeACD.
5. Click Search.

The Table of Contents opens and the first instance of ACD is highlighted.
6. UnderResults, click theACD hypertext link to locate the next instance of ACD.

TROUBLESHOOTING ASSISTANCE
For the latest frequently asked questions and troubleshooting information, see theMitel Knowledge
Base at http://micc.mitel.com/kb/Tags.aspx?Tag=Lync+Ignite.

To further support the troubleshooting process, you can find log files at the following locations:

l The Enterprise Router Service logs are located here: C:\Program Files\prairieFyre Software
Inc\CCM\Logs.

l The SIP Listener Service logs are located on the Front End Server here: C:\Program
Files\prairieFyre Software Inc\CCM\Logs.

l All other Services log to here: C:\Program Files(x86)\prairieFyre Software Inc\CCM\Logs.

REQUIRED ANDOPTIONAL SOFTWARE COMPONENTS
MiContact Center for Skype Version 5.10.9 has a number of required and optional applications you
install on client computers. These components are included in the installation or can be downloaded
directly fromMicrosoft.

http://micc.mitel.com/kb/Tags.aspx?Tag=Lync+Ignite
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REQUIREDCOMPONENTS
In order to useMiContact Center for Skype applications, the following components must be installed
on client computers. For detailed information, see theMiContact Center for Microsoft Skype
Installation Guide.

l Microsoft .NET Framework enables your computer to run applications created with .NET. All
client computers must have .NET Framework 3.5 SP1 or greater installed.

l All client computers must have .NET Framework 4.5 installed.
l Microsoft Internet Explorer updates your browser software to the latest version. All client
computers require Internet Explorer 8.0 or greater. If you are running IVR Routing, you require
Internet Explorer 9, 10, or 11 in order to access the Callback Requests and IVR Endpoints
monitors.

l Microsoft Report Viewer 2005 Redistributable Package includes Windows Forms and
ASP.NETWeb server controls for viewing reports designed usingMicrosoft reporting
technology.

l WebServices Enhancements (WSE) 3.0 for Microsoft .NET is theMicrosoft .NET
Framework version 3.0 redistributable package that installs the common language runtime
and associated files required to run applications developed to target the .NET Framework.

l Microsoft DirectX significantly enhances graphics, sound, music, and 3-D animation in
Windows applications.

OPTIONALCOMPONENTS
You can install the following application on client computers.

l Adobe Reader enables you to view documents in .pdf format. You require Acrobat Reader to
view the online user guides. If you haveMicrosoft Excel you can use it to view reports, which
are in .xls format.

NOTE:Protected View is aMicrosoft Office security feature that can impact your ability to view
Excel reports. If you use Excel 2010 or 2013 to view reports, configure the following in Excel:

l Ensure the following Protected View options are not enabled:
l Enable Protected View for files originating from the Internet
l Enable Protected View for files located in potentially unsafe locations
l Enable Protected View for Outlook attachments
l Enable Data Execution Preventionmode

l Ensure that the following Trusted Location option is selected:
l Allow Trusted Locations onmy network (not recommended).

CLIENTCOMPONENTPACK
Client Component Pack contains all of the Contact Center Management software components that
contact center employees could need on their computers. You require administrator privileges to run
this installation.

You can install Client Component Pack on individual client computers or servers runningWindows
Clients.
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The Client Component pack installs:

l Ignite for Skype
l Client Role Selector
l Contact Center Client
l YourSite Explorer
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CONTACT CENTER PLANNING AND
MANAGEMENT

Effective contact center management involves having the right resources in place at the right times
to handle an accurately forecasted workload at the desired level of service. Commitment to a
systematic planning andmanagement strategy is essential. The strategy is based on corporate
objectives that you continually assess and refine. Whether you aremanaging a start-up contact
center or refining the performance of an existing operation, the process illustrated in Figure 1 applies.
It is the basic framework for achieving andmaintaining your service objectives.

Figure 1: Planning cycle
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The objective of contact center management is to find the right balance between the agents
scheduled and the service provided to customers. This involves assessing and re-assessing trade-
offs between the Service Level, agents scheduled, and average call duration for a knownCall Load
for each 15-minute or half-hour interval of the day. Collecting, properly interpreting, and applying
ACD and other information allows you to accurately forecast the workload and schedule sufficient
agents to meet your service objectives.

STEP #1 ESTABLISH A CORPORATE SERVICE
OBJECTIVE

The Service Level % is a performancemetric contact center managers use to determine what
proportion of customers receive 'good' service. Using the Service Level %, you can gauge the level
of service that customers experience, from a historical and a real-time perspective.

Defining and adequately funding a service objective should be closely tied to your corporatemission.
The service objective identifies the average length of time a caller waits for an available agent. It is
the basis for planning and budgeting and links the resources you require to your service objectives.
Choosing a service objective is the first step in a comprehensive planning andmanagement solution.
Once you set a service objective, you should routinely assess it to see how consistently you are
meeting it, on a 15-minute or half-hour basis.

Contact centers in different industries use different criteria for measuring service. Your service
objective should reflect the type of service being provided and the expectations of callers seeking
the service. For example, a company that sells magazine subscriptions has less to lose in the
outcome of any one call than a car dealership does. A caller to a credit card 'Lost or Stolen' linemight
expect different service than a caller to a customer service department at a bank. Contact center
metrics across industries are designed to reflect this.

Performance targets must suit the primary function of a contact center. In revenue-based contact
centers where agents sell products or services, the net revenue per call is considered when defining
a service objective. Revenue-based contact centers strive to provide a high level of service with
minimal blocking and delays.

UNDERSTANDING THESERVICE LEVEL
The Service Level is expressed as a percentage of a statistical goal: it specifies the Service Level
Time and the Service Level % goals for the queue or agent group.

The Service Level is expressed as X percent of calls handled in Y seconds or less, such as 80
percent of calls handled in less than 20 seconds. Why is Service Level the standardmeasurement of
service? Service Level provides themost accurate representation of the callers’ experience. It is
ultimately the caller who decides what constitutes good service, and whether or not to end a call. It
applies to inbound transactions that must be addressed as they arrive.

When a caller enters a queue, the call is processed in one of three ways:

l An agent answers the contact (handled contact).
l The client disconnects before an agent answers (abandoned contact).
l The contact is removed from the queue, and sent to another handling point (for example, to
voicemail, an automated attendant, or another queue), (Interflowed contact).



MiContact Center for Microsoft Skype User Guide

11

For detailed information on Calls Offered, Calls Handled, Calls Abandoned, Calls Interflowed, and
other Service Level parameters see "Choosing a Service Level goal" on page 12.

UNDERSTANDINGWHYTHESERVICE LEVEL IS THEMOST
MEANINGFUL STATISTIC
The Service Level is one of many ACD statistics used tomeasure performance. Each statistic has
its purpose. For example, theGrade of Service (GOS) statistic relates trunk use to the level of traffic
and indicates the likelihood an attempted call will receive a busy signal. It is expressed as a decimal
fraction. For example, a GOS of P.02means a caller will have a two percent chance of receiving a
busy signal. Since trunk costs are insignificant compared to agent costs contact centers are well
advised to schedule sufficient trunks, abandons should beminimal.

A delayed call is a call placed in the ACD queue because it cannot be answered immediately by an
agent. The probability of delay statistic relates the number of agents or extensions to the level of
traffic carried by the trunks and indicates the likelihood and amount of delay experienced. TheGOS,
probability of delay, andQuality of Service rendered by agents provide vital information about the
callers’ experience. (See Figure 2.)

Figure 2: Service criteria

TheGOS and probability of delay contribute to our understanding of what happens to the calls not
answered in Y seconds, and givemeaning to Service Level. Service Level is the primary statistic
used in planning and budgeting because it is themost stable measurement of queue activity.

The following statistics are alsomeaningful contact center indicators:
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ASA

TheAverage Speed of Answer (ASA) is an ACD statistic that measures how long the average caller
waits on hold before the call is picked up by an agent. ASA is a valuablemeasure of service quality,
but is oftenmisinterpreted. The average does not represent what is typically experienced by
individual callers. Most calls are answered by agents more quickly than the average, but a small
percentage of callers wait several minutes in queue. ASA is a useful parameter, but Service Level is
amore reliable indicator of what callers experience.

Abandonment

ACDs collect statistics on how long callers wait before abandoning calls, and what percentage of
calls are abandoned. Unfortunately, abandonment is difficult to forecast because it is impossible to
predict caller behavior with any reliability. Sometimes when the Service Level is highmore callers
abandon than expected. There are no industry standards for abandonment. It is a somewhat
unreliable measure of contact center performance. However, abandonment statistics assist in
planning Service Levels, and provide valuable information used to create in-queue andmessage-on-
hold announcements.

CHOOSING ASERVICE LEVELGOAL
Contrary to popular belief, there is no industry standard Service Level. Some contact centers base
their Service Level goal on the targets of similar companies in the same industry. In doing so, they
assume these companies are actually meeting their intended targets. Companies are setting
increasingly rigorous Service Level targets in sectors where outstanding customer service is the
norm. In a survey of over 100 UK contact centers, Opta Consulting was surprised to find an average
performance target of 90 percent of calls answered in 15 seconds. They found that companies
setting extremely rigorous targets did not necessarily meet them, and the investment required to
achieve 'best in class' targets was difficult to justify.

Setting an appropriate Service Level goal for your contact center is not easy. Themotivation and
expectations of your customers, the availability of similar goods or services, the Service Level
targets of same-industry companies, and the value of calls are things to consider. It may be useful to
run some calculations to determine the trade-offs in Service Level associated with adding or
removing an agent, and implement customer satisfaction surveys. When defining your corporate
Service Level, consider several factors and rate their relative importance.

An appropriate Service Level is one that

l Satisfies callers’ expectations for service
l Minimizes the number of abandoned calls (ideally under five percent)
l Minimizes expenses andmaximizes revenue
l Satisfies the expectations of support staff, supervisors, and senior management

Consider this modest objective. For a Service Level of 80 percent of calls answered in less than 20
seconds, callers receive the following service:

l Approximately 30 percent of callers experience a delay in queue.
l The longest wait time is approximately threeminutes.
l The average speed of answer is approximately 12 seconds.

Is this acceptable service for you and for your callers?
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UNDERSTANDING QUALITYOFSERVICE
Agent statistics reflect the time agents spend in various states and are used to assess agent
performance. The average time an agent spends handling contacts and in theMake Busy, Do Not
Disturb, Unavailable, andWrap Up states directly affects the agent’s availability and the Service
Level provided to callers.

Service Level alone does not ensure customer satisfaction. The quality of the interaction between
the caller and agent leaves a lasting impression. Quality of Service reflects an agent’s ability to
provide excellent service to each customer. The knowledge of the agent, the accuracy and
completeness of the information provided, and the courtesy extended to the caller contribute to the
caller’s experience.

MONITORING SYSTEMSANDTOOLS
The followingmonitoring systems and tools help you evaluate the performance andmanage the
quality of service of your contact center.

IT support systems

Information Technology (IT) support systems are commonplace in contact centers. Contact center
agents divide their time between listening to customer requests, entering and updating customer
information and other entries, searching for required information, and providing feedback to
customers. In order to provide prompt and complete information, agents must have immediate online
access to information including customer records and case histories, products and services, and
company policies and procedures.

The push to increase agent efficiency and customer service has placed new demands on computer
information systems and information technology. Information products that enhance agent
productivity are continually being developed. Contact center systems are designed to incorporate
some, or all of the following specialized support functions.

CTI

Computer telephony integration (CTI) is themerging of computers and telephone systems. Today’s
computer-based telephone systems deliver synchronized voice and data, voice and data
conferencing, automatic information retrieval for calls, caller-basedmessaging and routing, and
desktop productivity tools. You can use customer databases in call handling to enhance customer
service and agent productivity.

ANI

Automatic Number Identification (ANI) identifies the telephone numbers of callers to your contact
center, so agents can receive screen pops with calls. You can connect a database to your telephone
system to simultaneously send calls and caller information. The telephone system forwards the
caller’s telephone number to a software application that relays database records on the caller to the
agent. Alternately, the caller enters an ID number that the database associates with a set of records
for the caller and the agent is sent the information.
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ANI saves agents time since they do not have to ask for and enter a name for a caller, and wait for
the database to respond. This time savings significantly impacts staffing requirements and
telephone service charges. ANI also identifies telephone numbers of callers who abandon calls so
they can be contacted later for potential business.

Reports can identify the volume of usage and costs of internal line numbers, and help you track the
long distance distribution per line number andmaximize long distance efficiency.

DNIS

Dialed Number Identification Service (DNIS) is a feature of toll-free lines that identifies the telephone
number the caller dials. This assists agents who handle calls for more than one business or product
line. Each business or product line has its own toll-free number. When a caller dials a toll-free
number, the telephone system forwards information to the agent so the agent can identify who the
caller dialed. For example, a caller dials a toll-free number for a cruise line. The telephone system
sends a script to the agent along with the call. The agent then knows to answer 'Goodmorning.
Thank you for calling Southern Cruises,' instead of the name of another cruise line serviced by the
center.

AUTOMATING HELPDESKWORKFLOW
Agents at IT help desks require quick access to customer information and call history, and the ability
to rapidly log all of the support calls and incidents. Advanced help desk packages offer automated
desk help workflow systems. They assist agents in logging service requests (tickets), dispatching
them to prioritized queues or agents, tracking them, and documenting activities.

External applications, help desk operators, or end users (in web-based applications) generate
tickets. The system generates themmanually, or in some cases automatically, in response to
system events. It can correlate multiple incidents with single tickets, andmultiple problems with a
single call.

Automated help desk workflow systems track each step taken in answering a call, with automatic
time stamping of all of the referrals, escalations, reminders, alerts, and email notifications. Calls are
prioritized and referred to other departments without reassignment, reassigned (escalated) to other
technicians or specialized staff, and placed in an alert condition when they are not resolved
promptly. Activities are date and time stamped automatically. Most help desks offer outgoing email
notification and paging. Some help desks offer automated logging of incoming emails, and
automated call acknowledgment emails to clients.

STEP #2 COLLECT DATA
Telephone systems generate an enormous amount of real-time and historical data used in planning
andmanagement of your contact center. You use real-time data tomonitor the current Call Load and
agent availability sominute-to-minute adjustments can bemade. You use historical information in
forecasting, staffing, and scheduling. Other critical management information comes from customer
surveys, market studies, employees, external departments, telephone networks, workforce
management systems, competitors, and themedia. Data collection is a continuous process you
implement as soon as your telephone system is up and running.
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Telephone systems provide detailed report data on every aspect of call transactions. You can
program computer-based telephone systems connected to a Local Area Network (LAN). Users on
the LAN can view or print real-time and historical reports. Using web-enabled telephone systems,
you can view and generate reports in aWeb browser. You canmonitor contact center activities
remotely, and distribute reports to people on different networks.

COLLECTING DATAONCALLHANDLING
Contact center reporting software displays real-time telephone system data on desktopmonitors and
wall signs. Using real-time data, you canmanage current conditions and ensure agents respond to
changing contact center events. The telephone system provides information on call activity, agent
activity, and queue activity.

You can use historical data in forecasting and in assessing the performance of your resources.
Historical reports provide vital information on load activity, resource activity, and queue activity.

CTI provides in-depth information on call transactions. Detailed information on keystroke
sequences, databases searched on, and on-screen assistance provides a clear picture of agent
activities. Using ANI data, you can identify callers by area code and collate information on
demographic trends in caller behavior.

Workforcemanagement systems use telephone system data to forecast and schedule agents.
Some packages monitor the real-time adherence of agents to scheduled activities, so you know the
number of agents currently logged on and available to handle calls. Workforcemanagement systems
collect and store real-time adherence data. This data provides a historical account of adherence
used in agent assessment.

Customer surveys provide valuable supporting information on callers’ tolerance to delay, and
expectations for service. They address some of the following questions: Was the agent accessible?
Was the caller put on hold for too long?Was the agent courteous and responsive tomy request?
Was the agent well informed? Did the agent provide the correct information and keep commitments?
Contact centers use this information to estimate the repercussions of poor service: escalated costs,
duplication of work, lost customers.

As the economy moves towards individual, personalized services, new ways of handing calls
continue to emerge. These new features add to the complexity of collecting andmeasuring
information. It is vital you establish an integrated, reliable system for measuring the key indicators of
performance: the efficiency of call handling, the service that callers experience, and their
perceptions of that service.

STEP #3 FORECAST THE CALL LOAD
Finding the right balance between resources and traffic volumes is a critical step in effective contact
center management. Estimating resource requirements is particularly challenging as the number of
calls and the total duration of calls expected for a given time interval is difficult to predict.
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Forecasting impacts contact center operations and performance in the following ways:

l The number of blocked and abandoned calls
l The level of service provided to callers and callers’ perception of service Agent workload, call
behavior, and retention

l The accuracy and usefulness of schedules
l The success of periodic sales campaigns

FORECASTING ACCURATELY
Forecasting is an imprecise science. The accuracy of your forecast increases markedly with the
size of your data sample. You take a year (or preferably two or three years) of ACD queue traffic
data, examine trends in Call Load patterns, break down the information, and determine the ACD
Handling Times of the calls. You thenmodify the forecast based on current contact center activities
and other considerations, such as absenteeism, agent breaks, holidays, and training.

The range of forecast dates you specify depends on the purpose of the forecast. Using long-term
forecasts, you can estimate future budgets and expansion opportunities, and establish corporate
objectives. Using short-term forecasts (of one to threemonths) you can determine seasonal staffing
requirements, plan for short-term sales campaigns, and assess upcoming hiring needs. You can use
weekly, daily, hourly and half-hour forecasts to tweak agent schedules and adjust for absenteeism.

CONDUCTING FORECASTS
Conducting a forecast involves accurately estimating the three components of Call Load: the ACD
Handling Time, Wrap Up Time, and Calls Offered. After you run a forecast, it is useful to examine
the data andmake adjustments based on present contact center conditions. You tweak the forecast
by adding or reducing calls based on your intuition and on information gathered by yourself and
others.

To forecast the agent requirement, you

1. Examine trends in Call Load patterns.
2. Break the information down in tomonthly, weekly, daily, half-hour, and 15-minute intervals

that reflect Call Load patterns.
3. Determine the handling times of calls
4. Modify the forecast based on current contact center activities and other considerations, such

as absenteeism, agent breaks, holidays, and training.

Youmay need to consider the following issues: hardware or software system changes, expected
callers, advertising andmedia, changes to your products, services, or pricing, new products, product
performance, competitors' actions, and international, national, and corporate events. It is vital to
have a systematic forecasting process in place that all of the departments support. For detailed
information on Call Load, ACD Handling time, Wrap Up Time parameters, see "Forecasting terms"
on page 178.
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STEP #4 CALCULATE THE RESOURCES REQUIRED
You calculate the agent requirement in conjunction with the telephone system requirement. The
number of available agents affects the likelihood and length of delay experienced by callers. The
delay affects the load the telephone systemmust carry. Because the number of available agents
impacts the telephone system requirement, you calculate the agent requirement first.

The Erlang C formula uses your historical Call Load and Average Talk Time data to predict the agent
requirement for the time interval and date range in the forecast. The resultant spreadsheet displays
the Call Load and agents required across time intervals.

PREDICTING AGENTREQUIREMENTS
Agent costs account for over 60 percent of all of the contact center costs. Accurately predicting the
agent requirement, making themost effective use of agents, and standardizing andmonitoring agent
activities are paramount to achieving your service objectives. Agents are your most valuable
resource and as such you shouldmake team building and teammanagement a high priority.

You can predict the agent requirement for your Service Level Percentage and Service Level Time
targets by applying the Erlang C equation to the estimated Call Load and Average Talk Time.

UNDERSTANDING ERLANG C
Staffingmodels consider important factors unique to the inbound contact center environment:

l Call arrival is random.
l Consolidating resources allows the same number of contact center agents to handlemore
calls while maintaining Service Levels

l Maintaining high Service Level targets requires staffing a large number of agents that will be
idle a significant portion of the day

The industry standard Erlang C equation operates on these three principals. Most contact center
reporting packages use Erlang C. An Erlangmeasures telephone traffic, or the flow of calls, and call
attempts to your contact center during a given period. One Erlang equals one hour or 60 x 60 = 3,600
seconds of telephone conversation. This could be one call lasting one hour, six calls lasting 10
minutes, or any combination of calls and call durations that equal 60minutes. The Erlang formulas
provide amathematical basis for making predictions about randomly arriving workloads.

Agent and delay calculations use the Erlang C equation. It predicts the resources required to keep
delay times within your Service Level objective. Three variables influence the delay time: the number
of agents, the number of waiting callers, and the average time it takes to handle each call.
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Limitations of Erlang C

Erlang C has fundamental principles that do not reflect real-world circumstances. It assumes all of
the calls reach the contact center and all of the callers wait indefinitely to reach agents. Because
Erlang C assumes no blocking or abandons, it may overestimate the agents you need. Erlang C
requires accurate information on call flow where voicemessaging and call overflow are employed,
assumes your Call Load prediction is extremely accurate, and assumes you have the same number
of agents handling calls the entire half hour.

Although Erlang C has its limitations, it is the preferred planning tool as it provides reasonable traffic
estimates for contact centers that maintain good service.

Considerations when predicting resource requirements
Erlang C provides theoretical numbers for staffing that you need to assess in light of the following
contact center realities:

l The contact center blocks a certain proportion of calls and some callers abandon their calls.
l Talk time is unpredictable, and althoughmost calls may last two to threeminutes, a few calls
can last upwards of an hour.

l Agents in trainingmay require more time to process calls.
l Agents may use wrap up (after-call paperwork) time inconsistently during busy periods.
l Not all of the agents within an agent group are available at all times to handle calls offered to
the agent group.

Erlang C predicts staffing needs fairly accurately. However, contact centers that use skills-based
routing, overflow, interflow, and advanced routing options need to use intuition and experience in
adjusting the final numbers.

The Erlang C formula uses your historical Call Load and Average Talk Time data to predict the agent
requirement for the time interval and date range in the forecast. The resultant spreadsheet displays
the Call Load and agents required across time intervals.

PERFORMING 'WHAT-IF' SCENARIOS
After you run a forecast, you can perform 'what-if' scenarios on the resultant data by changing the
value of forecast parameters and recalculating the results. You can enter values for the ACD Calls
Offered, average ACD Handling Time, Wrap Up Time, and Service Level Percent and Time and
recalculate the number of agents required. For example, you can reduce the average handling time
and recalculate the agents required and the calls handled across 15-minute time intervals for the
shift.
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UNDERSTANDING THERELATIONSHIPBETWEENAGENTS
ANDTRUNKS
You are already familiar with the terms GOS (probability of blockage) and Service Level (average
wait time).

The following definitions are essential to understanding the relationship between agents and trunks.

Delay

Trunk calculations assume no queueing. For trunk calculations, the delay includes the time from
when a trunk picks up a call until an agent answers it.

Agent Load

TheAgent Load includes the ACD Handling Time andWrap Up Time. See "Understanding reports"
on page 160.

Trunk Load

The Trunk Load includes the time from when a trunk picks up a call until the agent finishes speaking
to the caller and disconnects. The Trunk Load does not includeWrap Up Time.

Callers expect to have a 95 percent or better chance of obtaining a free trunk in to your contact
center, and expect to connect to an agent within a reasonable amount of time. Theremust be
sufficient trunks available to pick up calls, and sufficient agents available to handle the level of traffic
carried by the trunks. Themore agents handling a given Call Load, the less delay callers’ experience.
Callers experience a delay if there are insufficient agents available. If the delay is considerable, calls
back up and some calls do not reach the contact center.

Traffic engineering involves estimating the number of trunks and amount of communications
equipment needed to service an anticipated number of callers. It revolves around basic questions
concerning the relationships between service parameters and trunk and agent resources. How much
traffic can a particular number of trunks handle for a particular GOS?What is the GOS for a particular
number of trunks and traffic level? How many trunks are required to handle a particular traffic level
andGOS?What is the probability of delay and length of delay experienced for a particular traffic level
and number of agents? How many agents are required to handle a particular traffic level for a given
set of delay characteristics?

UNDERSTANDING ERLANG B
Contact centers use the Erlang B equation to estimate the number of trunks required. Erlang B
assumes calls are not queued and that callers who receive a busy signal do not attempt to call again.
It can underestimate the trunks required. One Erlang equals one hour or 60 x 60 = 3,600 seconds of
telephone conversation.

Predicting your trunk requirement involves

l Determining your Busy Hour Traffic (BHT)
l Deciding how many blocked calls you can tolerate, or Grade of Service (GOS)
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BHT

TheBusy Hour Traffic (BHT) statistic, measured in Erlangs, is the number of hours of call traffic (or
trunk traffic) you experience during the busiest hour of operation. It is important that your busy hour
figure represent the busiest Call Load your trunks will ever receive, and not just today’s peak traffic.
BHT is the (average call duration + average delay) x calls per hour ÷ 3600. This value represents the
highest Trunk Load (occupancy) in hours.

The call center traffic is the average number of trunks busy during the hour in question. One Erlang
equals one hour, or 60 x 60 = 3,600 seconds of telephone conversation. If a contact center
experiences 6.12 erlangs (or 6.12 hours of telephone conversation) during an hour, an average of six
trunks were busy.

GOS

TheGrade of Service (GOS) value is a decimal fraction. A GOS of P.02means a caller has a two
percent chance of receiving a busy signal. Contact centers useGOS in calculating the number of
trunks required. It is important to specify a GOS that is right for you in order for the trunk calculation
to be realistic.

STEP #5 SCHEDULE AGENTS
Scheduling involves accurately forecasting the workload and determining which agents should work
which shifts. This has traditionally been a labor-intensivemanual process for contact center
supervisors. You can schedule agents for breaks, split shifts, ACD and non-ACD work periods,
repeating work patterns, holidays, and on call work. You can categorize agents by pay level,
overtime eligibility, skill level, employment status (part time or full time), and scheduling preferences.
Matching these shift and agent variables to the anticipated workload, and re-allocating agents in
response to employee absenteeism can be a daunting task.

Scheduling is becoming increasingly challenging, as contact centers support a wider range of
products and services, and agents require more frequent and specialized training. Advances in
technology have automatedmany agent tasks and have resulted in more varied and challenging
calls and responsibilities.

Accurately forecasting and building schedules that reflect the workload as it changes across
intervals for days of the week, weeks of themonth, and seasons of the year is essential in meeting
your service objectives. You need a schedule that accurately matches agents to the anticipated
workload and agents who aspire to adhere to the activities scheduled.

You can track the availability and activities of agents throughout the day and verify agents are
performing the duties for which they are scheduled. Not adhering to the schedule, such as forgetting
to log out for a break, or performing non-ACD work when scheduled to perform ACD work adversely
affects your Service Level and themoral of other agents whomust compensate for the unavailable
agent.

UNDERSTANDING THESHRINKAGEFACTOR
Accurately forecasting the workload and scheduling agents to satisfy your Service Level objective is
a good start, but does not account for the activities that prevent agents from sitting at their desks and
handling telephones.
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Agents scheduled for ACD work can be involved in some of the following activities:

l On a bathroom break
l Making or receiving personal calls
l Conferring with the supervisor or another agent
l On the phone with other departments
l Sending emails or faxes
l Involved in a lengthy, difficult call
l Prolonged in after-call work
l Absent due to illness or compassionate leave

To account for short-term or daily unscheduled absences, you can calculate the rostered staff factor
(Shrinkage Factor). TheShrinkage Factor is a numerical value that defines the percentage of time
agents are scheduled to work but are unavailable to handle calls. It tells you the number of agents
youmust schedule in addition to the base number of agents required tomeet your Service Level.

CALCULATING THESHRINKAGEFACTOR
You calculate the Shrinkage Factor for one or more agent groups as follows:

1. Determine the base staff forecasted by hour or half hour for the day.
2. Make a list of activities that prevent ACD agents from handling calls.
3. Add the base staff to the number of agents who are unavailable to handle calls because they

are absent, on break, at an unanticipatedmeeting, etcetera.
4. Calculate the Shrinkage Factor for each time interval by dividing the scheduled staff by the

base staff required to handle telephones.
The result is a set of Shrinkage Factors that represent the expected shrinkage by half hour.
See Figure 3.

Figure 3: Calculating the Shrinkage Factor
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Youmultiply shrinkage values against the base staff required on telephones when setting future
schedules. If your agent requirements vary considerably on certain days of the week, you can
calculate a separate set of Shrinkage Factors for these days. Youmust use your good judgment in
identifying absences that are relevant to include in your Shrinkage Factor calculations. Anticipating
higher absenteeism on Fridays andMondays is a safe bet while factoring in daily compassionate
leave is not. As with all of the steps in contact center planning, routinely assess the accuracy of your
shrinkage predictions and adjust them as required.

OPTIMIZING SCHEDULES
Now that you have adjusted your agent requirement to account for unanticipated absences, the next
step is to design a schedule that makes themost of your resources.

The following examples illustrate ways to adequately staff a contact center without having agents sit
idle during slower periods.

Scheduling split shifts

Although not everyone likes to take a long break in themiddle of a shift, for some agents split shifts
fit well with priorities outside of work. For contact centers that experience heavy call traffic in the
morning and evening, split shifts prevent overstaffing during these periods.

Staggering shifts

Staggering shifts allows you tomaintain staffing levels over busy periods or periods when agents are
on breaks. For example, one set of agents could start at 8:00 A.M., a second group at 9:00 A.M., and
a third group at 10:00 A.M. so the contact center is fully staffed when it starts getting busy mid-
morning. Alternately, you could schedulemorning and afternoon shifts that overlap from noon until
1:00 P.M. to enable themorning shift to break for lunch while the afternoon shift handles calls.

Staggering breaks

Making slight adjustments to the timing of morning, lunch, and afternoon breaks has a tremendous
effect on call handling. The Erlang C equation predicts 28 agents can handle 300 calls, each lasting
280 seconds and delayed 20 seconds.

Figure 4 illustrates that changing the availability by one agent decreases the average delay time by
five seconds, and allows the contact center to handle 16 additional calls.
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Figure 4: Staggering breaks to optimize call handling

Forecasting non-ACD work

Not all of the non-ACD work must be performed immediately. For example, call-backs to clients,
emails, and discussions with staff and supervisors can sometimes wait until less busy periods.
Forecast and schedule non-ACD work for slow times to ensure sufficient agents are available during
peak periods. Set availability priorities and regularly communicate them to agents.

Scheduling part-time agents and agents on call

When practical, scheduling part-time agents and agents on call can be an effective strategy for
topping up your pool of available agents. Scheduling agents on call is particularly useful for days of
the week and seasons when absenteeism is noticeably higher.

ROUTING CALLSTO OPTIMIZECOVERAGE
To optimize service, you can use the following routing strategies that involve resources outside of
the target agent group.

Overflowing calls to less busy agent groups

You can overflow calls from busy agent groups to less busy agent groups during peak periods. You
can route calls to agents who primarily perform non-ACD work but act as reinforcements during busy
periods, and to supervisors.

Employee call-back messaging

You can program the ACD to forward calls to voicemail so callers can leavemessages instead of
waiting for live agents. Call-back messaging helps to balance agent workloads between peak call
periods and slow periods.
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Contracting calls to customer care bureaus

Contracting calls is a growing industry. During peak periods, you can route simple, routine calls
externally to customer care bureaus. Service bureaus collaborate with contact centers to set up
scheduling andmonitoring practices, and train agents to handle calls that vary in complexity.

Employing ACD enterprise call routing

Contact centers that provide extended, or around-the-clock service, can interflow calls to other sites.
For example, you can interflow mid-day calls received by a busy center in San Francisco to agents
working the late-afternoon shift at a center in Philadelphia. This optimizes call handling without
scheduling additional agents.

SCHEDULING CONSIDERATIONS
Scheduling should be a collaborative effort. Agents have schedule preferences, and want to know
when they are working well in advance. Agents aremore likely to adhere to schedules if they are
involved in defining the conditions of schedule adherence and non-adherence, and in other areas of
the planning process.

Producing long-term schedules is less efficient than producingmonthly schedules, as contact center
conditions and agent availability are continually changing. Short-term scheduling is more accurate,
but less popular with agents. It is important to find a good balance.

Measuring scheduling accuracy

You canmeasure the effectiveness of your scheduling process. Create a line graph of the Service
Level for each half-hour interval for each day over the past week. Draw a horizontal line across the
graph to indicate your service objective. Look for inconsistencies in the service provided for different
time intervals across days, and how far you stray from your service objective.

If the Service Level is erratic, youmay have enough resources in place, but they may not be
consistently available to handle calls. If the Service Level is inconsistent at certain time intervals
across the week, or you are not meeting your Service Level objective, investigate to see if you are
adequately staffed at these times and aremaking the best use of resources. Try to assess how
consistently the agents are responding to real-time information displays. Determine if they are
restricting non-ACD activities to slow periods and adhering to the schedule.

Scheduling agents with workforce management tools

Workforcemanagement tools assist you in scheduling agents for work and holiday periods. Many
packages offer an integrated forecasting component that uses historical data to partially automate
the scheduling process for established agents. Scheduling is not entirely automated: youmust
tweak agent schedules and enter shift and agent variables for agents manually.

STEP #6 DETERMINE CONTACT CENTERCOSTS
An effective budget conveys what is currently happening in the contact center, projections for the
upcoming year, and business objectives. It is important to highlight the trade-offs between the
service provided to callers and costs to the organization by developing at least two budgets that
reflect different scenarios.
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You need to provide a clear indication of how themoney is being spent, what you are doing to reduce
or curb spending, and what equipment is required tomeet service objectives and expected growth
over the next year. Budgeting is on-going process that needs continuous refinement.

BREAKING DOWNEXPENSES
The costs associated with contact center operations include

l Loaded labor costs
Loaded labor costs include wages, fringe benefits, and facilities, and account for over 60
percent of contact center costs. This is a significant cost and underlines the importance of
accurate forecasting and scheduling.

l Equipment and automation costs
Equipment and automation costs include the cost of the telephone system, computer
systems, and furniture, and account for about five percent of total expenses.

l Transmission costs
Transmission costs include costs incurred for voice (telephone lines) and data (email, fax, and
modem) transmission, and account for 25 to 30 percent of contact center costs. Transmission
costs have decreased considerably in the past few years and are continuing to drop. In
revenue-based contact centers, toll-free lines cost approximately 15 cents per minute, or nine
dollars per hour, per line.

The following statistics help you breakdown and analyze your contact center costs:

l Cost of Delay
When insufficient agents are available to handle a given Call Load, the delay increases as
does the Trunk Load. Calls are queued. For toll-free services each call delayed in queue is a
cost to the organization. You are charged for the toll-free service from the time a trunk picks up
a call until an agent completes the call and hangs up. The expense of queueing callers is
known as theCost of Delay. Staffing affects toll-free service costs: if insufficient agents are
available and the Service Level is continually low, network costs will be high. You need to
consider the Cost of Delay when estimating the agent requirement, and closely monitor it.

l Cost per Call
You use a cost-per-call analysis to measure contact center profitability and performance. The
cost per callmeasures labor, communication, and equipment costs against the revenue
generated. You calculate it by dividing the total cost by the total calls for a particular period of
time.

l Average Call Value
You use theAverage Call Value in revenue-based contact centers. You calculate it by dividing
the total revenue by the number of calls received for a given period. Sales and reservations
environments use the Average Call Value. The value of each call is balanced against the
service provided to customers.

ANTICIPATING GROWTH
Predicting company growth is a challenging and essential aspect of contact center costing. Growth
predictions impact budgeting considerations andmust be clearly communicated to senior
management. It is useful to map out your projected costs and time frames for the upcoming year and
substantiate them with statistics and graphs. Determine when and how many resources you require,
and lead-time issues.
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SERVICES AND DATABASE ADMINISTRATION
This chapter includes specifyingmaintenance functions, backing up data, and describing
Management Console functionality (updating server IP addresses, importing configuration data
using the Quick ConfigurationWizard, running themaintenance routine immediately, summarizing
data, creating a support package, and controlling services).

SPECIFYING ENTERPRISEMAINTENANCE FUNCTIONS
The Enterprise Server is the server computer on which you installed the Contact Center
Management server software.

To specify an enterprisemaintenance function

1. In YourSite Explorer, click Enterprise.
2. Click theMaintenance tab.
3. After Zip files older than, select the number of days after which you want to zip data files.
4. AfterPurge reports older than, select the number of days after which reports will be

discarded.
5. AfterDelete maintenance logs older than, select the number of days after which

maintenance logs will be discarded.
6. AfterDelete configuration backup files older than, select the number of days after which

configuration backup files will be discarded.
7. After Time maintenance service runs, select the time at which themaintenance service

summarizes data. Themaintenance service is set to run at 2:00 A.M. by default. Select a time
for themaintenancemanager to run when your company is closed or is the least busy.

8. Click Save.

BACKING UP DATA
NOTE:We recommend you back up the SQL server data files, YourSite Database configuration
data files, and raw telephone data files to an off-boardmedia type (DVD, CD, tape, alternate network
drive) each day as a precaution in case of server failure.

In the event of server failure, you can restore your company history and configuration with

l A backup copy of .xml files.
l A backup copy of the SQL server data files.
l A backup copy of the YourSite database.
l The raw telephone system data files stored on the local hard drive.

BACKING UP .XML FILES
Themaintenance routine automatically backs up an .xml file of the YourSite database every night.
This backup file is stored in the directory: <drive>:\program files\prairiefyre software
inc\CCM\Backup Files. Themaintenance routine keeps an .xml file for each of the last 30 days
maintenance ran.
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To back up or restore the .xml files

1. Start Contact Center Client.
2. Click View=>Administration.
3. Click Management.
4. Click Configuration.
5. Click Back up/Restore configuration data.
6. Follow the steps in the Backup and RestoreWizard to back up or restore the .xml file.

BACKING UPSQLSERVERDATAFILES
You back up SQL Server data files to ensure you can replace corrupted or lost data as a result of
media problems, user errors, hardware failures, and natural disasters. Please review Microsoft
procedure for creating a recovery model that controls the backup and restores operations for a
database. See http://msdn.microsoft.com/en-us/library/ms175477%28v=sql.100%29.aspx

For detailed information on backing up SQL Server through SQL Server Management Studio, see
http://msdn.microsoft.com/en-us/library/ms187510.aspx.

Understanding SQL Server recovery models
The following section details SQL Server recovery models and how they relate to backups and disk
space usage. There are three recovery models available for use with SQL Server:

1. Simple
2. Full
3. Bulk logged

For a complete overview of SQL Server recovery models, see http://msdn.microsoft.com/en-
us/library/ms175987(SQL.90).aspx.

By default, SQL Server Express uses the Simple recovery model. Retail versions of SQL Server use
the Full recovery model. There are two things youmust consider when deciding which recovery
model to use:

1. The importance of the data being stored in the SQL Server database.
2. The amount of disk space used by the transaction log file.

The only way to recover a SQL Server database is to restore it from a SQL Server backup. The type
of recovery model you use impacts the ability to restore the database.

http://msdn.microsoft.com/en-us/library/ms175477(v=sql.100).aspx
http://msdn.microsoft.com/en-us/library/ms187510.aspx
http://msdn.microsoft.com/en-us/library/ms175987(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms175987(SQL.90).aspx
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The Simple recovery model is recommended for customers who do not have an IT department upon
which to rely for regular backups and who believe the summarization process is sufficient to re-
generate historical data. There are several things that should be considered when using the Simple
recovery model:

l The log file does not continually grow and is truncated each time a successful transaction is
completed.

l When the log file is 80% full, the log will automatically clear out old transactions and rewrite
the log file with the newer transactions.

l Point-in-time recovery is not supported with this model and the database can be restored only
from the last full or differential backup.

l This model is ideal when the data in the database is not consideredmission critical, is being
backed up periodically, or can be restored from another means, such as summarization.

The Full recovery model is recommended for customers who have an IT department that can
manage scheduled backups. There are several things that should be considered when using the Full
recovery model:

l The log file will grow until a transaction log backup is successfully completed against the SQL
Server database. Transaction logs can be applied to full database backups to ensure point-in-
time recovery, up to the time when the last transaction log backup was taken.

l Point-in-time recovery is supported with this model
l This model requires a regular backup schedule and sufficient disk space to house the log file
as it grows between backups.

Frequency and scope of configuration changes may be a suitable indicator in determining which
recovery model to use. If configuration changes are infrequent and point-in-time recovery is not
critical, the Simple recovery model may be sufficient. However, when using the Simple recovery
model, we highly recommend that SQL Server backups are performed after any significant
configuration changes have beenmade to the database.

Regardless of the recovery model used, it is strongly recommended that the data files collected are
backed up on a regular basis, as these files are used in the summarization process to re-generate
historical data.

MANAGEMENT CONSOLE
TheManagement Console application resides in Contact Center Client. UsingManagement
Console, you can administer the database, perform maintenance functions and create support
packages.

Management Console consists of the followingmenus:

l Configuration
l Maintenance
l Support
l System
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OPENINGMANAGEMENTCONSOLE
Management Console is available to users whose security permissions permit them to use
Management Console.

To openManagement Console

1. Click Start=>All Programs=>prairieFyre Software Inc=>Contact Center Client.
2. Type your user name and password.
3. Click Log on.

The Contact Center Client window opens.
4. On themain toolbar, click Administration=>Management.

TheManagement Console window opens.
See Figure 5.

Figure 5: Management Console

CONFIGURATION
The Configurationmenu enables you to update the server IP address

Updating server IP addresses
If you want to apply Enterprise Server or SQLDatabase Server IP address changes to all Mitel
applications, you use the Update Server IP Address Wizard.

To apply the IP address change to all Mitel applications

1. In Management Console, click Configuration.
2. Click Configuration.
3. Click Update server IP address.
4. Follow the steps in the wizard to apply the IP address change universally.
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MAINTENANCE
Using theMaintenancemenu, you can

l Run themaintenance routine
l Summarize data

Running themaintenance routine immediately
TheMitel Maintenance Service automatically runs at 2:00 A.M., by default. However, you can
manually invoke theMitel Maintenance Service at any time with the Runmaintenance command.

To run themaintenance routine

1. In Management Console, click Maintenance.
2. Click Run maintenance.

A message notifies you that processing is complete.

Summarizing data
The Summarize DataWizard uploads historical telephone system data to the SQL database for a
specific date range.

If you run a report and notice that data for a particular device is missing from the report output, verify
the device is programmed in the telephone system and in the YourSite database. If you determine
the device is missing from the database, add it to the database and use the Summarize command to
update Collector Service and the SQL database with the complete raw telephone system data
(stored on the local hard drive). You can then produce reports on the device.

NOTE:

l When a summarize is performed the devices not programmed in the telephone system or
YourSite database are identified and logged to an XML file located in the Logs directory. The
files are named as in the following example, summarizeInspection[29-01-2007][29-01-2007]
[29-01-2007].xml, where the first date is the current date, the second is the start date of the
summarize, and the third is the end date of the summarize.

l If you attempt to summarize data and there is no data for that date an error opens. Please
select another date.

To summarize data

1. In Management Console, click Maintenance.
2. Click Summarize data.
3. Follow the steps in the Summarize DataWizard to summarize the data.

SUPPORT
Using the Support menu, you can

l Create an Enterprise Server support package
l Create a client support package
l View contact information
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Creating an Enterprise Server support package

You can package your Enterprise Server telephone system records and YourSite configuration data
to send toMitel for troubleshooting issues using the Support PackageWizard. The Support package
formats your data in a way that helps to resolve any problems.

To create an Enterprise Server support package

1. In Management Console, click Support.
2. Click Create support package.
3. Follow the steps in the Support PackageWizard to package your telephone system records

and YourSite configuration data.
4. Click Finish.

Creating a client support package

You can package your client configuration data to send toMitel for troubleshooting issues using the
Client Support PackageWizard. The Client Support PackageWizard formats your data in a way that
helps to resolve any problems.

To create a client support package

1. In theManagement Console, click Support.
2. Click Create a support package.
3. Follow the steps in the Support PackageWizard to package your system records and

configuration data.
4. Click Finish.

Viewing contact information

Should you need to contact Mitel for support, contact information is provided inManagement
Console.

To view contact information

1. In Management Console, click Support.
2. Click View contact information.
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SYSTEM
Using the Systemmenu, you can control services.

Controlling services
Services Manager controls all Contact Center Management services andmandatory system
services. These include the prairieFyre .Net Enterprise Server, prairieFyre Auditor Service,
prairieFyre CCS Service, prairieFyre Collector Service (v5), prairieFyre Config Service, prairieFyre
Data Processor Service, prairieFyre Data Synchronization Service, prairieFyreMaintenance
Service, prairieFyre Reporting Service, prairieFyre SQLWriter Service (v5), prairieFyre Updater
Service, the prairieFyre Server Monitoring Agent, andMicrosoft's IIS Administration Service.

NOTE: If youmust restart the Enterprise Router, we recommend you do so outside of business
hours. Otherwise, calls could be lost.

To control services

1. In Management Console, click System.
2. Click Services Manager.
3. Select the service you want to control.
4. Right-click the service.

The right-click menu opens. This enables you to control the service the following ways:
l Start
l Stop
l Pause
l Resume
l Restart
l Refresh
l Restart All Running Services

5. Select the action you want to perform.
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Configuring devices and device groups
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computers
Security roles
ANI and DNIS call routing
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CONFIGURATION
MiContact Center for Skype configuration is done in both the Contact Center Management website
(CCMWeb) and in YourSite Explorer.

Security settings are specified in the YourSite database, under YourSite, in CCMWeb. All other
configuration is done in YourSite Explorer.

NOTE:MiContact Center for Skype requires the following Skype for Business Server settings under
Voice Routing=>Trunk Configuration enabled:

l Enable forward call history
l Enable forward P-Asserted-Identity date

The phrasing and location for these settings is from Lync Server 2013. This may vary depending on
your version of Skype for Business or Lync Server.

To set up the YourSite database youmust configure the

l Enterprise settings
l Media servers
l Site
l SMTP Server (optional)
l Optional additional servers
l Schedules
l Node alarms (optional)

See "Enterprise setup" on page 40.

Next, youmust configure devices and device groups as follows.

1. Add employees and employee groups.
2. Associate the employees with the employee groups.
3. Add employee divisions.
4. Associate employee groups with employee divisions.
5. Add agent groups.
6. Associate employees with agent groups.
7. Set up queue announcements.
8. Set upmusic on hold playlists.
9. Add queues.
10. Associate agent groups with queues.
11. Add queue groups.
12. Associate queues with queue groups.
13. Add extension groups.
14. Associate extensions with extension groups.
15. Add extension divisions.
16. Associate extension groups with extension divisions.
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17. Add teams.
18. Associate agent groups with teams.
19. AddMake Busy and DoNot Disturb Reason codes.

See "Configuring devices and device groups" on page 54.

YOURSITE EXPLORER
YourSite Explorer is a configuration interface that simplifies datamanagement by enabling you to
configure and administer all devices in a single application.

YourSite Explorer streamlines configuration. For example, you can

l Select multiple devices and change their attributes in one step.
l View groupmembership information on the samewindow as the devices are listed.
l View multiple windows of devices simultaneously and tab between them.
l Edit in line in an extended grid.

NOTE:YourSite Explorer enables you to havemultiple device tabs open simultaneously. As a best
practice, we recommend you only have the device tabs open that you are currently using.

STARTING YOURSITEEXPLORER
To start YourSite Explorer

l Click Start=>All programs=>prairieFyre Software Inc=>YourSite Explorer.

NOTE: Launching client-side applications from the task bar causes them to bypass the Updater
Service process. To ensure successful updates from the Enterprise Server, after an upgrade close
all client-side applications for 15minutes or reopen them from the Start menu/Start screen.

SEARCHING
When you perform searches in YourSite Explorer, you can filter on specific criteria to narrow the
search. YourSite Explorer searches on criteria you type into the Search box. The search result will
consist of all instances of the search item. For example, if you ran a search for ext, your search
result could contain: extension, text, and next time.

After you perform an initial search, you can type additional criteria in the box to narrow the search. If
no words or numbers match your search request, the resultant list will be blank.

YourSite Explorer searches on the following variables:

l Employees and Employee groups—first and last name and reporting number
l Extension groups—name and reporting number
l Agent groups—agent group ID, name, and reporting number
l Queues andQueue groups—dialable number, name, and reporting number

To search for a specific word or number

l In the Search box, type the word or number you want to find.
A list of devices that match the search criteria appears.
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PAGING
Paging enables you to specify the number of items to be included per page. You can reduce the page
size to increase the application speed. By default, the page size allows for 100 items. When
changing the page size, youmust close and re-open the device window.

To change the number of items viewed per page

1. In YourSite Explorer, click YourSite.
2. On the ribbon, click theView tab.
3. AfterPage size, select the number of items to be viewed per page.
4. Click Save.

FILTERING
The filtering bar enables you to access records alphabetically or numerically.

To filter records alphabetically

l On the filter bar, click the letter with which the record begins.

To filter numerically

l On the filter bar, click # to view records that start with numbers 0 through 9.

To reset filtering

l On the filter bar, click All to view all records.

You can filter and then search within the filtered records. For example, click F to filter for all records
that start with the letter F. Then type th to search within that list for any record with th.

CUSTOMIZING THEUSER INTERFACE
You can customize the user interface by minimizing aspects of it, changing the order of the columns,
changing column options, and adjusting the page size. This customization is referred to as a profile.
Your profile is associated with the username you use to access YourSite Explorer. Each time you
close YourSite Explorer, your profile is automatically saved. When you reopen YourSite Explorer
using the same username, the user interface displays your profile.
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MINIMIZING ASPECTSOFTHEUSER INTERFACE
To add space to the user interface so you can view additional rows of data, you canminimize the

l Filter bar
The filter bar is the bar on which the alphabet is displayed.

l Page bar
The page bar is located above the filter bar. The page number is displayed on the right side of
the page bar.

l Ribbon
The ribbon is located at the top of the user interface. The ribbon includes Home, View,
Configuration, Tools, and Active directory tabs and enables you to add devices, change the
view (horizontal, vertical, or data grid), and re-synchronize and reset clients. Ribbon attributes
change depending on the area you are viewing.

To hide the filter bar

1. On the ribbon, click theView tab.
2. In YourSite Explorer, click YourSite.
3. Clear theShow filter bar check box.

To hide the page bar

1. On the ribbon, click theView tab.
2. In YourSite Explorer, click YourSite.
3. Clear theShow paging bar check box.

Tominimize the ribbon

1. Right-click the ribbon.
2. Click Minimize the Ribbon.

The ribbon at the top of YourSite Explorer is hidden.

SELECTING THEFIRSTRECORDOFEACHLIST
You can save time by configuring YourSite Explorer to automatically select the first record on a
page.

To select the first record of each list

1. On the ribbon, click theView tab.
2. In YourSite Explorer, click YourSite.
3. Select theSelect the first record check box.
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CHANGING THEORDEROFTHECOLUMNS
You can reorder columns in either of two ways. You can drag a column heading to a different position
on the table or you can change column order using Column options. See "Changing column options"
on page 39.

To drag column headings

1. With the device window open, select the column heading to bemoved.
2. Drag it to a different position on the table.

CHANGING COLUMNOPTIONS
You can adjust the width and order of columns and hide or show columns in device windows.

To adjust columnwidth

1. Drag the column to the left or right to adjust its width.
2. Click OK.

To hide a column

1. Right-click a column heading.
The Column options window opens.

2. Select Column options.
3. Select the column heading to be hidden.
4. Click <<.
5. Click OK.

To change the order of columns

1. Right-click a column heading.
The Column options window opens.

2. Select Column options.
3. Select the column heading to bemoved.
4. Use the arrows to change the order of the column headings.

The top column appears first in the device window.
5. Click OK.

GROUPING DEVICECRITERIABYCOLUMNHEADERS
You can group devices by column heading in the grid view. For example, if you click the Site column
heading on the Employees window, you can group employees by site. Grouping enables you to
quickly select like devices andmake changes to them simultaneously. See "Makingmultiple
changes" on page 40.

To group device criteria by column headers

1. Open the device with the criteria to be grouped.
2. Click Group by.
3. Select themethod of grouping.
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MAKINGMULTIPLECHANGES
In one action, you can edit common information across multiple devices of the same type.

You can change information that is common across multiple devices only. For example, you cannot
change Name and Reporting number across multiple employees because they are specific to each
device item.

CHANGING THEYOURSITEEXPLORERVIEW
You can select from three window orientations or views: horizontal, vertical, and data grid. The
horizontal view displays information in a horizontal layout. The vertical view displays information in a
vertical layout.

The data grid view contains a table in which you can readily edit device attributes. Pressing the Tab
key enables you tomove from column to column. When viewing a device group in grid view, you can
associate members within the samewindow.

When you close YourSite Explorer and then restart it, YourSite displays the view and device
windows that were open the last time you used YourSite Explorer.

To select a particular view

1. On the ribbon, click theView tab.
2. In YourSite Explorer, click YourSite.
3. Select Horizontal, Vertical, orData grid.

ENTERPRISE SETUP
To set up your enterprise structure youmust configure the following, using YourSite Explorer

l Enterprise
l Media server
l Site
l SMTP Server
l Servers
l Schedules
l Node Alarms

CONFIGURING ENTERPRISESETTINGS
To set up the enterprise, you configure Enterprise server settings, somemaintenance services, and
email alarms.
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Configuring Enterprise server settings
To configure Enterprise server settings

1. In YourSite Explorer, click YourSite=>Enterprise.
2. Click theEnterprise tab.
3. AfterName, type the name of the enterprise.
4. After IP address, verify the IP address of the Enterprise Server.
5. If the IP address is incorrect, after IP address, type the IP address of the Enterprise Server.
6. AfterReal-time port, type the real-time port number.

The default real-time port is 5024.
The real-time port is used to communicate real-time events.

7. If you use Secure Socket Layer, select the This server uses Secure Socket Layer (SSL)
check box.

8. If you want to be notified when your warranty is about to expire, select theDisplay warranty
warning and expiration message check box.

9. If you want client applications to be automatically updated, select theAuto update client
applications check box.

10. Click Save.
11. Specify enterprisemaintenance functions.

See "Configuring Enterprisemaintenance functions" on page 41.

Configuring Enterprisemaintenance functions
To configure Enterprisemaintenance functions

1. In YourSite Explorer, click YourSite=>Enterprise.
2. Click theMaintenance tab.
3. After Zip files older than, select the number of days after which you want to zip data files.
4. AfterPurge reports older than, select the age after which reports will be discarded.
5. AfterDelete maintenance logs older than, select the age after whichmaintenance logs will

be discarded.
6. AfterDelete configuration backup files older than, select the age after which configuration

backup files will be discarded.
7. After Time Maintenance Service runs, select the time themaintenance service summarizes

data.
Themaintenance service is set to run at 2:15 A.M. by default.
Select a time for themaintenancemanager to run when your contact center is closed or is the
least busy.

8. Click Save.

Configuring email alarms
MiContact Center for Skype can send email alarms indicating when the Enterprise router or the SIP
Listener services are experiencing difficulty. Users also receive email notifications when the issue
has been resolved. We recommend you configureMiContact Center for Skype to send the email
alarms to your Contact Center Management administrators.
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Email alarms notify users of:

l The severity of the alarm
l The alarm that has been triggered
l When the alarm was triggered
l Details specific to the alarm

For example, an email alarm will indicate that the Enterprise router’s server certificate authenticating
it to Skype for Business’s server is nearing its expiration date or has expired. You can then renew the
certificate to continue operations. When the certificate is renewed, you will receive an email
notification that the alarm has been cleared. For details on configurable alarms and troubleshooting
information for specific email alarms, see theMitel Knowledge Base.

Enabling, disabling, and configuring email alarms takes place in YourSite Explorer. You can
configure the SMTP Mail Server address, the intervals at which email alarms are sent, and the email
addresses receiving the alarms.

Before you configure your email alarms, youmust have SMTP servers configured. For more
information, see "Configuring the SMTP server in YourSite Explorer" on page 52. If you want to
alarm on a site, youmust add the same SMTP server as the email alarms to that site. For more
information, see "Configuring the site" on page 51.

NOTE:

l You receive a single email alarm for a single router issue. However, if the router experiences
additional difficulties, you will receive the original alarm message along with subsequent email
alarms. The original alarm message will be in a list of active alarms. Themost recent alarm
will be at the top of the list.

l The severity of alarms is pre-set and cannot be changed.

To configure email alarms

1. In YourSite Explorer, click YourSite=>Enterprise.
The Enterprise pane opens.

2. Click theEmail alarms tab.
3. AfterSMTP Mail Server address, click the… button, select the IP address of themail

service provider, and click OK.
NOTE: The SMTP server must be configured in Your Site Explorer in order for MiContact
Center for Skype to send email alarms. For more information, see "Configuring the SMTP
server in YourSite Explorer" on page 52.

4. AfterEmail notification interval minutes, select from the drop-down list the number of
minutes between email alarms.
NOTE:Notifications of critical alarms are sent immediately after the router detects the issue.

5. AfterSend Enterprise Server alarms to the following address(es), type the email
addresses that will receive email alarms.
NOTE:Separatemultiple email addresses with commas. We recommend you type the email
addresses of Contact Center Management administrators.

6. To enable or disable email alarms, select or deselect theEnable email alarms check box.
7. On the ribbon, click Save.
8. If you have not already, add your SMTP server to your sites to enable alarming on those sites.

See "Configuring the site" on page 51.
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Configuring Contact Center Screen Pop
Contact Center Screen Pop is an application for MiContact Center for Skype that provides caller and
queue information on an agent’s screen before the agent answers a call. This feature helps agents
provide customers with personalized and responsive service.

Table 1 lists the variable from which Contact Center Screen Pop can contain information.

NAME VARIABLE
IVR ROUTING
ACTIVITY
REQUIRED

DESCRIPTION

Caller
Name %PFCALLERNAME% N/A The name of the caller

ANI %PFANI% N/A The telephone number or
SIP address of the caller

DNIS %PFDNIS% N/A The telephone number
the caller dials

Queue %Queue% N/A The queue from which
the call originated

Collect
Caller
Entered
Digits

%PFVERIFIEDCOLLECTEDDIGITS% Collect Digits

The digits the caller
enters for identification
purposes, such as a
customer site key, held
in the IVR Routing
LastCollectedDigits
variable. This variable
can display up to 50
digits. (MiContact
Center for Microsoft
Skype – IVR Routing
required. This variable
requires a Contact
Center Solutions
Version 7.1.2 or greater
Enterprise Server)

Table 1: Contact Center Screen Pop variables
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NAME VARIABLE
IVR ROUTING
ACTIVITY
REQUIRED

DESCRIPTION

Query
Results %PFQUERYRESULT% Query or

Execute

The last Query activity
or Execute activity result
in the IVR Routing
LastQueryResult
variable.
%PFQUERYRESULT%
can display up to 500
characters. (MiContact
Center for Microsoft
Skype – IVR Routing
required. This variable
requires a Contact
Center Solutions
Version 7.1.2 or greater
Enterprise Server)

Table 1: Contact Center Screen Pop variables (continued)

You configure Contact Center Screen Pop in YourSite Explorer. You can specify the information that
the pop-up displays and whether a custom application or customWeb page launches Contact
Center Screen Pop. In YourSite Explorer you can verify Contact Center Screen Pop configuration
using the sample Contact Center Screen Pop application file, ScreenPopDisplayTestForm.exe,
included inMiContact Center for Skype . Agents can also enable or disable Contact Center Screen
Pop using the Ignite for Skype icon on their desktops or task bars.

To configure Contact Center Screen Pop

1. In YourSite Explorer, click YourSite=>Enterprise.
The Enterprise pane opens.

2. Click theScreen Pop tab.
3. To enable Contact Center Screen Pop, select the Launch an application or Web page

when agents answer ACD calls.
4. To disable Contact Center Screen Pop, deselect the Launch an application or Web page

when agents answer ACD calls.
5. To launch the screen pop using an application, underContact Center Screen Pop will

launch this application or Web page:, type the application’s file path.
For example: C:\MyProgram\CustomerManagement.exe.

6. If you do not specify the path, youmust drop the .exe file into your Ignite for Skype program
folder as follows:

l For a 32-bit Windows system, go toC:\=>Program Files=>prairieFyre Software
Inc=>CCM=>Applications=>Ignite.

l For a 64-bit Windows system, go toC:\=>Program Files (x86)=>prairieFyre
Software Inc=>CCM\Applications=>Ignite.
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7. To launch the screen pop using aWeb address, underContact Center Screen Pop will
launch this application or Web page:, type the Web address.
For example, http://myintranetsite.business.com/

8. After the file path orWeb address you entered, type the names of the variables between
percentage signs.
For example: C:\MyProgram\CustomerManagement.exe “%PFCALLERNAME%”
“%PFANI%” “%PFDNIS%” “%QUEUE%” "%PFVERIFIEDCOLLECTEDDIGITS%"
"%PFQUERYRESULT%" will display the caller name, the number or SIP address from which
the caller dialed, the number the caller dialed, the queue from which the call originated, the
caller entered collected digits, and the IVR Routing query result.
NOTE:

l Variables must be enclosed within quotationmarks and percentage signs, as in the
example above. Multiple variables must be separated by a space.

l With the exception of QUEUE, variable names must be preceded by PF.

To verify Contact Center Screen Pop configuration

1. In YourSite Explorer, click YourSite=>Enterprise.
2. Click theScreen Pop tab.
3. UnderContact Center Screen Pop will launch this application or Web page:, type the

following file path:
C:\Program Files\prairieFyre Software
Inc\CCM\Applications\Ignite\ScreenPopDisplayTestForm.exe.

4. After the file path, type the names of the variables you want to display in a screen pop as in
the following example: C:\Program Files\prairieFyre Software
Inc\CCM\Applications\Ignite\ScreenPopDisplayTestForm.exe“%PFCALLERNAME%”
“%PFANI%” “%PFDNIS%” “%QUEUE%” "%PFVERIFIEDCOLLECTEDDIGITS%"
"%PFQUERYRESULT%".
NOTE:

l Variables must be enclosed within quotationmarks and percentage signs, as in the
example above. Multiple variables must be separated by a space.

l With the exception of QUEUE, variable names must be preceded by PF.
5. On the ribbon, click Save.
6. Place a call to a queue. If screen pop is configured correctly, the toaster should display, with

the variables you configured, on the agent’s desktop when the call rings through to them.

To enable or disable Contact Center Screen Pop in Ignite for Skype

1. Right-click the Ignite for Skype application icon on your task bar or desktop.
2. To enable Contact Center Screen Pop, select Turn Screen Pop On.
3. To disable Contact Center Screen Pop, select Turn Screen Pop Off.
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CONFIGURING THEMEDIASERVER
Youmust first add themedia server and then configure its location settings, system defaults for
queues and agents, routing and presence settings, SIP Listener settings, data summary options,
and Network Monitor.

We do not recommendmaking configuration changes on the Front Endmedia server in YourSite
Explorer during working hours. If configuration changes aremade while ACD calls are being routed
to agents, agents who are in the ACD statemay become ‘stuck’ in that state and not be able to
receive or handle calls again until the Enterprise Router is restarted. You can optionally configure a
timeout duration during which queues will no longer accept calls and will display as ‘offline’. Ongoing
ACD calls will continue until completion. When the timeout duration ends, the Router will attempt to
apply configuration changes. If there are ACD calls still in progress at this time, the Router will be
unable to save the configuration changes and will need to be restarted to allow ACD agents to
commence receiving calls. For information on setting the timeout duration, see the following
Knowledge Base article: http://micc.mitel.com/kb/KnowledgebaseArticle52410.aspx.

NOTE:Pools are treated as media servers in YourSite Explorer. All pool configuration options are
located under media servers in YourSite Explorer.

Adding amedia server
To add amedia server

1. In YourSite Explorer, click Media servers.
2. Click Add.
3. AfterName, type the name of themedia server.
4. AfterSite, select the site where themedia server resides.
5. AfterServer, select the computer name.
6. AfterMaintenance start time andMaintenance end time, select the time the SIP Listener

and Enterprise Routers will process updates.
If you install updates during the day, they are not processed until this time.

7. After Licensing, select the licenses to use for themedia server.
If you are not licensed for a product, the check box for that product will not display. If you have
no remaining licenses, although the check box still displays, an error message indicates that
all available licenses have been used.

http://micc.mitel.com/kb/KnowledgebaseArticle52410.aspx
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8. UnderPool
l AfterPool Domain, type the distinguished name of the pool object in Active Directory.
Check Override Default Sip Domain if required.

l AfterPool FQDN, type the fully qualified domain name of the pool.
The pool is either the default pool created by Skype for Business Standard or the pool
you created for Skype for Business Enterprise.
An IP address is not allowed.
The Pool FQDN must match the Pool FQDN from the Skype for Business Server
topology.
The certificate for the Skype for Business pool must match the Pool FQDN for routing
to function.

l AfterPool Type, specify whether this is an Enterprise or a Standard Pool.
If it is an Enterprise Pool, use FEPool.
If it is a Standard Pool, use HomeServerPool

9. UnderSystem Port Configuration, type the port numbers used for the following:
l Ignite Port - default port is 15073
l Collector Data Port - default port is 15072
l Enterprise Router Port - default port is 5071
l Listener Port - default port is 15070
l Communications Port - default port is 5061

10. AfterMusic On Hold Playlist, click ... to select the playlist to apply to themedia server.
11. Configure the location settings.

See "Configuring location settings" on page 47.

Configuring location settings
To configure location settings for themedia server

1. Click the Location tab.
2. AfterCountry, click ... and select the country where themedia server is located.
3. Click OK.
4. AfterArea, click ... and select the area code where themedia server is located.
5. Click OK.
6. Configure the System Defaults.

See "Configuring system defaults" on page 47.

Configuring system defaults
Default queue settings for timers and default agent ACD policy settings are configured under the
System Defaults tab.

ACD policy settings determine how agents aremade available to agent groups. (See Table 2.)

NOTE:Default queue settings for requeue timer and work timer will only be applied to queues that
have queue timers enabled. See "Adding queues" on page 63.
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ACD POLICY DESCRIPTION

NoPresence Control

The agent cannot control their presence options. When they log into
their computer and open Ignite for Skype, they are automatically
logged into their default agent groups and available to answer ACD
calls. The agent will not be able to change their ACD settings via
Ignite for Skype.

Agent Presence Control

Agents can control their own presence options. The administrator
can designate default agent groups with which agents are
automatically associated with upon login. However, these agents
can remove or add themselves to other groups as needed.

NOTE: If an agent has been assigned to one or more agent groups
but has not beenmarked as default in any of them, when they log
into the system they will be designated as 'Logged into System' but
not be available to any ACD groups.

Third-party Presence
Control

This setting is intended to give supervisors additional control over
agent presence. Currently, this control operates in the sameway as
Agent Presence control (both from an agent and supervisor
perspective).

Table 2: ACD Policy settings

You can customize ACD policy settings for specific agents in YourSite Explorer=>Employees. See
"Adding employees" on page 55.

To configure system defaults

1. Click theSystem Defaults tab.
2. Click theQueue Settings tab.
3. AfterDefault time before requeue, select the amount of time you want a call to ring on an

agent's desktop before being sent back to the queue. By default, the time before requeue is 3
minutes.
When the call is requeued the initial agent is placed inMake Busy and is unable to answer
ACD calls. The agent remains logged in and can receive non-ACD calls and instant
messages.

4. If you want to apply the set time against all new and existing queues, click Update.
5. If you want to apply the set time to new queues only, click Save.
6. AfterDefault work timer, select the amount of time you want agents to remain in theMake

Busy/Work Timer state.
When an agent is in work timer they cannot receive calls. At any time, either in Ignite for
Skype or Contact Center Client, an agent can cancel work timer. However, if an agent
removes themselves from work timer they cannot place themselves back into work timer.

7. If you want to apply the set time against all new and existing queues, click Update.
8. If you want to apply the set time to new queues only, click Save.
9. Click theAgent Settings tab.



MiContact Center for Microsoft Skype User Guide

49

10. Select the default agent ACD policy settings by choosing either True or False for each type of
control.
See Table 2.

11. Configure Routing and presence settings.
See "Configuring routing and presence settings" on page 49.

Configuring routing and presence settings
To configure routing and presence settings, you configure presence settings, routing, and the SIP
Listener.

Configuring presence settings
You can configure overriding agent presence states that are applied when agents

l Select Busy in Skype for Business
l Select Do Not Disturb in Skype for Business
l Enter a transition state

To ensure agents in transition states do not receive calls, supervisors can use the overriding
presence state option to automatically place them in SystemMake Busy with an associatedMake
Busy code.

We recommend that agents set their presence in Ignite for Skype, rather than in Skype for Business.
In Ignite for Skype, agents can set their ownMake Busy or Do Not Disturb reason code, ensuring
accurate records of agent activities are produced.

NOTE: By default, overriding agent presence state settings are not enabled.

To configure presence settings

1. Click theRouting and Presence tab.
2. Click thePresence tab.
3. Select the check box(es) for theOverriding Presence State(s) you want to enable.
4. Click ... and select a code.
5. Click OK.

Configuring routing settings
The Routing tab displays all of the information used in registering the Enterprise Routers to Microsoft
Skype for Business. If this information is blank, the Routers have not been registered.

The following information is automatically populated during installation. If your system configuration
changes, you can update these fields as required.

l Globally Routable User Agent URI - the registration URI from Skype for Business that
validates you are authenticated with Skype for Business

l SIP Address - the SIP address of the Routers
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To configure routing settings

1. Click theRouting and Presence tab.
2. Click theRouting tab.
3. AfterRouter FQDN, type the Fully Qualified Domain Name for the Router location.

NOTE:Youmust configure the Routing FQDN before queues can be provisioned and calls
routed.

4. UnderDefault Settings, afterMaximum Number of Forward Hops, specify themaximum
number of times you want calls to route between queues while waiting to be answered.
This option sets a limit on the number of times a call can be rerouted or interflowed.

5. Click Save.

SIP Listener settings
The SIP Listener tab contains a listing of the registration fields used by the SIP Listener. The
following fields are read-only and are automatically populated by the SIP Listener after it has
successfully registered with Skype for Business.

l Application ID- the registered ID of the SIP Listener in Skype for Business
l Application URI- the registered URI of the SIP Listener in Skype for Business
l Application Marked as Critical- if this check box is selected, Skype for Business will not
start until MiContact Center for Skype starts

l Application Enabled - if this check box is selected, MiContact Center for Skype and Skype
for Business are running consecutively

Configuring data summary options
To configure data summary options

1. Click theData summary options tab.
2. If you want to use Trace reporting, enable the Inbound/Outbound/Make Busy Trace

reporting check box.
3. If your business operates around the clock, enable the This enterprise operates 24 hours a

day check box.
NOTE: If you do not enable the This enterprise operates 24 hours a day check box, but
have agents logged in to applications overnight, youmay experience problems with shift-
related statistics, such as agent shift monitor andMake Busy Reason codes. For example, if
logged in to Contact Center Client overnight with aMake Busy Reason code, when you
change theMake Busy Reason code the following day, Contact Center Client will display
'UnknownMake Busy code'. This can be remedied by logging out of the application and
logging back in.

4. If you want to track outbound calls that were not answered, enable theCredit unanswered
outbound calls check box.

5. UnderACD Options, to store ACD redundant events, select the File all ACD stream
redundant events check box.

6. UnderAgent state timeout audit, afterClear line if agent Hold Time exceeds, select the
number of minutes or hours you are in a hold state before the telephone system clears the line.

7. AfterClear line if agent primary Talk Time exceeds, select the number of minutes or hours
you are in a single state on the primary line (ACD line) before the system clears that line.
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8. AfterChange the agent state from Ringing to Idle after, select the number of minutes or
hours after which you want the agent state to change from Ringing to SystemMake Busy.

9. EnableReset MKB/DND time in realtime after call ends check box, if you want the
MKB/DND time to reset in real time when the call concludes.

10. Configure Network Monitor settings.
See "Configuring Network Monitor" on page 51.

Configuring NetworkMonitor
To configure Network Monitor settings

1. Click theNetwork Monitor tab.
2. AfterAlarm name, click ...and select an alarm from the list.
3. Click OK.
4. If youmust create or modify an alarm that will warn you if data is not being collected for this

media server, click Manage alarms and configure an alarm.
See "Configuring node alarms" on page 53.

5. Click Save.

Deleting themedia server
CAUTION: If you delete amedia server, you will delete all of the devices associated to themedia
server.

To delete amedia server

1. InYourSite Explorer, click Media servers.
2. Select themedia server you want to delete.
3. Click Delete.

A window opens with themessage 'All of the data associated with this media server will be
permanently deleted. Are you sure you want to delete this media server?'

4. Click OK.

CONFIGURING THESITE
A site is an office location with one or moremedia servers. It can be the office where the Enterprise
Server is installed or a branch office.

To configure a site

1. In YourSite Explorer, click YourSite=>Site.
2. Click Add.
3. AfterSite name, type the name of the site.

You can add a number to the name of the site to indicate the number of sites in this location.
4. After Time Zone, select the time zone for the site.
5. AfterSMTP Server, click ....
6. Select the SMTP server and click OK.
7. Click Save.
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CONFIGURING THESMTPSERVER INYOURSITEEXPLORER
To configure an SMTP server in YourSite Explorer

1. In YourSite Explorer, click YourSite=>SMTP Server.
2. Click Add.
3. AfterSMTP Server, type the IP address or name of the SMTP server (for example,

PFEXCHANGE).
4. UnderSMTP Port, type the port number of the SMTP server.

NOTE: The default value of this port is 25.
5. After From Email Address, type the email address from which all Contact Center

Management reports will bemailed.
NOTE: The field is mandatory as some email servers will not relay mail messages without a
valid sender.

6. If theMail server uses Secure Sockets Layer, select theUse SSL check box.
7. If the email server requires authentication, type the logon information in theUsername and

Password boxes.
8. Click Save.

CONFIGURING SERVERS
To add a server, other than the front-endmedia server and the SMTP server, you do so in YourSite
Explorer=>Servers.

To configure a server

1. In YourSite Explorer, click Servers.
2. Click Add.
3. Type theName and IP Address\DNIS Name of the server.
4. Click Save.

CONFIGURING SCHEDULES
You create schedules that accurately reflect the business hours of your operation. You can create
yearly or seasonal schedules. When you install MiContact Center for Skype, the 24/7 default
schedule is created. This schedule is for businesses that operate 24 hours a day, seven days a
week.

Your contact center software performs certain tasks during business hours and other tasks after
business hours. You create schedules that describe the hours of operation for your business.

Scheduled business hours can be applied to a queue. Outside of business hours calls can be
redirected to an external or internal number, another queue, or voicemail using either the Line URI
(extension) or SIP address. For queues where a redirection point is not applicable a closedmessage
can be configured.

The schedules you create do not expire. The weekly schedule configuration applies week after week
until you change the schedule or apply a different schedule to the device. You can exclude specific
dates from the schedule for national holidays.
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To configure a schedule

1. InYourSite Explorer, click Schedules.
2. Click Add.
3. AfterName, type the name of the schedule (for example, type Fall 2014 schedule).
4. AfterSchedule exclusion list, click ... and select a schedule exclusion list.
5. If youmust create or modify an exclusion list for the schedule, click Manage schedule

exclusion list and configure a list of days to exclude from the schedule.
See "Managing schedule exclusion lists" on page 53.

6. AfterStart time, select the business day start time for each day of the week.
7. AfterEnd time, select the business day end time for each day of the week.
8. AfterDisable for day, enable the check box for each day your business is closed.
9. Click Save.

Managing schedule exclusion lists
Tomanage schedule exclusion lists

1. InYourSite Explorer, click Schedules.
2. Click Add.
3. Click Manage schedule exclusion list.
4. AfterName, type the name of the exclusion list.
5. On the calendar, click the dates you want to exclude from the schedule.
6. Click Save.
7. Click Apply to apply the new schedule exclusion list to the schedule.

Applying schedules
You can apply the schedules you create to

l Media servers—See "Configuring themedia server" on page 46.
l Queues—See "Adding queues" on page 63.
l Network Monitor alarms—See "Configuring themedia server" on page 46.

CONFIGURING NODEALARMS
You can configure one or more node alarms for your media servers. You specify the days and times
during which node alarms will be activated. For those days and times, the system will notify you if
the Enterprise Server Collector Service is not receiving data from your media servers, or if the server
disk space is low. The Low Disk Threshold setting detects if the disk space is low on the disk
housing the text files and SQL database. If the disk space is less than the threshold you specify, the
system sets off an alarm.

To configure a node alarm

1. In YourSite Explorer, click Node alarms.
2. Click Add.
3. AfterName, type the name of the node alarm.
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4. AfterSchedule, click ... and select the schedule that reflects the company’s hours of
operation.
The schedulemust accurately reflect the hours and days of the week the business is open
and data is being received so data alarms are not activated after hours.

5. Click OK.
6. After Low disk threshold, select the value in MB for the threshold below which you want the

node alarm to be activated. (For example, select 50. An alarm will be activated when the disk
space is less than 50MB).

7. If you want to automatically restart the data ports in the event Collector Service detects a
problem with the Com ports, enable theAuto restart data ports check box.

8. AfterData alarm timeout minutes, select the duration of the time lapse inminutes from
when the data stops streaming to when you want the alarm to appear.
This setting relates to the SMDR Data timeout and ACD Data timeout Network Monitor
alarms.

9. AfterCertificate Expiry in Months, select how far ahead of time, in months, you want to be
informed before your Authentication Certificate expires.

10. Click Save.

CONFIGURING DEVICES ANDDEVICE GROUPS
Using YourSite Explorer, you create and configure devices and device groups in order to be able to
view real-time data and run reports.

You can configure devices manually or by using the Quick Setup option.

You can also add a range of devices using comma-separated values (.csv) import.

To configure devices and device groups, you

l Add employees.
l Add employee groups.
l Associate employees with employee groups.
l Add agent groups.
l Associate employees with agent groups.
l Configure queue announcements.
l Set upmusic on hold playlists.
l Add queues.
l Associate agent groups with queues.
l Add queue groups.
l Associate queues with queue groups.
l Configure queue announcements.
l Configuremusic on hold playlists.
l Add extension groups.
l Associate extensions with extension groups.
l Add extension divisions.
l Associate extension groups with extension divisions.
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l Add teams.
l Associate agent groups with teams.
l AddMake Busy Reason codes.
l AddDoNot Disturb Reason codes.

CONFIGURING DEVICESANDDEVICEGROUPSMANUALLY
NOTE:

l When you configure reporting numbers for groups, use numerical characters only. Do not
insert symbols, such as a star [*] or pound sign [#], in the number.

l If you attempt to add a device or device group to YourSite that is already in the database, the
system notifies you that the device or device group is already present. When you add a series
of devices or device groups to YourSite, such as Agent groups 5001 to 5005, if the system
detects you have already added Agent group 5002, then it will not add Agent group 5002 or any
subsequent Agent groups in the series (that is, Agent groups 5003 to 5005) to the database.

Adding employees
Youmust add all employees (agents, supervisors, managers) in YourSite Explorer so you can run
reports on employee activities and view employee performance in real time.

All employees are automatically assigned an extension for non-ACD reporting and real-time
monitoring purposes. This extension number cannot bemodified. An employee's extension is the
same as their employee ID. You can view extension information in YourSite
Explorer=>Employees=>Extension.

Employees can be configured as either contact center or general business employees.

When you designate an employee as reporting only reports can be created for that employee but they
cannot bemonitored in real time. The following issues should be considered when designating
employees for reporting only.

Retiring an Employee

If you want to retire and reuse an employee ID, for example, when an employee leaves the company,
the following applies: If a retiring employee’s ID (Employee A) is issued to a new employee
(Employee B) and a report is run for the period when Employee A was an active employee,
Employee B’s namewill display in the report but the statistics will be those of Employee A.

Deleting an Employee

If you delete an employee you will not be able to select this employee in the Contact Center
Management website in order to run reports for them. Furthermore, if you summarize historical data,
the data for the deleted employee will be purged from the database.

Instead of deleting an employee, designate the employee as reporting only. Their statistics will not
be deleted from the database and you will be able to continue to run historical reports for them.
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NOTE:

l Summarizing historical data removes it from the database. If, after summarizing, you need to
access this historical data, you can re-designate the employee as licensed for real time and
reporting and re-summarize the data.

l MiContact Center for Skype does not support multiple lines for employees. Employees may
only be configured with a single line.

Configuring general and licensing information
To configure general and licensing information for an employee

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Employees.
3. Click Add. 

The Associate with user window displays.
4. Browse to the location of the Active Directory user you want to add as an employee, select

the user, and click OK.
5. UnderGeneral, specify employee identification information.

Youmust provide the date the employee became an active part of the enterprise if you intend
to generate administrative employee reports.
A unique employee ID number is generated for each employee.

6. Under Licensing, select the features and applications for which you want to decrement a
license.

l TheReporting only option enables you to run reports on the employee but not monitor
the employee in real time.

l TheReal-time and reporting option enables you to run reports on the employee and
monitor the employee in real time, and decrements one employee license.

NOTE:
l You cannot license an employee if no licenses remain.
l Supervisors must be assigned an agent license to use supervisor-related features
reliant on Skype for Business, such as silent monitoring, help, or conferencing.

7. Configure user account information.
See "Configuring user account information" on page 56.

Configuring user account information
When configuring employee user account information, you can view the employee's associated SIP
address and Line URI, but these fields are not editable, as they are controlled from the associated
Active Directory user account.

To configure user account information for an employee

1. Select an employee.
2. Click theUser account tab.
3. Specify theUsername andPassword for the employee.
4. AfterSite, click ... and select the site to which the employee is associated.
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5. Click OK.
6. If the employee is a supervisor, select the Is supervisor check box.

NOTE: Supervisors must be assigned an agent license to use supervisor-related features
reliant on Skype for Business, such as silent monitoring, help, or conferencing.

7. UnderSecurity, click ... and select a security role for the employee.
The default security role permits users full access to all applications and devices.

8. Click OK.
9. UnderReport distribution, specify the path of the network printer and select print and email

options.
Youmust configure the network printer as the default printer on the Enterprise Server.
The printer path name is case sensitive.

10. UnderCommunication Properties
l Right-click Communication Properties to optionally call, send an instant message, or
start a video call with the selected employee.

l If the employee is configured for Enterprise Voice in Skype for Business, theSIP
Address and Line URI fields are automatically populated.

l If you are configuring a contact center employee, select theEnabled for SIP check
box.

l If you want to configure this employee for real-timemonitoring and reporting, select the
Enabled for ACD check box. When this option is enabled, an agent ID is created and
associated with the employee. The Enabled for ACD check box is disabled if you do not
select the Enabled for SIP check box.

11. Configure employee details.
See "Configuring employee details" on page 57.

Configuring employee details
To configure details for an employee

1. Select an employee.
2. Click theDetails tab.
3. Specify address, personal, and emergency contact information for the employee.
4. Configure agent login information.

See "Configuring agent login information" on page 57.

Configuring agent login information
NOTES:

l Employees are not enabled for ACD by default. Youmust select the enable for ACD option for
each employee.

l If you havemore than one pool, youmust select each employee (the employee info will turn
bold) to generate an extension for that employee. An extension will not be generated until this
is completed.
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To configure agent login information

1. Select an employee.
2. Click theAgent Login tab.
3. AfterMedia Server, click ... and select themedia server to which the employee is

associated.
NOTE: The default media server used for each employee is the first media server in the list. If
the employee is in the second pool (associated to the secondmedia server), youmust select
the secondmedia server from the list.

4. Click OK.
5. UnderAgent Availability, select the appropriateACD Policy from the drop-down list.

For a description of ACD Policy settings, see "Configuring system defaults" on page 47.
6. Click Save.

Disassociating Line URI from historical employees
If you wish to reuse a Line URI from an employee who is no longer active at your contact center,
such as from a former employee, with a new employee, youmust make the employee historical and
remove them from Lync using the Lync Control Panel. This will enable you to reuse their Line URI.

To disassociate Line URI from a historical employee

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Employees.
3. Select the employee you wish tomake historical.
4. Under Licensing and real-time options, select theReporting only button.
5. Click Save.

The Line URI is removed from the employee.
6. Open the Skype for Business control panel.
7. Click Users.
8. Select the historical employee whose Line URI you want to reuse.
9. Click Action=>Remove from Skype for Business Server.

The employee is removed from Skype for Business. The Line URI may be used with new
employees.

Adding employee groups
After adding employees, you add employee groups and then associate employees to these groups.

To add an employee group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Employee groups.
3. Click Add.
4. Configure employee group identification information.
5. Click Save.
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Associating employees with employee groups
To associate an employee with an employee group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Employee groups.
3. Select an employee group from the list.
4. On theMembership tab, underAvailable members, select an employee and click > to move

the employee to theSelected members list.
5. Click Save.

Adding agent groups
You add agent groups and then associate employees to these groups.

When you designate an agent group as historical reporting only reports can be created for that device
but they cannot bemonitored in real time.

Deleting agent groups

If an agent group is deleted, it is no longer a selectable device. If you want to be able to run historical
reports, deleting agent groups is not recommended. Instead of deleting agent groups, designate
them as historical reporting only but remember that if a historical summarization is performed this
agent groups’ data will be removed from the database.

NOTE:Summarizing historical data removes it from the database. If, after summarizing, you need to
access this historical data, you can re-designate the agent group and its associated devices
(employees/agents) as licensed for real time and reporting and re-summarize the data.

To add an agent group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Agent groups.
3. Click Add.
4. Configure agent group identification information and select themedia server for the agent

group.
5. Under Reporting and real-time options, select

l Historical reporting only if you want to run reports on an agent group without real time
monitoring.

l Real time and reporting if you want to run reports on an agent group andmonitor it
with basic real time functionality, such as ACD states and statistics and presence.

6. Click Save.

Associating employees with agent groups
To associate an employee with an agent group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Agent groups.
3. Select an agent group from the list.
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4. On theMembership tab, underAvailable members, select an employee and click > to move
the employee to theSelected members list.
The employees listed as available to be assigned to an agent group are those associated with
the samemedia server to which the agent group is associated.

5. Under Is Default, select True if you want the employee to be associated by default to the
agent group.
When an agent logs into Ignite for Skype they are automatically joined to their default agent
group(s).

6. Click Save.

Configuring queue announcements
Announcements are assigned to queues and play to individual calls in queue at specified times. After
you create announcements for a queue they can be re-used across all queues as required. If Music
OnHold is configured for a queue, themusic plays between announcements. If an agent is available
when a call enters the queue, the caller is immediately routed to the agent and does not hear any
queue announcements.

Audio files for announcements can be selected from the local file system or chosen from themedia
file library on the Enterprise server. Once a file is selected from the local file system, it is instantly
added to themedia file collection, copied to the sharedmedia directory on the Enterprise server, and
is made available to any queue.

NOTE:All queue announcements must be in .wma format. The codec required is 32kpbs, 44khz, 16-
bit mono, and CBR (Constant Bit Rate).

The following announcement types can be played to callers waiting in queue:

l Recorded announcements - can be interspersed with other announcements and played at
specified intervals in a defined order. There is no limit on the number of recorded
announcements that can be configured to play on a queue.

l Welcome greeting - this announcement is played once when a caller enters the queue.
l Estimated wait time message - this announcement is played once when a caller enters the
queue and tells the caller the estimated amount of time they will wait in queue before being
answered. Estimated wait time (EWT) is calculated using real-time call handling statistics
from the Enterprise Server. If there are agents available, the EWT is calculated as follows:
average TALK TIME x # of calls in the queue. If there are no agents available when the call
enters the queue then EWT = average handle time. EWT files are shipped with MiContact
Center for Skype. The estimated wait timemessage will not play if EWT is equal to zero
seconds.

l Call load announcement - this announcement plays when the number of calls waiting in the
queue surpasses a specified threshold. Music OnHold (if enabled for the queue) and other
configured announcements are interrupted and the caller is advised that there is a high volume
of calls. The call load announcement can also be configured to play according to a specific
time interval, for example, every 60 seconds.

l Queue Closed Announcement - this announcement plays when a call is directed to a closed
queue. The queue closed announcement plays and the call is terminated.
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To configure a queue announcement

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Queue Announcements.
3. Click Add.
4. UnderQueue announcement settings, type aName for this queue announcement

configuration and, optionally, type descriptive information in theComment text box.
5. To add a welcome greeting, afterWelcome greeting, click ... to select a file from themedia

directory or click Add file to select a file from your local file system.
When you add a file from your local file system, it is automatically added to themedia
directory on the Enterprise server and is available to be selected for future queue
announcement configuration.

6. If you want to remove the welcome greeting you have selected, click Clear.
7. To add an estimated wait timemessage, afterEstimated Wait Time Message, click ...to

select a file from themedia directory or click Add file to add a file from your local file system.
8. If you want to remove the estimated wait timemessage you have selected, click Clear.
9. After Time before next announcement, specify the time interval between recorded

announcements.
10. AfterCall load before announcement is played, specify a threshold for the number of calls

that must be waiting in queue before the call load announcement will play.
11. AfterAnnouncement, click ... to select a file from themedia directory or click Add file to add

a file from your local file system.
12. If you want to remove the call load announcement you have selected, click Clear.
13. AfterPlay call load announcement every, specify the time interval between call load

announcements.
14. To add a queue closed announcement, afterQueue Closed Announcement, click ... and

select a file from themedia directory or click Add file to add a file from your local file system.
15. If you want to remove the queue closed announcement you have selected, click Clear.
16. To add a recorded announcement, UnderAnnouncements, Available members, click Add

to select a file from your local file system.
The file is now accessible in the Available members list.

17. To preview the file, click Play.
18. To delete the file, click Delete.
19. To add the recorded announcement to the playlist, select the file in theAvailable members

list and click > to move it to theSelected members list.
The files will play in the order in which they are placed in the Selectedmembers list.

20. To change the order the files will be played in, click the up and down arrows in the right margin
of theSelected members list. 

21. Click Save.

ConfiguringMusic OnHold playlists
Music is played to callers both waiting in queue or on hold in queues that are enabled to play Music
OnHold. If a caller changes queues while listening toMusic OnHold they will not notice a change in
themusic if both queues are enabled to play Music OnHold.
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You can upload .wma files to the Enterprise Server and then add them to your playlist. Once the files
have been added to the playlist youmust associate the playlist to themedia server and enableMusic
OnHold on the queues for which you want Music on Hold to be active. See "Adding queues" on page
63.

When a file is uploaded using YourSite Explorer, it is automatically synchronized to the server where
the router is located, as these files must exist on the server that contains the prairieFyre Enterprise
Router Service. There are no limits on the number or length of files that can be added to the server.
However, all files must be in the .wma format. The codec required is 32kpbs, 44khz, 16-bit mono,
and CBR (Constant Bit Rate).

To configure aMusic OnHold playlist

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Music on Hold playlists.
3. Click Add.
4. AfterPlaylist name, type a name for the playlist.
5. UnderAvailable Members, click Add, navigate to the location where your .wma files are

stored, and select the files you want to make available to the playlist.
The .wma file is added to the list ofMusic on Hold Files

6. To listen to the .wma file, click Play.
7. To delete the .wma file, click Delete.
8. To place .wma files into the playlist, click > to move the files from theAvailable members

window to theSelected memberswindow.
9. Click Save.

Configuring Call Ringing
Call ringing plays a ring tone when a caller leaves the queue and their call is offered to an available
agent. If a queue has noMusic on Hold or queue announcements configured, then the ring tone will
also play.

MiContact Center for Skype includes a default ring tone, but custom ring tones may be used as well.
To use a custom ring tones, youmust overwrite the RingingTone.wma file on both the Enterprise
Server and the Router.

NOTE:

l Custom ring tones must be in .wma format.
l It is recommended that you choose a ring tone with a duration of 10 seconds or longer.
l It is recommended that you back up a copy of RingingTone.wma before overwriting it if you
want to preserve a copy of the default tone.

l It is recommended that you place a test call after overwriting the default ringing tone file.
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Replacing the default ring tone
To replace the default ring tone

1. Rename the custom ring tone .wma file RingingTone.wma.
2. Replace the existing RingTone.wma file with the custom RingingTone.wma file into <Server

IP address>\MediaDirectory\SystemMedia\ folder on both the Enterprise Server and the
Router.

Adding queues
You add queues and then associate agent groups to the queues. You can also create queue groups
and associate queues with the queue groups. Every queue you createmust have a valid Line URI
and SIP address in order to receive calls. A newly created queue is available to Ignite for Skype and
the Enterprise routers after it has been provisioned in Skype for Business.

When you designate a queue as historical reporting only reports can be created for the queue, but the
queue cannot bemonitored in real time or put back into service.

NOTE: If a queue is designated as historical reporting only and a historical summarization is
performed this queue's data will be removed from the database. If, after summarizing you need to
access this historical data, you can re-designate the queue as licensed for real time and reporting
and re-summarize the data.

Configuring general information for queues
To configure general information for a queue

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Queues.
3. Click Add.
4. UnderCommon, specify theName andReporting number for the queue.

NOTE: To ensure accurate reporting, queue reporting numbers must be unique across both
active and inactive queues.

5. Click ... and select themedia server for the queue.
6. Click OK.
7. UnderQueue service objective, specify theService Level goal and theService Level

time.
8. AfterShort Handle less than, type the duration that will define a call as a short handle call.

For example, type 3 to define a short handle call as one that lasts less than 3 seconds.
Short handle calls are included in call statistics.

9. AfterShort Abandon less than, type the duration that will define an abandoned call as 'Call
Abandoned (Short)'
For example, type 5 to define a short abandon call as a call that is abandoned in less than 5
seconds. NOTE: Short abandoned calls are not included in the Offered, Service%, or
Average delay to abandon (hh:mm:ss) statistics.
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10. UnderReporting and real-time options, select
l Historical reporting only if you want to run reports on a queue without real time
monitoring.

l Advanced real time and reporting if you want to run reports on a queue andmonitor it
with basic real time functionality, such as ACD states and statistics and presence.

11. If you want to enable requeue timer for this queue select theUse requeue timer check box
and specify the duration.
The value of the queue requeue timer must be equal to or less than the system requeue time
configured on themedia server. By default, the system requeue time is configured to be 3
minutes. See "Configuring system defaults" on page 47.

12. If you want to enable work timer for this queue, select theUse work timer check box and
specify the duration.
The default work timer settings are configured on themedia server.
See "Configuring system defaults" on page 47.

13. If you want to include work time as part of handling time, select the Include work timer as
part of handling time check box.

14. UnderConnection Settings, type theSIP Address and Line URI for the queue.
NOTE:

l A queue's SIP address cannot be changed once the queue has been saved. To change
a queue's SIP address, youmust first delete and recreate the queue. You can then type
the new SIP address.

l In amulti-site installation of MiContact Center for Skype with multiple Enterprise
Servers, there is the remote possibility that a queue will be provisioned that uses a Line
URI in use at another Enterprise Server site’s configuration. For troubleshooting
assistance, consult the Knowledge Base for resolution.

15. UnderMedia Options, click ... and select aQueue Announcement.
See "Configuring queue announcements" on page 60.

16. Click OK.
17. If you want to enableMusic on Hold, select Use Music on Hold for this queue.

Music on Hold settings are configured on themedia server.
See "ConfiguringMusic OnHold playlists" on page 61.

18. Configure business hours for the queue.
See "Configuring business hours for queues" on page 64.
NOTE: In order to apply a business hour schedule to queues, youmust first create a business
hour schedule. See "Configuring schedules" on page 52.

Configuring business hours for queues
You configure business hours for queues to determine when queues are available. Outside of
business hours, calls can be:

l Redirected to another answer point, such as voicemail, another queue, or an external number
l Presented with a closedmessage
l Presented with a busy signal
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To configure business hours for queues

1. Click theBusiness Hours tab.
2. AfterBusiness-hour schedule, click ... and select a schedule for the queue.
3. Click OK.
4. If you want to restrict the production of real-time statistics and reports to only during business

hours, select theGenerate real-time statistics and reports only within the business
hours selected check box.

5. To apply the selected business-hour schedule to all queues associated with themedia server,
click Submit.

6. Configure routing options.
See "Configuring general routing options for queues" on page 65.

Configuring general routing options for queues
Longest idle routing ensures that the agent with the longest idle time always handles the next
available call that is waiting in queue. If there are four agent groups configured for a queue, the first
agent group is checked to see if there are any available agents. If no agents are available and the
overflow timer is active, the next agent group will be included in the searching algorithm. Either way
the agent with the longest idle time is selected and presented to the caller. The call will search all
four agent groups until the interflow timer expires and then follow the interflow point directory
number. If no interflow timer is present then the call will continue to queue until the caller abandons
the call. (See Figure 6.)

Figure 6: ACD routing
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To configure routing options for queues

1. Click theRouting options tab.
2. UnderGeneral, afterPriority, select a priority for the queue.

Queue priority determines which calls are answered first. Queues with the same priority are
answered based on longest-waiting call. One is the highest priority for a queue and 64 is the
lowest priority. Callers in higher priority queues will be delivered before callers in lower priority
queues. The call priority does not change for the duration of the call unless the call has
interflowed to other queues where the interflow destination point has been set to change the
call priority.
Default call priority is 64.

3. AfterQueue unavailable answer point directory number, type the Line-URI or SIP
Address you want calls to be directed to if the queue is unavailable.
NOTE: In order for queues without logged in agents to be available during business hours,
ensure you set the 'Allow calls to queue when no agents are present in this queue' option.

4. If you want calls to wait in the queue until an agent makes themselves available to a group
associated with that queue, select theAllow calls to queue when no agents are present
in this queue check box.
Calls that are routed to queues with no agents present immediately queue to all agent groups.
By default, this option is turned off and calls are transferred to the unavailable answer point
directory number.

5. Under Interflow options,
l After Interflow enabled, select whether you want interflow to be enabled.
Interflow is a time-based routing function that takes an ACD call out of the path and
routes it to an interflow answer point.

l After Interflow timeout, specify the time that it takes a call to interflow, for example if
interflow timeout is set to twominutes, the call will interflow if not answered after two
minutes.
The duration configured should be longer than the combined overflow timer for the agent
groups in the queue.

l After Interflow point directory number, type the interflow answer point directory
number, Line URI or SIP Address, or click ... to select from a list of optional answer
points, where calls will be interflowed to when the queue is unavailable. Interflow points
can be Line URIs or other SIP addresses.

l After Interflow immediately when all agent groups' timers have expired, select
Yes if you want calls to interflow immediately after the overflow timers for all agent
groups in the queue have expired.

l After Interflow to this queue uses this queue's priority, if you want calls that are
interflowed to this queue to assume this queue's call priority settings.

6. Configure Interactive Contact Center queue control.
See "Configuring Interactive Contact Center queue control" on page 70.

Interflowing calls directly to voice mail
By default, even if the Interflow Endpoint is busy, the call will still be sent to the endpoint to ring
before being redirected to that endpoint’s voicemail. You can, however, configure the router service
to immediately send the call to the endpoint’s voicemail if the endpoint is busy.
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NOTE: If an endpoint is busy and does not have a voicemail configured, the call will fail when
interflowed. If you change this configuration setting, ensure your interflow endpoints have voicemail
available.

To change the interflow behavior to immediately send the call to a busy endpoint’s voicemail.

1. Navigate to the following folder:
<drive>\Program Files\prairieFyre Software Inc\CCM\Service\RouterService

2. OpenOrandaRouterService.exe.config in an editor.
3. Locate the following:

<setting name=”AllowInterflowToVoiceMailImmediatelyWhenOnAcdOrBusy”
serializeAs=”String”>
<value>false</value>
</setting>

4. Delete false and replace with true.
5. Save and close the editor.
6. Navigate toServices.
7. Right-click prairieFyre Enterprise Router Service and click Restart.

Configuring alternate queue endpoints
You can also configure queues with alternate endpoints. Alternate queue endpoints ensure that calls
reach a service destination:

l When queues are unavailable, such as when a call comes in after hours or when a queue is in
Do Not Disturb.

l If a queue has been configured incorrectly or in the rare event that the Enterprise router goes
offline.

Alternate queue endpoints include

l Resilient queue endpoints
l A global resilient endpoint
l Unavailable answer points

Resilient queue endpoints provide an alternate endpoint for calls if a queue is configured incorrectly
or in the rare event that the router is offline and unable to direct calls to queues. For example, if you
take the router offline for maintenance, you can configure a resilient queue endpoint to send callers
directed to that queue to an alternate response group. Configure resilient queue endpoints by
creating an .xml SIP Listener service configuration file called QueueFailureRedirects.xml. A sample
configuration file, QueueFailureRedirects.Sample.xml, is shipped with MiContact Center for Skype.
Use this file to create your own .xml configuration file.

NOTE: A resilient queue endpoint must be internal to Skype for Business. External PSTN numbers
cannot be used.
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The global resilient endpoint provides an alternate endpoint for calls if the router is offline and you
have not configured resilient queue endpoints. For example, if you take the router offline for
maintenance, calls that enter the system will be sent first to the resilient queue endpoints. If no
resilient queue endpoints are configured, these calls will be sent to a single global resilient endpoint.
Configure the global resilient endpoint by creating an .xml SIP Listener service configuration file
called QueueFailureRedirects.xml. A sample configuration file, QueueFailureRedirects.Sample.xml,
is shipped with MiContact Center for Skype. Use this file to create your own .xml configuration file.

NOTE:  A global resilient endpoint must be internal to Skype for Business. External PSTN numbers
cannot be used.

Unavailable answer points provide an alternate endpoint for calls if queues are unavailable for
reasons independent of the router, such as being in DoNot Disturb or being closed for the evening.
For example, you can configure an unavailable answer point to send after-hours calls to a voicemail
box. Configure unavailable answer points in YourSite Explorer.

NOTE:

l If your business uses multiple front end servers, ensure that endpoints are configured
identically for each server. This includes ensuring that the content of the .xml file for each SIP
Listener is identical.

l If a call comes in when the router is offline, MiContact Center for Skype’s SIP Listener service
receives a response code of 400 or higher, indicating the call’s failure to route. For
descriptions of response codes, see the following Knowledge Base article:
http://micc.mitel.com/kb/KnowledgebaseArticle51586.aspx

l After configuration, you do not need to restart the SIP Listener. The SIP Listener will reload
the same .xml SIP Listener service configuration file within 5-10 seconds.

l Ensure that SIP addresses are valid before saving the .xml SIP Listener service configuration
file, or the redirection will not take effect.

l If the router is taken offline and you have not configured resilient queue endpoints or a global
resilient endpoint, calls will be sent to the unavailable endpoint if one is configured.

l If you are usingMicrosoft Exchange server auto-attendant, calls will not be directed to another
answer point if the queue is unavailable (for example, being offline or deleted).

To configure a resilient queue endpoint

l Resilient queue endpoints are configured for individual queues. Configure a resilient queue
endpoint by creating an .xml SIP Listener service configuration file called
QueueFailureRedirects.xml, either from scratch or using the sample .xml file provided.
Information on creating the .xml configuration file can be found at C:\Program Files\prairieFyre
Software Inc\CCM\Services\SipListener\QueueFailureRedirects.Readme.txt. This folder is
included in each Front End server.

To configure a global resilient endpoint

l The global resilient endpoint is unique and is configured across all queues. Configure the
global resilient by creating an .xml SIP Listener service configuration file called
QueueFailureRedirects.xml, either from scratch or using the sample .xml file provided.
Information on creating the .xml configuration file can be found at C:\Program Files\prairieFyre
Software Inc\CCM\Services\SipListener\QueueFailureRedirects.Readme.txt. This folder is
included in each Front End server.

http://micc.mitel.com/kb/KnowledgebaseArticle51586.aspx
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To configure an unavailable answer point

1. In YourSite Explorer, click YourSite=>Queues.
TheQueues pane opens.

2. Click theRouting options tab.
3. AfterQueue unavailable answer point directory number, type the directory number you

want calls to be directed to if the queue is unavailable.
4. For example, to send callers to a voicemail extension, you would type the appropriate sip

address such as sip:user@domain.local;opaque=app:voicemail
NOTE:

l For voicemail extensions, ensure you type a SIP address.
l If the router is offline, the call will route to the resilient queue endpoint if one is
configured. If a resilient queue endpoint is not configured, the call will route to the global
resilient endpoint if one is configured.

Configuring Dial Out of Queue
Dial Out of Queue enables callers currently in a queue to dial a pre-configured number and leave that
queue to connect to a different point of contact in a contact center. Dial Out of Queue is configured
for queues by defining destination points, such as voicemail, another queue, or even directly to a
specific agent, for up to 12 DTMF digits (0-9, '*', and '#') and then configuring the duration of time that
must pass before Dial Out of Queue become available to a caller in queue.

NOTE:

l Once Dial Out of Queue becomes available to a caller, it will remain available until the caller
leaves the current queue.

l It is a requirement for Dial Out of Queue that DTMF be delivered through SIP messages as
opposed to in-band signaling through the trunk interface.

l A call coming out of queue through Dial Out of Queue is reported as an Interflowed in queue
reports.

l Queue announcements informing callers of Dial Out of Queue destination points must be
recorded, configured as queue announcements, and then associated to the queue. See
"Configuring queue announcements" on page 60 and "Configuring general information for
queues" on page 63.

To enable Dial Out of Queue for a queue

1. In YourSite Explorer, click Queues.
2. UnderQueues, select the queue in which to define Dial Out of Queue destination points.

The queue opens in the pane below.
3. Click theDial Out of Queue tab.
4. AfterEnable Dial Out of Queue after, set the time which you want to pass before the dial-

out becomes available.
NOTE: Themaximum time that may pass before Dial Out of Queue becomes available is 1
hour.
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5. UnderDial Out Of Queue Destination Endpoints, in the text box beside the DTMF digits
you want to configure as dial-out options, enter the phone number, SIP address, or LineURI
for the desired destination point.
NOTE:Phone numbers must be entered only as LineURI only, without hyphens or
parentheses, e.g. tel:+6135990045. Phone numbers must work when dialed by a Skype for
Business client.

6. When you are finished setting the destination points, click Save.

Configuring Interactive Contact Center queue control
To configure Interactive Contact Center queue control

1. Click the Interactive queue control tab.
2. Select the The queue uses Interactive Contact Center queue control check box to enable

this queue to be interactively controlled using the schedule you specify.
3. Configure queue spectrum settings.

See "Configuring queue spectrum settings for queues" on page 70.

NOTE: Youmust configure Interactive Contact Center to enable queues to enter DND based on
business-hour schedules.

Configuring queue spectrum settings for queues
Queue spectrum reports provide valuable information on how calls are dispersed in your contact
center. You configure answer, abandon, interflow, handle, and ringing thresholds for queues in
YourSite Explorer.

The answer, abandon, interflow, and talk statistics will be distributed across the queue spectrum
reports in the time intervals you specify.

NOTE: The data in the queue spectrum ringing reports is derived from the ACD data stream. Queue
performance report data is derived from the SMDR data stream so cannot be compared to queue
spectrum ringing report data.

To configure queue spectrum settings for a queue

1. Click theQueue Spectrum tab.
2. Select the spectrum value(s) you want to include in reports and specify thresholds for each.

All threshold values are in seconds.
3. To apply spectrums to all queues associated with themedia server, click Submit.
4. Click Save.
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Associating agent groups with queues
When you add a queue, you associate the queue with the agent groups that handle calls for that
queue. Youmust associate at least one agent group with a queue in order to produce reports on the
queue. A maximum of four agent groups can be associated to a queue.

To associate an agent group with a queue.

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Queues.
3. Select a queue from the list.
4. On theMembership tab, underAvailable members, select an agent group and click > to

move the agent group to theSelected members list.
The agent groups listed as available to be assigned to a queue are those associated with the
samemedia server to which the queue is associated.

5. Click Save.

Deleting queues
If a queue is deleted, it is no longer a selectable device. If you want to be able to run historical
reports, deleting queues is not recommended. Instead of deleting queues, designate them as
historical reporting only but remember that if a historical summarization is performed this queue’s
data will be removed from the database. When you designate a queue as historical reporting only
reports can be created for the queue but it cannot bemonitored in real time.

NOTE:Summarizing historical data removes it from the database. If, after summarizing, you need to
access this historical data, you can re-designate the queue as licensed for real time and reporting
and re-summarize the data.

Adding queue groups
To add a queue group.

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Queue groups.
3. Click Add.
4. Configure queue group identification information.
5. Click Save.

Associating queues with queue groups
After adding queues, you can associate them with queue groups.

To associate a queue with a queue group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Queue groups.
3. Select a queue from the list.
4. On theMembership tab, underAvailable members, select a queue and click > to move the

queue to theSelected members list.
5. Click Save.
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Adding extension groups
To add an extension group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Extension groups.
3. Click Add.
4. Configure extension group identification information.
5. Click Save.

Associating extensions with extension groups
To associate an extension with an extension group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Extension groups.
3. Select an extension group from the list.
4. On theMembership tab, underAvailable members, select an extension and click > to move

the extension to theSelected members list.
5. Click Save.

Adding extension divisions
To add an extension division

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Extension divisions.
3. Click Add.
4. Configure extension division identification information.
5. Click Save.

Associating extension groups with extension divisions
To associate an extension group with an extension division

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Extension divisions.
3. Select an extension division from the list.
4. On theMembership tab, underAvailable members, select an extension group and click > to

move the extension group to theSelected members list.
5. Click Save.
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Adding teams
You add teams and then associate agent groups to these teams.

To add a team

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Teams.
3. Click Add.
4. Configure team identification information.
5. Click Save.

Associating agent groups with teams
To associate an agent group with a team

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Teams.
3. Select a team from the list.
4. On theMembership tab, underAvailable members, select an agent group and click > to

move the agent group to theSelected members list.
5. Click Save.

AddingMake Busy Reason codes
Agents enter Make Busy Reason codes to indicate why they are placing themselves in Make Busy
and not handling calls.

To add aMake Busy Reason code

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Make Busy Reasons.
3. Click Add.
4. Type aName andReporting number for theMake Busy Reason code.
5. Click Save.

Adding DoNot Disturb Reason codes
Interactive Contact Center enables supervisors to control the availability of agents and
ACD queues. Likewise, agents can control their own availability, including placing themselves in or
removing themselves from Do Not Disturb. There aremany reasons why agents are placed in Do
Not Disturb. You add these reasons in YourSite Explorer.

To add a Do Not Disturb Reason code

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click DND Reason Codes.
3. Click Add.
4. Type aName andReporting number for the DoNot Disturb Reason code.
5. Click Save.
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CONFIGURING DEVICESANDDEVICEGROUPSUSING
QUICKSETUP
If you want to add a range of devices and device groups (employee groups, employee divisions,
agent groups, queue groups, extension groups, Make Busy Reason codes, and teams) you can use
Quick Setup.

NOTE:Quick Setup is not offered in the Data grid view.

Employee groupQuick Setup
To add a range of employee groups

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Employee groups.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. Click Run.

Employee division Quick Setup
To add a range of employee divisions

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Employee Divisions.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. Click Run.

Agent groupQuick Setup
To add a range of agent groups

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Agent groups.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. On theGeneral tab, click ... and select amedia server with which to associate the agent

groups.
7. Click OK.
8. Click Run.
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Queue groupQuick Setup
To add a range of queue groups

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Queue groups.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. Click Run.

Extension groupQuick Setup
To add a range of extension groups

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Extension groups.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. Click Run.

Extension division Quick Setup
To add a range of extension divisions

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Extension divisions.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. Click Run.

Make Busy ReasonQuick Setup
To add a range of Make Busy Reason codes

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Make Busy Reasons.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. Click Run.
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Team Quick Setup
To add a range of teams

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Teams.
3. Click Quick Setup.
4. In theActive number from andActive number to boxes, type a range of device numbers.
5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/or

Name postfix type the prefix and/or postfix.
6. Click Run.

CONFIGURING DEVICESANDDEVICEGROUPSUSING .CSV
FILES
You can import devices to YourSite Explorer using comma-separated value (.csv) files. The
following device types are currently supported for use with the YourSite Explorer .csv import tool:
employees, employee groups, employee divisions, agent groups, queue groups, extension groups,
extension divisions, Make Busy Reason codes, Do Not Disturb Reason codes, and teams.

A .csv file is used for the digital storage of data structured in a table of lists form, where each
associated item (member) in a group is in association with others also separated by the commas or
tabs of its set.

To import a range of devices using a .csv file

1. In YourSite Explorer, underDevices, click the name of the device you will add using a .csv
file.

2. Click Import.
3. AfterSelect file type, specify whether the .csv file uses Comma separated values or Tab

separated values.
4. AfterSelect file, click Browse and specify the location of the .csv file.
5. UnderOptions, specify how the Import Wizard will handle duplicate items.
6. Click Next.
7. On the Field Mappingswindow, map the fields in theAvailable columns list to the

Selected columns list using the arrow buttons, so they appear in the same order as they do in
your .csv file.

8. Click Next.
9. When the import has completed, click Finish.

The imported devices will display in the data grid view of YourSite Explorer.

ACTIVE DIRECTORY SYNCHRONIZATION
Active Directory is a centralized data system. YourSite Explorer and Active Directory groups,
domains, and organizational units are synchronized during Active Directory synchronization.

When you run Active Directory synchronization, employees in YourSite Explorer are synchronized
with users in Active Directory groups.
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To run Active Directory synchronization

1. In YourSite Explorer, underYourSite, click Enterprise or click Employees.
2. On the ribbon, click Active Directory.
3. UnderSync frequency, select how often you want automatic synchronization to occur.

The default frequency is every hour. We recommend you set frequency for 24 hours. If you
turn Active Directory synchronization off, the system will automatically synchronize when
maintenance service runs (every day at 2 A.M., by default).

4. Click Sync paths.
The Select paths to sync window opens.

5. Click > or < to add or remove Active Directory entities from the Active Directory tree on the
left to the selected items list on the right and click OK.
The list of selected items on the right includes the Active Directory entities that will be
synched.

6. UnderSecurity Role, click ...and select a default security role to apply to newly created
employees.

7. Click OK.
8. UnderSites, click ... and select a default site to apply to newly created employees.
9. Click OK.
10. Click Run.

Active Directory synchronization is initiated and pertinent information is updated in YourSite
Explorer.

APPLYING CONFIGURATION SETTINGS TO CLIENT
COMPUTERS

You can apply configuration settings to client computers by sending recent configuration changes to
client computers or by resetting client computers with the latest YourSite database configuration
information.

To send recent configuration changes to client computers

1. In YourSite Explorer, underYourSite, click Enterprise or click Employees.
2. On the Ribbon, click Tools.
3. Click Re-synchronize clients.

To completely reset client computers with the latest YourSite database configuration information

1. In YourSite Explorer, underYourSite, click Enterprise or click Employees.
2. On the Ribbon, click Tools.
3. Click Reset clients.
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SECURITY ROLES
You create security roles if you want to restrict employees from specific devices and application
areas.

NOTE: In order for you to assign security roles, your account must be associated with a security role
that does not restrict you from administering security.

The default security role Local Administrator allows employees full access to all of the applications
(to which the contact center is licensed) and devices. Security roles are inclusive. This means that a
security role assigned to an employee defines the application areas an employee can access.

Upon installation, a default user is created. This assures you there is at least one account with which
you can access the Contact Center Management website.

Security roles have two components:

l Basic—Basic security controls user access to specific areas of Contact Center
Management.

l Advanced—Advanced security controls user access to customized lists of devices, real-time
monitors, profiles, reports, sites, and users.

CREATING ANDAPPLYING SECURITYROLES
You can create security roles that have various basic and advanced authorizations applied to them.
For example, you can create a security role with minimal security restrictions, granting users access
to as many Contact Center Management reports and applications as you designate. You do this by
leaving the security components listed under the Advanced tab set to 'Not restricted'. Alternatively,
you can create a security role that grants full access to someContact Center Management
application areas but is restricted from accessing other reports and devices. (See Figure 7.)

To create and apply a security role with basic and advanced components, youmust

1. Ensure employees are configured in YourSite Explorer.
See "Adding employees" on page 55.

2. Create security lists.
3. Configure basic security.
4. Configure advanced security.
5. Assign the security role to one or more employees.

To create and apply a security role with basic security components only, youmust

1. Ensure employees are configured in the YourSite Explorer.
2. Specify basic security.
3. Assign the security role to one or more employees.
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To create and apply a security role with advanced security components only, youmust

1. Create security lists if you want to apply advanced security.
2. Configure basic security.
3. Configure advanced security.
4. Ensure all employees are configured in the YourSite Explorer.
5. Assign the security role to one or more employees.

Figure 7: Security flow chart
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CREATING SECURITY LISTS
You can use advanced security to restrict user access to sites, reporting, and real-time functions.

Before you can specify advanced security, youmust create security lists (device lists, real-time
monitor lists, profile lists, report lists, site lists, user lists, and card design lists). Each list must
contain the devices, real-timemonitors, reports, sites, and/or users to which employees are granted
access. You can combine these lists when you assign a security role. For example, you can specify
advanced security that permits users to create EmployeeGroup Performance by Employee reports
(specific report list) on Kanata employees (specific device list) only.

Use the following security lists to define advanced security:

l Device list—Device lists specify devices for which employees may view real-time
information. You create device lists to restrict access to statistics on specific employees. For
example, youmight want amanager to view certain employees only (specific device - Kanata
employees). The device list must contain the device (employee group - in this case, Kanata
employees) to which the user may gain access.
Devices include agent groups, employee groups, queue groups, extension groups, and teams.
Statistics are generated from these devices. You can view these statistics or generate a
report from them.

l Real-time monitor list—The real-timemonitor list specifies real-timemonitors to which you
are granted access. You create a real-timemonitor list to restrict access to particular real-time
monitors. The real-timemonitor list must contain themonitors to which the user may gain
access.

l Profile list—You create a profile list to restrict users frommanaging specific real-timemonitor
profiles.

l Report list—You create report lists to restrict users from viewing specific report types. For
example, youmight want managers to view employee reports only (specific report category).
The report list must contain the reports the user may run. If you do not assign a report list to
the employee, then the employee will see every group and team when running reports and
monitoring real-time activities (unless a basic security role is assigned to that employee that
does not permit the employee to gain access to any reports).

l Site list—The site list specifies sites youmay manage. You create a site list to restrict
access to devices by site. For example, youmight want a supervisor to view the employees
at a particular site only. The site list must contain the site (in this case, Kanata) to which the
user may gain access.

l User list—You create a user list to restrict a user from chatting online with certain employees.
The user list must contain the employees with which the user may chat. For example, you
might want managers to chat online with only the employees they supervise. If Janemanages
Bill, Sue, andGeorge, then you assign Jane an advanced security role that permits Jane to
chat with Bill, Sue, andGeorge (the user list would contain Bill, Sue, andGeorge).

l Card design list—You create a card design list to restrict users frommanaging card designs
(card designs specify the information displayed on agent, employee, and extension real-time
monitors).
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To create a security list

1. In Contact Center Management, click YourSite=>Security=>Security lists=> and select the
security list you want to create.

2. Click Add.
The Add list tab appears.

3. AfterName, type the list name (for example, type Jane’s chat group).
4. AfterDescription, type the list description (for example, type Jane’s group).
5. Click theMembers tab.
6. If you are creating a device or reports list, after Filter by, select a category to narrow the items

that appear in the list (for example, Agent group).
7. Select the check boxes of themembers you want to include in the list.
8. Click Save.

The security list appears in the list tree.

CONFIGURING SECURITY
NOTE:When users first access the Contact Center Management website, by default, they can
access all of the Contact Center Management Web applications.

You can create basic security to restrict user access to specific areas of the Contact Center
Management website. For example, if you want to restrict users from viewing Contact Center Client
and Enterprise Configuration, then youmust create a security role with those characteristics. (See
Figure 8.)

Youmust create a security list before you can create an advanced security role. Using these lists,
you define a security role. See "Creating security lists" on page 80.
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Figure 8: Basic security tab

To configure security

1. In Contact Center Management, click YourSite=>Security=>Security roles.
The Security roles window appears. It lists all of the security roles that have been created.

2. Click Add a role.
3. AfterRole name, type the name of the security role, (for example, Contact Center

Management only).
4. AfterRole description, type the description of this security role, (for example, No access to

YourSite Explorer).
5. On theBasic tab, clear the check boxes of the items the user is not permitted to use. For

example, if agents are not permitted to administer security, clearMay manage security.
6. If required, click theAdvanced tab and specify advanced security.

An advanced security role restricts access to reports, real-time and Interactive Contact
Center statistics, Chat, sites, and real-timemonitors. (See Figure 9.)

7. Click Save.
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Figure 9: Advanced security tab

VERIFYING SECURITYROLEPROPERTIES
To verify the properties of a security role

1. In Contact Center Management, click YourSite=>Security=>Security roles.
The Security roles window appears. It lists all of the security roles that have been created.

2. Click View adjacent to the security role for which you want to view properties.
You can assign the security roles to new users and to existing users.
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ASSIGNING SECURITYROLESTO EMPLOYEES
NOTE:Users who are currently logged on will not be affected by changes made to their associated
role until the next time they log on. If you want the security role changes to take effect immediately,
start and stop the Contact Center Management website from the Internet Server Manager. Ensure
that you log off and log on again.

To assign a security role to an employee

1. In YourSite Explorer, click Employees.
2. Click Employees.
3. Click theUser account tab.
4. AfterSecurity role, select a security role to assign to the employee.

All security roles are listed here.
5. Click Save.

ANI ANDDNIS CALL ROUTING
ANI call routing directs calls to queues based on their phone numbers, enabling contact centers to
ensure that specific regions of callers or even specific callers are routed to the desired queues. For
contact centers operating for businesses with strong international presence, ANI call routing ensures
that callers are being routed to the correct point of contact.

DNIS call routing directs calls to queues based on the phone number the caller dialed, enabling
contact centers to ensure that callers calling for a specific business or product line are routed to the
correct queues. For contact centers supportingmultiple businesses or product lines, DNIS call
routing improves efficiency by ensuring that callers reach the correct point of contact andminimizes
the chance of agent error in answering call from a queue incorrectly.

NOTE:When routing calls by DNIS in a Skype for Business Server environment with existing
telephony infrastructure, DNIS must be provisioned based on the numbers coming into the Skype for
Business Server.

CONFIGURING ANI ANDDNISROUTING
The configuration of ANI and DNIS routing for your contact center is done throughmanually creating
two .csv files named AniRouting.csv and DnisRouting.csv, either from scratch or by using the
sample .csv files provided in <drive>:\Program Files\prairieFyre Software
Inc\CCM\Services\RouterService\Routing.

NOTE: If you use AniRouting.sample.csv and DnisRouting.sample.csv for ANI and DNIS routing,
youmust copy and rename the sample files as these will be rewritten with every upgrade and fix
pack.
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Routing conditions in the .csv files must have the format of Name, ANI/DNIS, Media Server, and
Destination, such as:

Eastern Ontario,613XXXXXXX,Default Microsoft UC Server,sip:supportqueue@mitel.com

Calls will be redirected to the specified destination if the ANI matches any ANI condition reported in
the AniRouting.csv file or if the DNIS matches any DNIS condition reported in the DnisRouting.csv
file. By default, calls route first by ANI and then by DNIS, but this routing order may be changed. ANI
and DNIS routing conditions in the .csv files are checked starting with the ANI or DNIS condition
with the fewest wildcards.

Guidelines for configuring the format and syntax of the .csv files for ANI and DNIS routing, as well
as guidelines for changing the routing order of ANI and DNIS, can be found at <drive>:\Program
Files\prairieFyre Software Inc\CCM\Services\RouterService\Routing\ReadMe.txt.



Chapter 5
REAL-TIME MONITORS 

Contact Center Client
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REAL-TIME MONITORS
The Enterprise Server continuously updates the real-time applications with Skype for Business
Server system data.

Supervisors use the real-timemonitors located in Contact Center Client to view real-time voice
statistics for agents, employees, extensions, and queues and the phone availability of contact
center and general business employees. Contact Center Client real-timemonitors are automatically
updated to reflect device and device group changes made in YourSite Explorer and provide
supervisors point-and-click access to real-time performance statistics for their contact center,
enabling both agents and supervisors to identify issues in contact center performance and see who
is available to answer or assist with calls.

CONTACT CENTERCLIENT
Contact Center Client is a real-time application in which supervisors can view real-time voice
statistics and the availability of contact center and general business employees.

In addition to real-timemonitors, Contact Center Client includes the following application areas:

l Network Monitor
Network Monitor provides information on the status of media server real-time data collection.
See "Network Monitor" on page 226.

l Management Console
UsingManagement Console, network administrators can restart services, administer the
database, and perform maintenance functions.
See "Management Console" on page 29.

l Interactive Contact Center
Interactive Contact Center enables supervisors to control the availability of agents and ACD
queues.
See "Interactive Contact Center" on page 235.

NOTE:

l Employees must be licensed for real time and reporting in YourSite Explorer in order to be
visible in Contact Center Client.

l If you want Supervisors to be able to view all real-timemonitors and devices in Contact
Center Client, youmust set up their security role accordingly. See "Configuring security" on
page 81.

l A queuemust be amember of a queue group in order for you to view the queue on the queue
groupmonitors in Contact Center Client.

STARTING CONTACTCENTERCLIENT
You use Contact Center Client to access real-time functionality. Supervisors can view real-time
voice statistics. After starting Contact Center Client, you can choose tominimize it to either the
system tray or the taskbar, depending on your operating system.

NOTE: Launching client-side applications from the task bar causes them to bypass the Updater
Service process. To ensure successful updates from the Enterprise Server, after an upgrade close
all client-side applications for 15minutes or reopen them from the Start menu/Start screen.
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To start Contact Center Client

1. Click Start=>Programs=>prairieFyre Software=>Contact Center Client.
2. Type your user name and password and verify the Enterprise Server IP address.

When logged intoWindows as a domain authenticated user with Active Directory
authentication a username and passwordmay not be required.

3. If you use Secure Socket Layer, select SSL.
4. Click Log on.

To display Contact Center Client in the taskbar

1. In Contact Center Client, click Tools=>Options.
2. UnderDevice control, clear theHide when minimized check box and click OK.

Contact Center Client, whenminimized, will display in the taskbar.
3. To save the profile, click File=>Save as.
4. Type aName for the profile and click OK.

The profile is saved and will automatically be applied each time you open Contact Center
Client.

AGENTSTATES
NOTE: If Contact Center Client becomes disconnected from the server, upon re-connection agent
states will automatically be synchronized with the server.

Table 3 lists the agent states and their corresponding icons.
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ICON NAME DEFINITION

Ringing An ACD call ringing at an agent’s workstation, waiting to be handled

ACD An agent handling an ACD call

Idle An agent logged on and waiting to receive a call

Non ACD An agent involved in an incoming non-ACD call or agent-originated call

Outbound An agent on an outgoing call

Do Not
Disturb

An agent activated DoNot Disturb and is not available to receive any ACD or
non-ACD calls

Make
Busy

An agent is not available to receive ACD calls but can receive calls dialed
directly to their Line URI (SIP endpoint)

Work
Timer An agent who is completing paperwork and is unavailable to receive calls

Unknown An agent has not generated any activity since Contact Center Management
was started

Logged
Off An agent not currently logged in to any queue

Table 3: Agent states

EMPLOYEENON-ACDSTATES
NOTE: If your Contact Center Client becomes disconnected from the server, upon re-connection the
Employee non- ACD states will automatically be synchronized with the server.

Extension states apply to general business employees or logged-out agents.

Table 4 lists the extension states and their corresponding icons.
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ICON TERM MEANING

Ringing Call is ringing on the extension and waiting to be handled

Idle Employee is waiting to receive a call

Non-ACD Employee is involved in an incoming call or an internal extension-
originated call

Non-ACD
Hold

Employee has placed an incoming call or an internal extension-
originated call on hold

Outbound
Call Employee is on an outgoing call

Outbound
Hold Employee has placed an outgoing call on hold

DoNot
Disturb

Employee has activated DoNot Disturb and is not available to receive
calls

Logged off Employee is not currently logged on and is unavailable to take calls

Table 4: Employee non-ACD states
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UNDERSTANDING CONTACTCENTERCLIENT FEATURES
Contact Center Client enables you to view and customize agent, employee, extension, queue, and
queue chart monitors.

NOTE:

l Contact Center Client has a tabbed interface for managing and arranging windows. You can
dock themonitors, displaying them on overlapping tabbed panels to maximize real estate.
This enables you to readily navigate betweenmonitors.

l You can save threshold settings and display characteristics you define for monitors. When
you click File=>Save, Contact Center Client saves all openmonitors under one profile name.
You can click File=>Open to open another profile, or File=>New to create a new profile.

You can perform the following tasks on themonitors:

l Openmonitors
l Position Contact Center Client
l Dock monitors
l Add and remove devices
l Sort monitor devices
l Rearrange cells
l Set monitor dimensions
l Configure columns
l Filter device variables
l Set alarms
l Clear alarms
l Definemonitor styles
l Customize the information displayed
l Group data
l Print monitors
l Build marqueemonitors to broadcast statistics andmessages
l Start a conversation (send an instant message, call, or start a video call)
l Configure chart characteristics

Positioning Contact Center Client
When you right-click amonitor tab, underWindows, the Dock Contact Center Client command
docks Contact Center Client at the top, bottom, left, or right of your desktop.

When you right-click amonitor tab, underWindows, and select the Always on top command,
Contact Center Client always displays on your desktop on top of all other open applications.
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Openingmonitors
To open amonitor

1. Click View=>Real time.
2. Select themonitor you want to open from the drop-down lists underPosition, Time, Shift,

andNow.
3. In the left pane of theAdd/Remove device IDswindow, click Media server (on agent

monitors only) to sort themembers by media server, click Reporting to sort themembers by
Reporting number, or click Name to sort themembers alphabetically.
You can sort members in either ascending or descending order.

4. UnderAgent Groups andAgents, select agent groups and agents to monitor.
5. UnderCard Designs, select a card design.

Card designs specify the information displayed on agent, employee, and extensionmonitors.
See "Selecting and customizing card designs" on page 100.

6. Click OK.

Dockingmonitors
You can dock monitors and readily navigate between them. You can dock amonitor to the top,
bottom, left, or right of another monitor. Alternatively, you can dock amonitor on the top, bottom, left,
or right side of the Contact Center Client window. You can dock monitors on top of one another,
displaying them on overlapping tabbed panels to maximize real estate.

To dock amonitor on top of another monitor

1. Right-click the title bar of an openmonitor and select Dock.
2. Repeat step 1 for all openmonitors.
3. Click the title bar of amonitor and drag themonitor on top of a secondmonitor placing your

cursor in the center of the four-headed arrow that displays.
See Figure 10.
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Figure 10: Docking monitors

4. Release themouse button.
Your monitors are displayed on overlapping tabbed panels.
See Figure 11.

Figure 11: Docked monitor

Adding and removing devices
The Add/Remove devices command adds or removes devices or device groups from themonitor.
The Add/Remove devices option is not available for chart monitors.

NOTE: If you add agents, they are added to the bottom of themonitor.
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To add devices to amonitor

1. Right-click an openmonitor and click Add/Remove devices.
2. Under Agent/Employee/Queue groups, select additional agent, employee, or queue groups to

add to themonitor, or under Agent/Employee/Queues, select additional agents, employees, or
queues to add to themonitor.

3. Click OK.
On the Agent State by Position and Employee State by Positionmonitors a blank row of cells
separates the original agents from those you just added. To remove the blank row youmust
sort themonitor.

To remove devices from amonitor

1. Right-click an openmonitor and click Add/Remove devices.
2. Under Agents/Employees/Queues, clear the check boxes of the agents, employees, or

queues you want to remove.
3. Click OK.

Sortingmonitor devices
When you select devices to display on amonitor, you can specify the devices be sorted by media
server (on agent monitors only), ID, or name (alphabetically) in ascending or descending order. When
themonitor opens, the devices will display in the order you selected.

To sort the devices displayed on amonitor

l In the left pane of theAdd/Remove deviceswindow, click Media server to sort themembers
by media server, click Name to sort themembers alphabetically, or click Reporting to sort
themembers by ID, in either ascending or descending order.

On the Agent State by Positionmonitor the Sort monitor=>by Agent ID, name, state, or extension
command sorts agents by Agent ID, name, state and time in state, or extension.

On the Employee State by Position and Extension State by Positionmonitors, the Sort monitor=>by
name, state, or extension command sorts agents by name, state and time in state, or extension.

If you sort agents or employees by state, Contact Center Client displays the agents or employees by
state and time in state across themonitor in the following order:

l Ringing
l ACD
l Idle
l Non-ACD
l Outbound
l DoNot Disturb
l Make Busy
l SystemMake Busy
l Unknown
l LoggedOff
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Rearranging cells and columns
You can rearrange cells on the Agent State by Position, Employee State by Position, and Extension
State by Positionmonitors.

To rearrange cells

l On an openmonitor, drag a cell to a different position on themonitor.

You can rearrange columns on the Agent Shift, Queue by Period, Queue Now, andQueueGroup
Now monitors.

To rearrange columns

1. Right-click an openmonitor and click Properties.
2. Click the Layout folder.
3. Click Column order.
4. Click a column header and click the up or down arrow key to change the position of the column

relative to other columns on themonitor.

Settingmonitor dimensions
You can specify the number of rows and columns of cells to display on the Agent State by Position,
Employee State by Position, and Extension State by Positionmonitors. You can then adjust the
table to fit within themonitor frame.

To set table dimensions

1. Right-click amonitor and click Set table dimensions.
2. AfterColumns, type a number.
3. AfterRows, type a number.
4. Click OK.

Columns or rows are added or deleted from themonitor. You can redistribute the cells using a
drag-and-drop operation.

To size the table to fit the frame

l Right-click in any real-timemonitor and select Size table to frame.

Configuring columns
You can configure the way columns display in real-timemonitors by right-clicking themonitor and
selecting Properties=>Layout. Using this option, you can specify the background color, font color,
font type, and text alignment for columns. You can also specify the column height and width and hide
or display individual columns and the order in which columns display.

Filtering device variables
On theQueue Now, Agent Shift, Queue by Period, andQueueGroup Now monitors, you can filter
specific device variables. For example, on the Queue by Periodmonitor, you could filter the Calls
Offered variable and display statistics for the intervals during which the queue was offered five or
more calls.
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To filter device variables

1. Right-click amonitor and click Filter device variables.
2. Click Filter data to show, select a variable, select an operand, and type a number.
3. Click OK.

A subset of the data is displayed based on the conditions defined in the filter.

Setting alarms
The Set alarms command specifies performance thresholds for queues and agents.

You can define alarms to alert you to significant changes in contact center activity. Using the
alarms, you specify performance thresholds for contact center elements, such as queues and
agents, and be notified immediately by customizable visual, auditory, and email alarms of any
availability or performance issues. The alarms can then instantly change agent and queue
availability to adjust to unplanned call volumes.

Client alarms are specific to each computer. To notify you that performance thresholds are not being
met, you can configure alarms so that

l Monitor cells and statistics change color.
l A pop-up notification appears on your desktop.
l A sound prompt, such as a beep or .wav file, plays.
l You are notified by email.
l Contact Center Client appears on top of all open applications.

To configure alarms for real-timemonitors

1. Add performance thresholds.
2. Specify threshold colors.
3. Specify threshold notification.

Adding performance thresholds
To add performance thresholds so you canmonitor alarms

1. Right-click amonitor and click Set alarms.
The Set alarms window appears.
NOTE:You can select the Apply the alarm thresholds to all devices displayed on themonitor
check box to apply the threshold settings for performance variables across all queues or
agents. Alternately, you can select Apply the alarm thresholds to a specific list of devices to
apply the threshold settings for a performance variables to a list of queues or agents.

2. UnderDevices, select one or more queues or agents or select theSelect all check box to
select all queues or agents.

3. In thePerformance variables list, select a variable.
4. UnderAlarm Thresholds, click Add threshold and type a value for the upper boundary of

the threshold.
The lower boundary cannot bemodified. The lower boundary of the next threshold is always
slightly greater than the upper boundary of the previous threshold.

5. Click OK.
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Consider the threshold programming in Figure 12. When the number of agents available in the
technical support queue is between 0 and 2, the cell housing the Agents Available statistic is red.
When the number of agents available is between 3 and 4, the cell turns orange. When the number of
agents available is 5 or greater, the cell turns white. In addition, audible alarms and pop-up alarms
appear.

To clear any current client alarms in Contact Center Client

l Right-click themonitor and click Clear alarms.

Figure 12: Set alarms window

Specifying performance threshold colors
To configure performance threshold colors

1. For the alarm threshold for which you want to specify colors, underBackground, click the
arrow.
A color palate appears.

2. Select a color.
3. Under Font color, click the arrow.

A color palate appears.
4. Select the font color for the alarm threshold.
5. Click OK.
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Specifying threshold sound notification
To configure performance threshold sound notification

1. For the alarm threshold for which you want to be notified by a sound, underSound, select the
check box.
The Sound window appears.

2. Specify the alarm triggering properties.
3. Specify the sound you want played when the alarm is triggered.
4. Click Save.

Specifying threshold pop-up window notification
To configure performance threshold pop-up window notification

1. For the alarm threshold for which you want to be notified by a pop-up window, underPop-up,
select the check box.
The Pop-up window appears.

2. AfterDuration, type the number of seconds you want the pop-up alarm to be displayed when
threshold conditions are satisfied.

3. If you want to display the pop-up alarm on top of all of the other applications, select theKeep
this message visible on mouse over check box.

4. Optionally, click the Format font button to specify font attributes for the pop-up alarm
message.

5. In the text box, type themessage for the performance threshold and click theAdd variable
button to insert performance variables. (for example, type CW P001 = <calls waiting
variable>).

6. Click Save.

Specifying Contact Center Client appear on top
To specify Contact Center Client appear on top of all other applications when a performance
threshold is satisfied

l For the alarm threshold for which you want to be notified, underBring to front, select the
check box.

Specifying threshold email notification
To configure performance threshold email notification

1. For the alarm threshold for which you want to be notified, or notify others by email, under
Email, select the check box.
The Email window appears.

2. AfterDistribution, specify which contacts are to be notified by email when threshold
conditions are satisfied.

3. AfterSubject, type the subject of the email to be sent (for example, type Calls Wtg in Sales
Queue 1 >10!).

4. In themessage box, type the body of the email.
5. Click Save.
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Definingmonitor styles
You can customize the appearance of individual monitor elements. For example, you can configure
the font size and color of column headings or apply a skin of predefined colors and font attributes to
the entire monitor.

To customize the appearance of monitor elements

1. Right-click an openmonitor and click Properties.
2. Click General=>General settings.
3. If you want to change the title of themonitor, after Title, type a name.
4. If you want to scroll horizontally on themonitor, select theEnable horizontal scroll bars

check box.
5. If you want to scroll vertically on themonitor, select theEnable vertical scroll bars check

box.
6. If you want to groupmonitor headings, select theEnable grouping check box.
7. If you want to apply a skin to themonitor, click Layout=>Monitor style.
8. Click Load style and select a skin.
9. Otherwise, underProperties, manually configure the column settings, column font, row

settings, and row-alternate settings.
10. Click OK.

Customizing the information displayed
On the Agent and Employee by Position and by Timemonitors, real-time information is displayed in
cells (cards). You can select from available card designs, or customize cards to display specific
information.

When you first open an agent or employeemonitor, you can select a card design on the Add/Remove
device IDs window:

l Silent Monitor Lync is the default card design and displays the agent state, time in the state,
presence, agent or employee name, agent or employee ID (or queue name for agents on ACD
or on ACD Hold), and whether the agent is tagged to be silent monitored. When an agent is
tagged to be silent monitored the thumbtack icon is blue and a note indicating their tagged
status displays.

l The Classic card displays the agent state, time in the state, presence, agent or employee
name, and agent or employee ID (or queue name for agents on ACD or on ACD Hold).

l Custom cards you create and share.

You can create new card designs or copy existing card designs andmodify them. For example, you
can add or remove text and variables from cards and rearrange the information displayed. You can
share card designs with other employees. When you select a card design for an agent or employee
monitor, it is applied to all monitors of that type.
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Selecting and customizing card designs
To select a card design

1. Right-click an open position or timemonitor and click Properties.
2. Click Layout=>Card design.
3. UnderDesign name, select a card design.
4. Click OK.

To customize cards for position and timemonitors

1. UnderCard design,
l If you want to create a card design, click New.
l If you want to edit an existing card design, select a card design and click Edit.
l If you want to create a card design based on the Classic card, select it and click Copy.

2. On theNew card designwindow, type the name of the new card design.
3. If you want to share the design with other agents, select Share design.
4. Click OK.
5. Select the card and click Edit.

See Figure 13.
6. AfterState, select a state for the card design.

You can use the same card design for all states or you can customize cards for specific
states, such as ACD, Idle, Make Busy, and Unknown.

7. Under Fields, select a field type and drag and drop it to the card design.
l If you want to resize the field, click the field and use your pointer to move or resize the
field.

l If you want to change the properties for a field, click the field and change the properties
in the right pane of Card Designer.

l If you want to change the size of the card design preview, after Zoom, select a different
magnification value from the list.

8. Add additional fields to the card.
9. Select Copy to if you want to copy the current design to the card of a different state.
10. Click OK.

The new card design appears on the Card design list.
11. Click OK.
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Figure 13: Card design window

Adding text to card designs
You can use a text box to add custom text to a card.

To edit text that you have added to a card

1. Select the text box.
Properties appear on the right.

2. UnderProperties, in the box to the right of Text, type the text to be added to the card.
3. Click OK.
4. Click OK.

Grouping data
You can group rows of data in the Queue Now monitor, and other monitors that contain columns. For
example, you can group the data by the ACD count statistic and readily see which agents handled
themost calls, and which agents handled the least calls, as illustrated in Figure 14.
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Figure 14: Enable grouping

The Enable grouping option displays a grouping panel to which users drag columns. The grouping
order determines the order in which the rows appear.

To enable grouping

1. Right-click an openmonitor and click Properties.
2. Select theEnable grouping check box.
3. Click OK.

Themonitor displays a grouping panel.
4. Drag a column heading to the panel to group by the column heading.

Printingmonitors
To print a monitor

1. Right-click an openmonitor and click Print monitor.
The Page Setup window displays,

2. Specify printing options.
3. Click OK.

Buildingmarqueemonitors
You can build amarqueemonitors to broadcast real-time statistics andmessages and alarm on real-
time contact center performance statistics. With marqueemonitors and wall-mountedmarquee
displays, such as LCD monitors or LED reader boards, you can offer your supervisors and agents
access to important contact center performancemetrics.

To build amarqueemonitor, youmust

l Specify styles for themarqueemonitor.
l Configuremarquee text and variables.
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Configuring marquee monitor styles
To specify attributes for themarquee background

1. Click theMarquee icon.
The Configuremarquee window appears.

2. Click Add message.
The Addmessage window displays.

3. Type a name for themessage.
4. UnderPosition, select Top, Right, Left, Center, orBottom to specify how themessage is

to be displayed on themarquee.
5. Click Format marquee.

The Format marquee window appears.
6. AfterBackground color, select a color for the background.
7. AfterCell color, select a color for themarquee cells.
8. AfterCell size, specify a value for the size of themarquee cells.
9. AfterCell spacing, select a value for the space betweenmarquee cells.
10. To specify themarquee text font type and color, click Format font.

The Font window displays.
11. Select font attributes.
12. Click OK.
13. If you want themessage and the background of themessage to be displayed using pixels,

select theMatrix style check box.
14. Click OK.
15. Click OK.

Themarquee displays.
Youmust configuremarquee text and variables.
See "Configuringmarquee text and variables" on page 103.

Configuring marquee text and variables
To configure text and variables for themarquee

1. Right-click themarquee and click Configure marquee.
The Configuremarquee window displays.

2. In theMessage editor text box, type amessage to display on themarquee (for example, type
Calls Wtg =).

3. UnderMessage editor, click theAdd variable button.
The Add/Edit variable window displays.

4. Click Add.
The Configure variable window displays.

5. UnderVariable types, click themonitor type to which the variable applies.
6. UnderVariables, click a variable.
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7. UnderDevices, select the check box of a device.
8. Under Thresholds, click Add threshold and specify a value for the upper boundary of the

first threshold.
9. Click OK.
10. For the threshold, underVariable, select a color to be displayed in themarqueemessage

string.
11. For the threshold, underMessage, select a color for the text that will precede the variable in

themarquee text string.
12. After Type a name for the variable, type a name.
13. Click OK.
14. On theConfigure marqueewindow, in theMessage editor text box, position your pointer

where you want to add the variable.
You can add variables at the beginning, middle, or end of message strings.

15. On theAdd/Edit variablewindow, double-click the variable to add it to themessage string.
16. Click theAdd variable button.

TheAdd/Edit variable window displays.
17. Click theConfigure transition effects button and select the check boxes for the transition

effects to be included.
18. Click OK.

Themarquee displays the text you typed and a real-time value for the performance variable.
You can define additional thresholds for the performance variable, and add additional variables
to themarquee.

Configuring chart characteristics
You can select specific call statistics to display on queue charts.

You can right-click chart titles, axis labels, and other areas of charts to

l Edit axis label titles, including text color and font
l Edit axis labels, including text color, font, and attitude
l Define chart characteristics, includingmonitor lines, interlacing, legend, color, point labels,
and alarms

l Define queue chart (monitor) characteristics

Defining queue chart properties
Under Chart properties, you can select general chart characteristics, such as colors and stacked
effects. You can define series characteristics, such as the type of chart, the fill properties, and the
shape of the bars. In addition, you can define y axis characteristics.

To define queue chart properties

1. Right-click an open queuemonitor and click Chart properties.
2. On theGeneral tab, specify general chart characteristics (colors, effects, and 3D).
3. Click theSeries tab.
4. Specify series characteristics (chart style, fill style, bar type, and border style).
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5. Click theY Axis tab.
6. Specify axis scale characteristics, label characteristics, and the width and color of the axis

line.
7. Click OK.

Selecting call statistics to display
Under Properties, you can select call statistics to display. For example, you can add Calls Waiting,
Agents Available, Idle, and Requeued statistics to the Queue Now (Integer) chart. (See Figure 15.)

Figure 15: Queue Now (Integer) chart

To select call statistics to display

1. Right-click an open queuemonitor and click Properties.
2. Expand theChart properties tree and click Series data.
3. Select theSeries data type: Integer, Percentage, or Time.
4. UnderVisible, select the check box of the data you want to add to the chart.
5. Alternatively, underVisible, clear the check box of the data you want to remove from the

chart.
6. Click OK.
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Specifying the queue chart title
Under Properties, you can specify the title of the queue chart.

To specify the queue chart title

1. Right-click an open queue chart and click Properties.
2. AfterMonitor title, select and delete the chart title.
3. AfterMonitor title, type the new queue chart title.
4. Click OK.

Specifying x and y axis titles
To specify an x or y axis title

1. Right-click the numbers or titles of an axis and select Edit title.
2. Type the new queue chart title and press Enter.

Enabling the x axis to scroll on queue charts
Under Properties, you can enable the x axis to scroll on queue charts. When the scroll feature is
enabled, and when call statistics cannot all be displayed along the x axis due to space constraints,
the x axis becomes a scroll bar. You slide the scroll bar to view all of the statistics displayed along
the x axis.

To enable the x axis to scroll on queue charts

1. Right-click an open queuemonitor and click Properties.
2. Expand theChart properties tree and click General.
3. Select theScrollable check box.
4. Click OK.

Highlighting statistics
Under Properties, you can enable the highlight feature. When the highlight feature is enabled, and
when youmove your cursor over a bar representing a specific call statistic, that bar is highlighted
and the other bars, representing other call statistics, are dimmed.

To highlight statistics

1. Right-click the open queuemonitor and click Properties.
2. Expand the Chart properties tree and click General.
3. Select theHighlight check box.
4. Click OK.
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Specifying the angle of the text label for the queue chart
Under Properties, you can specify the angle of the text label for the queue chart.

To specify the angle of the text label

1. Right-click the open queuemonitor and click Properties.
2. Expand the Chart properties tree and click General.
3. AfterPoint label angle, specify the angle at which you want the text to display.

For example, if the columns are close together, youmight want to use a text label angle of 90
degrees so that the text is not crowded.

4. Click OK.

REAL-TIMEMONITORS INCONTACTCENTERCLIENT
The following real-timemonitors and queue charts are available to supervisors in Contact Center
Client:

l Agent State by Positionmonitor
l Employee State by Positionmonitor
l Extension State by Positionmonitor
l Agent State by Timemonitor
l Employee State by Timemonitor
l Agent State by Queue by Timemonitor
l Agent Shift monitor
l Queue by Periodmonitor
l Queue Now monitor
l Queue Now chart
l QueueGroup Now chart
l Queue Performance by Period chart
l Logmonitor
l Error monitor
l Forecasting
l Marquee
l ACD/SMDR Inspectors

To view real-timemonitors and charts in Contact Center Client:

l Click Real-time and select themonitor or chart you want to view from the drop-down list. (See
Figure 16.)
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Figure 16: Real-time monitor and chart menu in Contact Center Client

VIEWING AGENTAVAILABILITY
On the agent, employee, and extensionmonitors, supervisors can view the availability and presence
of contact center employees.

Agent, Employee, and Extension State by Position monitors
On the Agent, Employee, and Extension by Positionmonitors, supervisors can view the availability
and presence of employees before transferring calls or sending instant messages. (See Figure 17.) If
an agent cell in amonitor is grayed out, the agent is not connected to the network and is considered
out of service.

Figure 17: Agent State by Position monitor

The Agent, Employee, and Extension State by Positionmonitors provide real-time information in
cells you can arrange tomirror your floor plan: you can view agents, employees, or extensions by
their physical position in your contact center. In addition, thesemonitors enable you to view the
current status of general business extensions. Card designs enable you to customize the
information displayed in the cells.
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When you first open an agent, employee, or extensionmonitor, you can select a card design:

l The Classic card displays the agent state, time in the state, presence, agent/employee name,
agent ID/employee ID, and extension number (or queue name for voice agents on ACD or on
ACD Hold).

l Custom cards you create and share

You can set alarms for all real-time statistics.

NOTE:Agents can join multiple agent groups and, thus, answer for multiple queues. However, each
agent has only one ID and displays in a single cell of each applicable monitor. The agent activity that
displays in themonitor cell reflects their current overriding action.

Viewing extensions
You can set up your real-timemonitor profile to include two or more Extension by Positionmonitors:
one with cells that are arranged to show the whereabouts of agents in your contact center, and
another that shows the status of general business extensions: active/inactive, inbound/outbound.
The Extension State by Positionmonitor shows the state of agents who are not logged into the
system. You can use the Extension State by Positionmonitor to view the non-ACD activity of
employees and the current status of general business extensions. (See Figure 18.)

Figure 18: Extension State by Position monitor

Extension Inbound

Extension Inbound refers to a general business extension on an inbound call.

Extension Outbound

Extension Outbound refers to a general business extension on an outbound call.
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General business active extension

General business active extension refers to an active extension that is not logged on to any ACD
queue.

General business inactive extension

General business inactive extension refers to an extension that is not active because the computer
is turned off or Contact Center Client is not running.

General business, traditional extensions who sit at the same desks each day

If you have general business, traditional extensions who sit at the same desks each day, you use
the Extension State by Positionmonitor to view where they are sitting in the contact center. After
you add their extensions to themonitor, you can arrange the cells to match the layout of your
business, or arrange them alphabetically or by department.

When a general business employee is in Idle, the cell for the employee’s phone extension in the
Extension State by Positionmonitor displays the employee’s name and extension number and the
General business active icon. When the employee is on an incoming/outgoing call, the cell displays
the Extension Inbound/Extension Outbound icon, the employee’s name and extension number, and
the time in state.

If you prefer that Extension State by Positionmonitor cells be blank when there are no agents logged
on to the system, you can right-click themonitor, select Properties, and clear the Enable the general
business view check box.

Agent State and Employee State by Time monitors
The Agent State by Time and Employee State by Timemonitors provide real-time agent information
under ACD, Idle, Non ACD, Unavailable, and LoggedOff column headings. They display the same
real-time information as that of the Agent State by Position, Employee State by Position, and
Extension State by Positionmonitors. For more information, see "Agent, Employee, and Extension
State by Positionmonitors" on page 108.

Each column lists agents in order of time in state. You can specify which columns of agent statistics
are displayed, and the order in which they are displayed. You can sort logged off agents by the
longest logged off first. (See Figure 19.)
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Figure 19: Agent State by Time monitor

Table 5 lists the Agent State by Time and Employee State by Time column headings and their
associated agent states.

CATEGORY ASSOCIATED AGENT STATES

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non-ACD includes agents in Non ACD, in Non ACD Hold, Outbound agents, andOutbound
Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, Work Timer, and Unknown

LoggedOff includes agents in the LoggedOff state

Table 5: Agent State by Time and Employee State by Time column headings

Agent State by Queue by Time monitor
The Agent State by Queue by Timemonitor is designed specifically for contact centers using Agent
Group Presence functionality. The Agent State by Queue by Timemonitor is accessed from the
Timemenu in Contact Center Client and displays all agents configured in a specific queue and
agents who are on ACD calls, idle, on non-ACD calls, unavailable, logged on to the system (but not
present in the queue beingmonitored), and logged off. (See Figure 20.)
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Figure 20: Agent State by Queue by Time monitor

Table 6 lists the Agent State by Queue by Time column headings and their associated agent states.

CATEGORY ASSOCIATED AGENT STATES

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non ACD includes agents in Non ACD, in Non ACD Hold, Outbound agents, and
Outbound Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, andWork Timer

Logged on to
system

includes agents who are logged on to the telephone system but not in the
queue beingmonitored

LoggedOff includes agents in the LoggedOff and Unknown states

Table 6: Agent State by Queue by Time column headings

Agent Shift monitor
The Agent Shift monitor provides running totals of statistics on individual agents for the day. You can
specify which columns of statistics are displayed, rearrange columns, and sort individual columns in
ascending or descending order. (See Figure 21.)



MiContact Center for Microsoft Skype User Guide

113

Figure 21: Agent Shift monitor

Table 7 lists the Agent Shift column headings and their definitions.

TERM MEANING

Agent State The agent's current state

Media Server Themedia server to which the agent is associated

Agent Login ID The agent's login ID

Name The name of the agent beingmonitored

Extension
Number The extension where the agent is logged in

LoggedOn the time the agent logged on

Last Event
Received the last time an agent performed an event (for example, answered a call)

Shift Time the total shift time for the agent

ACD Time the total time the agent spent on ACD calls

ACD Hold Time the total time for ACD calls put on hold

Non-ACD Time the total time the agent spent on non-ACD calls

Non-ACD Hold
Time the total time for non-ACD calls put on hold

Outbound Time the total time the agent spent on outbound calls

Outbound Hold
Time the total time for outbound calls agents put on hold

DoNot Disturb
Time the total time the agent spent in the DoNot Disturb state

Table 7: Agent Shift column headings
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TERM MEANING

Make Busy
Time the total time the agent spent in theMake Busy state

Wrap Up Time the total time the agent spent in theWork Timer state

DoNot Disturb
Count the number of times the agent entered the DoNot Disturb state

Make Busy
Count the number of times the agent entered theMake Busy state

ACD Count the total number of ACD calls answered by the agent

Short ACD
Count the total number of ACD calls answered that lasted less than 20 seconds

Hold ACD
Count the number of times the agent put ACD calls on hold

Non-ACD
Count the total number of non-ACD calls answered by the agent

Non-ACD Hold
Count the number of times the agent put non-ACD calls on hold

Outbound
Count the total number of outgoing calls the agent made

Outbound Hold
Count the number of times the agent put outgoing calls on hold

Calls Per Hour the average number of incoming ACD calls answered by the agent per hour
since the beginning of the shift

On Failover Indicates whether the primary media server is offline and has failed over to the
secondary media server

Agent
Unavailable%

the percent of time the agent was set in Do Not Disturb or Make Busy and
unavailable

Average Handle the average amount of time the agent spent handling ACD calls (ACD Time
divided by ACD Count)

Occupancy the total time the agent spent in an occupied state (occupied state excludes idle
time)

Table 7: Agent Shift column headings (continued)
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VIEWING QUEUESTATISTICS
The followingmonitors display queue statistics:

l Queue by Period
l Queue Now
l QueueGroup Now

Queue by Periodmonitor
TheQueue by Periodmonitor collates queue statistics by 15-minute intervals over a 24-hour period.
Themonitor refreshes each time there is a change in a statistic and each 15-minute interval. The
Queue by Periodmonitor can be configured to display the current 15minute interval at the top of the
monitor. You can specify which columns of statistics are displayed, rearrange columns, and sort
individual columns in ascending or descending order. (See Figure 22.)

Figure 22: Queue by Period monitor

Table 8 describes the Queue by Period column headings.
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TERM MEANING

Offered the total number of calls offered to the queue during the 15-minute interval

Handled the total number of calls answered by agents during the 15-minute interval

Short
Abandoned

during the 15-minute interval, the total number of calls abandoned before the short
abandon time configured in YourSite

Abandoned the total number of calls abandoned during the 15-minute interval before being
answered by agents

Interflowed the total number of calls interflowed during the 15-minute interval

Requeued the total number of calls re-queued during the 15-minute interval

% Handled by
1-4

a count of all of the calls answered by the first, second, third, and fourth answer
points during the 15-minute interval

#Handled by
1-4

the number of calls answered by the first, second, third, and fourth answer points
during the 15-minute interval

Total Talk
Time the total time agents spent talking to callers during the 15-minute interval

Average Talk
Time the average time agents spent talking to callers during the 15-minute interval

Average Time
to Handle

the average number of minutes callers waited before agents answered their calls
during the 15-minute interval

Average Time
to Abandon

the average number of minutes callers waited during the 15-minute interval before
they abandoned their calls

Average Time
to Interflow

the average number of minutes callers waited during the 15-minute interval before
being interflowed

Service Level
% Today

during the 15-minute interval, the percentage of calls answered within the Service
Level Time specified for the queue

% Handled during the 15-minute interval, the percentage of calls answered compared to the
total number of calls offered to the ACD queue for the day

Wrap Up the total time the agent spent in theWork Timer state during the 15-minute
interval

Make Busy the total time the agent spent in theMake Busy state during the 15-minute interval

Occupancy the total time the agent spent in an occupied state during the 15-minute interval
(occupied state excludes idle time)

Table 8: Queue by Period column headings
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QueueNow andQueueGroup Nowmonitors
Contact Center Client updates Longest Waiting statistics every fifteen seconds, or more frequently
as records are received from the telephone system. Contact Center Client obtains the Calls Waiting,
Longest Waiting, and Agents Available statistics from the ACD data stream. If the telephone system
has not updated Contact Center Management with ACD real-time statistics within the last 90
seconds, questionmarks appear in place of these statistics.

The Average Handling Time is the Average Talk Time plus the Average Hold Time. If an agent calls
a supervisor in search of more information (while the caller is on hold) and/or transfers or
conferences the call, these times are added to the Average Handling Time value. If an agent fails to
answer an ACD call after X seconds or X rings, the call is requeued in the same queue and offered to
the next available agent.

On theQueue Now monitor, you can specify which columns of statistics are displayed, rearrange
columns, and sort individual columns in ascending or descending order. You can expand a queue
and view statistics on the agent groups associated with the queue. You can expand an agent group
and view performance statistics on the agents in the group. (See Figure 23.)

If you expand theQueue Now monitor to display the Agent name column, themonitor displays agent
presence in the queue. Presence is indicated by a colored star in the Present column. A green star
indicates the agent is present in the queue. A gray star and gray row indicates the agent is not
present in the queue.

Figure 23: Queue Now monitor

Table 9 describes the real-time and over-the-business day Queue Now andQueueGroup Now
statistics.
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TERM MEANING

Calls Waiting
the current number of callers queued up waiting for an agent to become
available, including those listening to silence, music, or recorded
announcements

Longest
Waiting

the current duration, in minutes and seconds, of the call waiting the longest in
queue

Agents
Available

the current number of agents logged on and not in Do Not Disturb, Make Busy,
Work Timer, Unknown, or Ringing

ACD the current number of agents handling ACD calls

Idle the current number of agents logged on and ready to receive calls

Non-ACD the current number of agents handling non-ACD calls

Outbound the current number of agents on outgoing calls

Unavailable the current number of agents in Do Not Disturb, Make Busy, Work Timer,
Unknown, or Ringing

Offered the total number of calls offered to the queue

Handled the total number of calls answered by agents for the day

Abandoned the total number of calls abandoned before being answered by an agent for the
day

Interflowed the total number of calls interflowed for the day. Interflow is amechanism that
directs a call waiting in queue to another answer point.

Requeued the total number of calls re-queued for the day

Average Time
to Handle the average time it takes for the call to be answered by an agent

Average Time
to Abandon the current average duration callers wait before abandoning calls

Average Talk
Time The current average time agents spend talking to callers

Service Level
%

the percentage of calls answered within your Service Level Time value over the
day

% Handled the percentage of calls answered compared to the total number of calls offered
to the ACD queue for the day

% Handled by
1-4

the percentage of all of the calls answered by the first, second, third, and fourth
answer points

Table 9: Queue Now and Queue Group Now column headings
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TERM MEANING

#Handled by 1-
4

the number of calls answered by the first, second, third, and fourth answer
points

Total Talk Time the current total time agents spend talking to callers

Current Queue
Unavailable

the total number of callers that were rerouted after you set the queue to
Unavailable. When youmake the queue available again, this value resets to
zero.

Total Queue
Unavailable

the total number of times during the day callers dialed the queue and were
rerouted because no agents were logged on to the queue or you set the queue to
Unavailable

Offered Last
Hour the total number of calls offered to the queue in the last hour of business

Time to Handle
Last Hour

the predicted duration callers, who call in the last hour of business, wait before
being answered by an agent

% Handled Last
Hour

the percentage of calls answered in the last hour of business, compared to the
total number of calls offered to the ACD queue for the day

Service Level
% Last Hour

the percentage of calls answered within your Service Level Time value in the
last hour

Interflowed Last
Hour

the total number of calls interflowed during the last hour of business. Interflow is
amechanism that directs a queue delayed call to voicemail or to another
answering point

Handled Last
Hour the total number of calls answered by agents during the last hour of business

Abandoned
Last Hour the total number of calls abandoned during the last hour of business

Unavailable
Last Hour

the total number of times, in the last hour of business, callers dialed the queue
and were rerouted because no agents were logged on to the queue or you set the
queue to Unavailable

Average
Handling Time
Last Hour

the average duration of calls from agent pick up to client hang up (including hold
time) during the last hour of business

Offered Last 15
Minutes the total number of calls offered to the queue in the last 15minutes of business

Time to Handle
Last 15Minutes

the predicted duration callers, who call in the last 15minutes of business, wait
before being answered by an agent

Table 9: Queue Now and Queue Group Now column headings (continued)
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TERM MEANING

Average
Handling Time
Last 15Minutes

the average duration of calls from agent pick up to client hang up (including hold
time) during the last 15minutes of business

% Handled Last
15Minutes

the percentage of calls answered in the last 15minutes of business, compared
to the total number of calls offered to the ACD queue for the day

Service Level
% Last 15
minutes

the percentage of calls answered within your Service Level Time value in the
last 15minutes of business

Handled Last
15Minutes

the total number of calls answered by agents during the last 15minutes of
business

Abandoned
Last 15Minutes the total number of calls abandoned during the last 15minutes of business

Interflowed Last
15Minutes

the total number of calls interflowed during the last 15minutes of business.
Interflow is amechanism that directs a queue delayed call to voicemail or to
another answering point

Unavailable
Last 15Minutes

the total number of times, in the last 15minutes of business, callers dialed the
queue and were rerouted because no agents were logged on to the queue or you
set the queue to Unavailable

% Abandoned the percentage of calls that were abandoned. The% Abandoned = (Calls
Abandoned ÷ Calls Offered).

% Abandoned
Last Hour the percentage of calls that were abandoned in the last hour of business.

% Abandoned
Last 15Minutes the percentage of calls that were abandoned in the last 15minutes of business.

Agent
Unavailable%

the percent of time the agent was set in Do Not Disturb or Make Busy and
unavailable

Wrap Up the total time the agent spent in theWork Timer state

Make Busy the total time the agent spent in theMake Busy state

Occupancy the total time the agent spent in an occupied state (occupied state excludes idle
time)

Table 9: Queue Now and Queue Group Now column headings (continued)
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VIEWING QUEUECHARTSTATISTICS
The following charts display queue statistics:

l Queue Now
l QueueGroup Now
l Queue Performance by Period
l QueueGroup Performance by Period

QueueNow andQueueGroup Now charts
TheQueue Now andQueueGroup Now (Integer) charts show the total calls Handled, Abandoned,
and Interflowed across queues and queue groups for the day. (See Figure 24.)

Figure 24: Queue Now (Integer) chart
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Queue Performance by Period andQueueGroup Performance by
Period charts
TheQueue Performance by Period andQueueGroup Performance by Period charts show the calls
Handled, Abandoned, and Interflowed across 15-minute intervals for queues and queue groups. (See
Figure 25.)

Figure 25: Queue Performance by Period chart

VIEWINGWEBPAGES
While using Contact Center Client, you can view web pages using theWeb browser monitor.

To view aweb page within Contact Center Client

1. Click View=>Web Browser.
TheWeb Browser Properties window opens.

2. AfterMonitor title, type a name for themonitor.
3. AfterStart URL, type theWeb address of the website to view.

NOTE: The website address must begin with http:// or you will not be able to view themonitor.
4. Optionally, select a value for theWeb Browser refresh rate.
5. Click OK.
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STARTING ACONVERSATION
Supervisors can start conversations with employees and agents using the employee, agent, and
extension by position and by timemonitors. The conversation can be an instant message, a call, or a
video call and can be addressed to an individual agent, employee, or extension or to any or all
agents, employees, and extensions in the selectedmonitor.

NOTE:Video calls cannot be placed with everyone in amonitor simultaneously.

To start a conversation

1. Right-click a cell in an agent, employee, or extension by position or by timemonitor.
2. Click Conversation and select whether you want to send an instant message, place a call, or

start a video call.
See Figure 26.

3. If you want to send an instant message or place a call to all members in themonitor, select
Entire Monitor.

Figure 26: Starting a conversation in Contact Center Client
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SILENTMONITORING CALLS
Silent monitoring is the process of listening to the voice conversations of internal and external calls
between agents and callers. Silent monitoring enables you to track call handling techniques and
determine where improvements can bemade in individual performance. Supervisors canmonitor
calls to assess agent competency or to assist agents who request help. Silent monitor requests are
made in agent state by position and agent state by timemonitors in Contact Center Client.
Supervisors can either tag agents to have future incoming calls silent monitored or spontaneously
monitor a currently active call. When an agent who has been tagged for silent monitoring receives a
call a pop-up notification displays on the supervisor's desktop. At any time in the conversation the
supervisor can choose to 'whisper' to the agent (only the agent hears the supervisor) or 'barge' into
the call (both the agent and the caller hear the supervisor).

NOTE:

l To be able to silent monitor agent calls youmust have the 'Is Supervisor' check box selected
in the employee configuration page of YourSite Explorer. See "Adding employees" on page 55.

l Supervisors must be running Contact Center Client in order to access whisper and barge
functionality.

To silent monitor an active call

1. In Contact Center Client, right-click a cell in an agent state by position or by timemonitor.
2. Click Agent Control>Silent Monitor>Monitor Active Call.

NOTE: In the agent's Skype for Business conversation window the agent only sees
themselves and the caller. The agent is unaware they are beingmonitored.
Only one supervisor at a time can silent monitor a call.

To tag an inactive agent to be silent monitored

1. In Contact Center Client, right-click a cell in an agent state by position or by timemonitor.
2. Click Agent Control>Silent Monitor>Tag Agent.

When a call is routed to the tagged agent the supervisor will receive a pop-up notification
advising that the call is available for monitoring. If a supervisor has multiple agents tagged to
be silent monitored they will receive a pop-up for each agent as they receive calls.
NOTE:When an agent is currently tagged to be silent monitored a blue thumbtack icon
displays in the agent's cell in the Contact Center Client monitor advising other supervisors
that the agent is already selected to be silent monitored. Only one supervisor at a time can
silent monitor a call. If more than one supervisor tags the same agent, when the agent
receives a call the first supervisor to accept the silent monitor event is conferenced into the
call. The other supervisor(s) receives a pop-up notification that the agent is already being
silent monitored.

To remove a silent monitor tag

1. In Contact Center Client, right-click a cell in an agent state by position or by timemonitor.
2. Click Agent Control>Silent Monitor>Untag Agent.
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Towhisper or barge into a call

l If you want to join a call so only the agent can hear you, clickWhisper in an active call
conversation window.

l If you want to join a call so both the agent and the caller can hear you, click Barge in an active
call conversation window.
NOTE: For a supervisor to whisper or barge, the call must be part of an active silent monitor
session. When a supervisor chooses to whisper or barge into a call the agent receives a pop-
up notification in their conversation window. If a supervisor barges into a conversation, they
cannot return to a silent monitoring or whisper mode.

To handle a request for help

1. Click Accept in the Request Help pop-up window to be engaged in a silent monitor session
with the agent requesting help.
When you click Accept, you join the call in silent monitor mode. You can optionally choose to
whisper or barge into the call if necessary.
If you are silent monitoring a call and the agent on that call requests help, the request for help
will be offered to you first. If you decline the request it will be offered to an alternate
supervisor.

2. To decline a request for help, click Decline.
3. To redirect a request for help, click Redirect.

See Figure 27.

Figure 27: Request for help window
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SKYPE FOR BUSINESS AND IGNITE FOR SKYPE
Agent actions in MiContact Center for Skype are performed in Skype for Business Client and in the
Ignite for Skype toolbar. Skype for Business Client provides the core communication capabilities for
contact center agents, determining agent presence, housing call handling and chat functions, as well
as displaying queues and agents, including the presence and ACD status of other contact center
agents.

Ignite for Skype is a toolbar that docks to Skype for Business, supplementing and augmenting
Skype for Business. Using Ignite for Skype, agents can change their real-time state to augment their
Skype for Business presence, log in and out of ACD, join or leave agent groups, cancel Work Timer,
request help from a supervisor while in a call, and view statistics for themselves, other agents, and
queues.

For more information about our products, click theMitel icon in the Ignite for Skype toolbar to
navigate to theMitel website. Additionally, you can access our help documentation by clicking the '?'
icon.

AGENT PRESENCE
Agent presence improves communication in a contact center by enabling agents to control their
availability, as well as providing other agents and supervisors a visual indication of what agents are
currently doing in the contact center. Before contacting another agent, transferring a call, or initiating
a conference, co-workers can see at a glance whether the agent they need is available. Agent status
and availability are displayed in both the Skype for Business client, which displays Skype for
Business presence, and in the Ignite for Skype toolbar, which displays an agent’s real-time state.
Agent presence in a contact center determines the agent’s ability to handle calls and provides real-
time statistics on agent behavior for contact center supervisors.

VIEWING AGENTSTATUSANDAVAILABILITY
An agent’s Skype for Business presence and real-time state determines their status and availability.
An agent’s real-time state is displayed in the Ignite for Skype toolbar, while their Skype for Business
presence is displayed in the Skype for Business client.

Ignite for Skype status and availability
The Ignite for Skype toolbar displays an agent’s real-time state as an icon at the top of the toolbar.
These Ignite for Skype icons correspond directly to agent and employee states in Contact Center
Client. An agent’s Ignite for Skype real-time icon is visible to other agents in the Agent Stats
dashboard view. For more information on the Ignite for Skype dashboard, see "Viewing agent
statistics" on page 144.

Ignite for Skype buttons for Agent Actions, Make Busy, and DoNot Disturb also provide visual
indications of an agent’s state. If an agent is logged in, the Agent Actions button becomes active. If
Make Busy or Do Not Disturb have been set, their buttons become active correspondingly. (See
Figure 28.)
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Figure 28: Ignite for Skype sidebar real-time presence

Skype for Business status and availability
Skype for Business presence is indicated by a colored bar adjacent to the agent’s photo in their
Skype for Business client. This presence indicator is also visible to other agents in the list of
contacts displayed in Skype for Business, although it may also display as a small square icon if a
user configures their contacts to display in Name view. For more information on Skype for Business
presence, see "Skype for Business presence indicators" on page 130. (See Figure 29.)

Figure 29: Lync with Picture view (left) and Name view (right)
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Skype for Business also displays a statement regarding agent contact center presence. Agent
presence inMiContact Center for Skype is primarily determined by agent interactivity with Skype for
Business, augmented by agent and supervisor activity within Ignite for Skype and Contact Center
Client. This combined Skype for Business and real-time agent presence displays as a statement
under the agent’s name in the following format: Real-time state – Reason code (if relevant) –
Skype for Business presence.

For example, in Figure 30, an agent is listed as being in Make Busy –Meeting – Busy. Their real-time
state is Make Busy, theMake Busy reason code is Meeting, and their Skype for Business presence
is Busy.

Figure 30: Lync client with presence statement

When on a call, the agent presence statement changes to: Real-time state – Call information–
Skype for Business presence. Call information varies depending on the type of call being handled,
but may include information such as queue information, ANI, or SIP address.

For example, in Figure 31, an agent is handling a non-ACD call from a fellow contact center agent.
They are listed as Non ACD – sip:joshua_roesler@mitel.com – In a call. Their real-time state is Non
ACD, the call information lists the SIP address of the caller, and their Skype for Business presence
is In a call, which is Busy.

Figure 31: Agent presence statement on non-ACD call
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Skype for Business presence indicators
Skype for Business presence is the primary determinate for agent presence inMiContact Center for
Skype. See Table 10 for a description of Skype for Business presence indicators.

PRESENCE
ICON

(LARGE)

PRESENCE
ICON

(SMALL)

STATUS
TEXT DESCRIPTION

Available

The contact is online and can participate in
conversations. Users canmanually set this status,
but the next automatic state change will override
this setting.

Busy

The contact is available, but is engaged by another
activity. Busy contacts will not be routed ACD calls,
but may receive non-ACD calls. Possible activities
include the following:

In a Call—the contact is in a phone, voice, or
video conversation.

In a Meeting—theOutlook calendar shows that
the contact has a scheduledmeeting.

Users canmanually set this status.

Do Not
Disturb

The contact is engaged by another activity and is
unavailable. Contacts in Do Not Disturb will neither
receive ACD or non-ACD calls. Users canmanually
set this status.

Table 10: Skype for Business presence indicator icons
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PRESENCE
ICON

(LARGE)

PRESENCE
ICON

(SMALL)

STATUS
TEXT DESCRIPTION

Away /
Inactive

Be Right
Back

Off Work

The contact is likely unavailable. Possible reasons
include the following:

The contact’s computer has been idle for more
than the away time period setting (5minutes by
default).

NOTE:By default, the transition from Available
to Inactive occurs after fiveminutes. After five
moreminutes, the status changes to Away if
there is still no activity on the computer.

The contact’s Outlook calendar or Out of Office
Assistant indicates that they are out of the
office.

The contact is temporarily unavailable

NOTE:As soon as activity is detected on the
contact’s computer, Ignite for Skype
automatically resets the presence status to the
appropriate state.

The contact has locked their computer.

The contact has manually set their presence to
Away or Be Right Back.

Users canmanually set this status.

NOTE:

l When a user manually sets themselves as Away,
they are still available to receive calls, such as
from a transfer.

l If a user is in Make Busy or Do Not Disturb, they
must first change their Skype for Business
presence to Available before changing their
Skype for Business presence to Be Right Back,
Off-Work, or Appear Away otherwise theMake
Busy or Do Not Disturb presence is not removed
as intended.

Table 10: Skype for Business presence indicator icons (continued)
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PRESENCE
ICON

(LARGE)

PRESENCE
ICON

(SMALL)

STATUS
TEXT DESCRIPTION

Offline

The contact is not available. Possible reasons for
this include the following:

The contact has manually set their presence
status to Appear Offline.

The contact has not signed into Skype for
Business.

The contact has blocked you from seeing their
presence status.

Skype for Business is not running on the
contact’s computer.

Presence
unknown

Skype for Business cannot determine the status of
the contact. This status is typically displayed
because the contact’s presence status is
unavailable to Skype for Business, such as for a
contact who is part of an organization that is not a
federated partner.

Table 10: Skype for Business presence indicator icons (continued)
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Ignite for Skype real-time state icons
The Ignite for Skype toolbar, in addition to providing an agent with contact center tools and statistics,
displays an agent’s real-time presence in the contact center, reflecting the agent’s agent and
employee state in Contact Center Client. See Table 11 for a description of Ignite for Skype real-time
state icons.

For a detailed description of Employee and Agent states, see "Agent states" on page 88 and
"Employee non-ACD states" on page 89.

IGNITE FOR
SKYPE

PRESENCE
INDICATOR

REAL-TIME
STATE ICON

Logged off Logged off

Logged in, not
present for ACD  Idle

Available for
ACD Idle

Available for ACD Icons Logged in, not present for
ACD icons

Make Busy Make Busy

DoNot Disturb DoNot Disturb

ACD Ringing ACD Ringing - -

ACD ACD - -

Table 11: Ignite for Skype real-time state icons
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IGNITE FOR
SKYPE

PRESENCE
INDICATOR

REAL-TIME
STATE ICON

Hold - ACD - -

Non ACD Non ACD

Outbound Outbound

Hold - Outbound Outbound Hold

Work Timer Work Timer - -

Unknown Unknown

Table 11: Ignite for Skype real-time state icons (continued)

AGENTPRESENCEBEHAVIOR
Agent presence is primarily determined by agent interactivity with Skype for Business, but can be
affected by agent and supervisor activity within Ignite for Skype and Contact Center Client.
Changing one’s Skype for Business presence or real-time state affects agent presence as a whole.

NOTE:Supervisors have control over the real-time presence of agents, but they can only affect the
Skype for Business presence of agents in limited ways, such as through setting and removingMake
Busy.

Skype for Business presence change behavior
Agents can change their Skype for Business presence state at any time, including during a call,
either on-site or remotely. Agent activities entered into Outlook calendars can affect an agent’s
presence as well if the Skype for Business option 'Updatemy presence based onmy calendar
information' is enabled. We do not recommend enabling this option. When an agent’s Skype for
Business presence state changes, their real-time state changes accordingly. Table 12 details how
changing Skype for Business presence affects real-time state.
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SKYPE FOR BUSINESS
PRESENCE CHANGE REAL-TIME PRESENCE

Available Idle

Do Not Disturb Do Not Disturb - No Reason Code

Busy Make Busy - No Reason Code

Away (Be Right Back, Off
Work, andAppear Away)

Does not change real-time presence.

If set during a call, real-time state
changes to Idle when the call ends.

Offline Logged Out

Table 12: The effect of Skype for Business Presence change on real-
time presence

Skype for Business presence can be changed while an agent is handling a call, but the change only
takes full effect after the call is finished. If an agent sets themselves into Busy, Do Not Disturb, or
Away, the Skype for Business presence indicator changes to the appropriate color and the presence
statement’s Skype for Business segment changes accordingly. Once the call ends, the agent
presence sets to the new Skype for Business presence and their real-time state adjusts accordingly.
If an agent changes their Skype for Business presence to Available, they remain in Busy until the
call ends.

Real-time state change behavior
Depending on the actions taken in Ignite for Skype or Contact Center Client, an agent’s real-time
state and Skype for Business presence are adjusted accordingly. See Table 13 for the effects of
Ignite for Skype or Contact Center Client actions on agent presence.
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ACTION IN IGNITE FOR
SKYPE OR CONTACT
CENTER CLIENT

IGNITE AND CONTACT
CENTER CLIENT (REAL-

TIME STATE)

SKYPE FOR BUSINESS
PRESENCE

Logging in

If Skype for Business was
Available orAway, changes
toUnknown, unless
configured to automatically
log into agent groups

If Skype for Business was
Busy orDo Not Disturb,
changes toMake Busy - No
Reason Code orDo Not
Disturb - No Reason Code

If previously Available, changes to
Logged in, not present to ACD -
Available, unless configured to
automatically log into agent groups

If previously Busy, changes to
Make Busy – No Make Busy
Code - Busy

If previously Do Not Disturb,
changes toDo Not Disturb – No
DND Reason Code – Do Not
Disturb

If previously Away (Be Right Back,
Off Work, orAppear Away),
changes to Logged in, not present
to ACD - (Be Right Back, Off
Work, orAppear Away) , unless
configured to automatically log in to
agent groups.

Joining Agent Groups

If Skype for Business was
Available orBusy, changes
to Idle

If Skype for Business was
Busy orDo Not Disturb,
changes toMake Busy - No
Reason Code orDo Not
Disturb - No Reason Code

If previously Available, changes to
Available for ACD – Available

If previously Busy, no change

If previously Do Not Disturb, no
change

If Away (Be Right Back, Off Work,
orAppear Away), changes to –
Available for ACD - (Be Right
Back, Off Work, orAppear Away)

Logging Off Logged Off

If previously Available, Busy, or
Do Not Disturb, changes to
Logged Off (Available)

If previously Away, then changes to
Logged Off (Away)

Set Do Not Disturb Do Not Disturb - (Reason
Code) Do Not Disturb - (Reason Code)

Remove DoNot Disturb
Returns to previous state
beforeDo Not Disturbwas
set

Returns to previous state beforeDo
Not Disturbwas set

Table 13: Ignite for Skype and Contact Center Client agent presence change effects
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ACTION IN IGNITE FOR
SKYPE OR CONTACT
CENTER CLIENT

IGNITE AND CONTACT
CENTER CLIENT (REAL-

TIME STATE)

SKYPE FOR BUSINESS
PRESENCE

Call Ringing Ringing ACD Ringing - Busy

Silent Monitoring a call Non-ACD Non-ACD - In a Call (Busy)

Call routed to Agent, but not
answered

Prior to failure to answer, if
Idle, changes toSystem
Make Busy

Prior to failure to answer, if
Away orDo Not Disturb,
no change

Prior to failure to answer, if
Available, changes toBusy

Prior to failure to answer, if Away or
Do Not Disturb, no change

Table 13: Ignite for Skype and Contact Center Client agent presence change effects
(continued)

Real-time states can be changed while an agent is handling a call using Ignite or Contact Center
Client, but the change only takes full effect after the call is completed. If an agent is logged out
during an ACD call, after the call completes, they will be logged out of their agent group and placed in
Logged in, not present to ACD.

Workstation change behavior
Workstation changes impact Skype for Business presence, which correspondingly affects real-time
state. If an agent is logged in and Idle and they lock their workstation, they are placed in real-time
'Make Busy - SystemMake Busy' and return to 'Idle' when they unlock their workstation. If an agent
is in real-time 'Make Busy' or 'Do Not Disturb' and they lock their workstation, they remain in that
state. If an agent shuts down their workstation, they are automatically 'LoggedOff'. When they
restart their workstation, they are automatically logged back in.

STARTING IGNITE FORSKYPE
Starting and logging into Ignite for Skype is a seamless operation forWindows users who are
properly configured as employees in YourSite Explorer. The employee SIP Address, Line URI, and
login credentials are synchronized between the Active Directory and YourSite Explorer. Once
synchronized, the employee is automatically authenticated with Active Directory when they are
logged in, eliminating the need tomanually enter login credentials. When Ignite for Skype is started,
agents are automatically logged into the group(s) for which they are configured.

NOTE: Launching client-side applications from the task bar causes them to bypass the Updater
Service process. To ensure successful updates from the Enterprise Server, after an upgrade close
all client-side applications for 15minutes or reopen them from the Start menu/Start screen.

To start Ignite for Skype

l Click Start=>All Programs=>prairieFyre Software Inc=>Ignite.
When Ignite for Skype is successfully loaded amessage displays the SIP address of the
agent and the connection status of the Enterprise Server and the Enterprise Routers.
See Figure 32.
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Figure 32: Ignite for Skype active display

JOINING AND LEAVING AGENT GROUPS
Supervisors can join agents to and remove agents from agent groups in Contact Center Client.
Agents can view and control their availability to agent groups they aremembers of by accessing the
Agent Actions button in Ignite for Skype if they have the appropriate ACD policy defined in their
ACD Policy tab in YourSite Explorer=>Employees. (See Figure 33.)

Figure 33: Agent Actions - join and leave agent groups

Default agent groups can be configured for an agent in YourSite Explorer. See "Associating
employees with agent groups" on page 59.

When an agent logs into Ignite for Skype they are automatically joined to their default agent group(s).
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When an agent joins an agent group they are available to take calls from any queue that the agent
group is associated to. When an agent leaves an agent group they are immediately removed from
any queues associated with that agent group.

NOTE: For agents to control their ACD presence in agent groups, they must be configured in
YourSite Explorer with Agent Presence Control. For more information regarding agent availability to
agent groups, see "Configuring system defaults" on page 47.

To log into Ignite for Skype

l Click the Agent Actions button in Ignite for Skype and select Log in.

To join an agent group

1. Click theAgent Actions button in Ignite for Skype.
2. Select the agent group(s) you want to join.
3. If you want to join all agent groups in the list, click Join All.
4. Click Apply.

To leave an agent group

1. Click theAgent Actions button in Ignite for Skype.
2. Deselect the agent group(s) you want to leave.
3. If you want to leave all agent groups in the list, click Leave All.
4. Click Apply.

LOGGING OUT OF ANDCLOSING IGNITE FORSKYPE
To log out of Ignite for Skype

l Click the Agent Actions button in Ignite for Skype and select Log off.
See Figure 34.
When you log off, you are removed from all agent groups and the ACD system but your Ignite
for Skype is still active and can receive and process updates.
NOTE: Agents handling an ACD call cannot log off until the call is complete.

Figure 34: Agent Actions button

To close Ignite for Skype

l Right-click the Ignite for Skype icon in the system tray and select Exit.
See Figure 35.

Figure 35: Ignite for Skype icon
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HANDLING CALLS ANDCALL ROUTING
The agent’s soft phone is embedded in Skype for Business. Outgoing calls aremade by typing the
phone number in the phone number text box. Internal calls can bemade by typing the extension
number in the phone number text box or by right-clicking the agent in the contact list and selecting
Call. Calls are answered by clicking the incoming call pop-up.

ACD Voice routing within MiContact Center for Skype ensures the longest waiting call is routed to
the longest idle agent. Calls from high priority customers can be routed into priority queues to be
answered ahead of other incoming calls. If a call waiting in a queue surpasses the overflow threshold
(themaximum length of time a call waits in queue before being redirected) it is immediately routed to
another queue in another agent group, in addition to remaining in the first queue. The first available
agent in either group handles the call. Calls can queue against amaximum of four agent groups. If
there are still no agents available to answer the call when the interflow timer expires the call is routed
to an alternate answering point, such as another queue or a voicemailbox.

TRANSFERRING CALLS
Occasionally, an agent needs to transfer a call to an alternate point of contact, such as another agent
or supervisor. There are two kinds of transfers available: blind transfers and supervised transfers.
Blind (or unsupervised) transfers simply transfer a call to a destination point. Supervised transfers
can bemade by agents by placing the caller on hold and calling the destination point first, enabling
the agent to check with the agent or supervisor at the destination point before the call is transferred.
Agents can also transfer calls directly to voicemails configured on an Exchange server.

NOTE:ACD transferred calls lastingmore than an hour cause agents to become stuck in their
current state. To work around this issue, after installingMiContact Center for Skype, we recommend
you change the following audit thresholds within the OrandaRouterService.exe.config file:

l EndpointRingingThresholdSec: This setting represents the number of seconds after which a
call that is offered to an agent is considered stale. The default value is 90 seconds. We
recommend changing this to 180 seconds.

l EndpointConnectedThresholdMin: This setting represents the number of minutes after which
a call that is handled by an agent is considered stale. The default value is 60minutes. We
recommend changing this to 720minutes (12 hours).

l EndpointHoldThresholdMin: This setting represents the number of minutes after which a call
that was put on hold is considered stale. The default value is 5minutes. We recommend
changing this to 60minutes.

MAKING ABLINDTRANSFER
Tomake a blind transfer to another agent or queue

1. If you want to place the caller on hold beforemaking the transfer, in the Conversation window
of the call you want to transfer, click theHold icon.

2. In the Ignitewrapper on theConversation window, click Transfer
3. Enter the name of the agent or queue to whom you want to transfer the call.
4. Click the Transfer button beside the destination agent or queue.
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MAKING ASUPERVISEDTRANSFER
Supervised transfers can bemade using one of twomethods:

l Using the 'Merge' option in Skype for Business
l Using the 'Invite' option in Skype for Business

NOTE:

l Dual-tonemulti-frequency signaling (DTMF) is not passed through Skype for Business
conferences to IVRs andmust be entered before you conference the caller and the destination
point.

l When an employee initiates a supervised transfer using the Invite option, the ACD/non-ACD
call is not pegged as Outbound in Agent Performance, Agent Outbound Trace, and Agent
Event by Period reports. When an employee initiates a supervised transfer using theMerge
option, the ACD/Non-ACD call is pegged as Outbound in reports.

Tomake a supervised transfer to an agent using 'Merge'

1. If you want to place the caller on hold beforemaking the transfer, In the Conversation window
of the call you wish to transfer, click theHold icon.

2. In Skype for Business, call the destination point to which you want to transfer the call.
A new Conversation window opens.

3. Inform the agent that you are transferring a call to their extension.
4. In the new Conversation window, click theView participants icon and select the original call

from underMerge This Call Into....
The original call and the transferring agent call aremerged into a single call.

5. Click theHang Up icon.
You are removed from the conversation.

Tomake a supervised transfer to an agent using 'Invite'

1. If you want to place the caller on hold beforemaking the transfer, In the Conversation window
of the call you wish to transfer, click theHold icon.

2. In Ignite for Skype, click theView participants icon and select Invite More People.
3. Select the contact to which you want to transfer the call or, alternatively, type their extension.
4. Click OK.

The invited agent joins the group conversation and can now speak to the caller.
5. Click theHang Up icon.

You are removed from the conversation.

Tomake a supervised transfer to a queue

NOTE:You can only use the 'Invite' option to transfer a call to a queue.

1. In the Conversation window of the call you wish to transfer, click theHold icon.
2. In Ignite for Skype, click theView participants icon and select Invite More People.
3. Select the queue to which you want to transfer the call or, alternatively, the queue ID.
4. Click OK.

The call is presented to the selected queue and will wait to be answered by the next available
agent.
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MAKING ATRANSFERTO ANEXCHANGEVOICEMAIL
Agents can transfer calls directly to a voicemail configured on an Exchange server. If an agent
knows another agent is busy but should handle a call, the agent can transfer the caller directly to the
other agent’s voicemail to leave amessage. If a queue has an Exchange voicemail configured as its
unavailable answer point, agents can also transfer calls to the queue’s voicemail.

NOTE:Voicemails need to be configured on the Exchange Server.

To transfer an active call to voicemail

1. If you want to place the caller on hold beforemaking the transfer, in the Conversation window
of the call you want to transfer, click theHold icon.

2. In the Ignite wrapper on theConversation window, click Transfer.
3. Enter the name of the agent or queue whose voicemail you want to transfer the call.
4. Click the Transfer to Voicemail button beside the destination agent or queue.

REQUESTING HELP
Occasionally, during a call, an agent may require assistance from a supervisor. In these situations,
the agent can use the Request for Help button in Ignite for Skype to request a supervisor to monitor
or join the call. When a supervisor receives a request for help, they can choose to accept, decline, or
redirect the request. If accepted, the supervisor can silent monitor the call or choose to whisper (only
the agent hears the supervisor's voice) or barge (the agent and the caller hear the supervisor's
voice).

If an agent requests help from a supervisor who is already silent monitoring that agent's
conversation, the request for help is automatically offered to that supervisor. If the supervisor
declines the request for help, the request is directed to the next available supervisor. Similarly, if an
agent requests a specific supervisor and that supervisor is unavailable or declines the request, the
request is directed to the next available supervisor. The text within the request for help window
indicates that it is a request for help, so should have a higher priority than other calls tagged for silent
monitoring.

To request help

1. Click theRequest for Help button in Ignite for Skype.
2. Select the supervisor to which you want to direct the request for help.

See Figure 36.
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Figure 36: Request for help window

SENDING AN INSTANT MESSAGE
Using Skype for Business, you can send instant messages to individuals or to multiple contacts.
After initiating a conversation, you can invite additional contacts to the conversation.

NOTE: Supervisors send instant messages to contacts or groups of contacts using Contact Center
Client. See "Starting a conversation" on page 123.

To send an instant message to an individual

1. Double-click a contact in theContact list in Skype for Business.
The Conversation window opens.

2. Type amessage in theConversation window.
3. Press Enter.

To send an instant message tomultiple contacts

1. To send an instant message to a contact group, right-click the group's name in theContact
list and click Send an Instant Message.

2. If you want to select specific contacts from a group, expand the group in theContact list,
press Ctrl, and select the contacts to which you want to send an instant message. Right-click
the last contact selected and click Send an Instant Message.

3. Type amessage in theConversation window.
4. Press Enter.
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To invite additional contacts to a conversation

1. In theConversation window, click thePeople Options icon and select Invite by Name or
Phone Number.

2. Select the contacts you want to invite to the conversation, and click OK.
Alternatively, drag one or more contacts from the Contact list to the Conversation window.

NOTE:

l When you invite people to a conversation, conferencing features become active.
l A group instant messaging conference cannot exceed 100 participants.

VIEWING AGENT STATISTICS
Agents can view personal statistics and those of other agents for the current shift by accessing the
Dashboard button in Ignite for Skype. Agent statistics display in the Dashboard view either in a data
table format or in a bar chart. (See Figure 37 and Figure 38.) Additional agent statistics can be
viewed, by agent, in the Agent Statistics Grid view. (See Figure 39.) Agents can view current agent
stats (ACD, Non ACD, Outbound, Idle, Make Busy, and DoNot Disturb) by clicking the Sidebar
Pager, located at the bottom on the Agent Actions sidebar in Ignite for Skype. (See Figure 40.)

The Agent Statistics Dashboard view includes the following by-count agent and call statistics for the
current shift:

l ACD - the number of ACD calls answered by the agent
l Non-ACD - the number of non-ACD calls answered by the agent
l Outbound - the number of outgoing calls the agent made
l Make Busy - the number of times the agent entered theMake Busy state
l Do Not Disturb - the number of times the agent entered the Do Not Disturb state
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Figure 37: Agent Statistics - Dashboard view with data table display

Figure 38: Agent Statistics - Dashboard view with bar chart display
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The Agent Statistics Grid view includes the following statistics for all agents for the current day:

l Logged On - the time the agent logged on for the shift
l State Duration - the duration of time the agent has spent in their current state
l ACD - the number of ACD calls answered by the agent
l ACD Hold - the number of times the agent put ACD calls on hold
l Non ACD - the number of non-ACD calls answered by the agent
l Non ACD Hold - the number of times the agent put non-ACD calls on hold
l Outbound - the number of outgoing calls the agent made
l Outbound Hold - the number of times the agent put outgoing calls on hold
l DND - the number of times the agent entered the Do Not Disturb state
l DND Duration - the duration of time the agent spent in the Do Not Disturb state
l MKB - the number of times the agent entered theMake Busy state
l MKB Duration - the duration of time the agent spent in theMake Busy state
l Calls Per Hour - the average number of incoming ACD calls answered by the agent per hour
since the beginning of the shift

l Short ACD - the number of ACD calls answered by the agent that lasted less than 20
seconds

l Unavailable % - the percentage of time the agent was set in Make Busy, Do Not Disturb, or
was unavailable

Figure 39: Agent Statistics - Grid view
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The Sidebar Pager view for agent statistics includes the following information for the current shift:

l ACD - the number of ACD calls answered by the agent
l Non ACD - the number of non-ACD calls answered by the agent
l Outbound - the duration of time spent handling outgoing calls
l DND - the duration of time the agent spent in the Do Not Disturb state
l Make Busy - the duration of time the agent spent in theMake Busy state
l Idle - the duration of time the agent spent in the Idle state (logged on and waiting to receive
calls)

Figure 40: Agent Statistics - Sidebar Pager view
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To view agent statistics

1. Click theDashboard button in Ignite for Skype.
2. Click Agent Stats.
3. Click eitherDashboard orGrid, depending on which view you want to display.

You can click and drag to change the order and width of the columns in the Grid view.
4. To change the data display in the Dashboard view click on the data table to toggle to the bar

chart and vice versa.
5. To see one agent only, type the agent's name in the search box.
6. To return to the all-agent display, remove the text from the search box.
7. To see a quick view of ACD and Non-ACD call counts and duration spent in Outbound call

handling, Do Not Disturb, Make Busy, and Idle, click theSidebar Pager, located at the
bottom of the Ignite for Skype Agent Actions sidebar.

VIEWING QUEUE STATISTICS
Agents can see real-time queue statistics in either a data table or bar graph format by accessing the
Dashboard button in Ignite for Skype. Agents can sort and reorder the statistics columns.
Supervisors can see the same statistics in the Queue Now monitor in Contact Center Client. For
more information, see "Queue Now andQueueGroup Now monitors" on page 117.

Statistics are updated with each agent event. For a quick review of each queue, the Queue Statistics
Dashboard view shows a subset of statistics, Offered, Abandoned, Requeued, and Handled, in a bar
chart format and Calls Waiting, Longest Waiting, Agents Logged In, Agents Idle, Calls Offered, and
Calls Abandoned in a data table format. TheQueue Statistics Grid view shows overall queue
statistics, by queue, with each row representing one queue. See Figure 41 and Figure 42 for
examples of the Queue Statistics Dashboard andGrid views. For a list of queue statistics that
display in the Queue Statistics Grid view, see Table 14.
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Figure 41: Queue Statistics - Dashboard view

Figure 42: Queue Statistics - Grid view
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TERM MEANING

Queue Status the current status of the queue

Queue # the queue number

Name the name of the queue

Calls Waiting
the current number of callers queued up waiting for an agent
to become available, including those listening to silence,
music, or recorded announcements

Longest Wait the current duration, in minutes and seconds, of the call
waiting the longest in queue

Agents Available the current number of agents logged on and not in Do Not
Disturb, Make Busy, Work Timer, Unknown, or Ringing

Idle the current number of agents logged on and ready to receive
calls

NotPresent the current number of agent not present in the queue

LoggedOut the current number of agents logged out

Non ACD the current number of agents handling non ACD calls

Outbound the current number of agents on outgoing calls

Unavailable the current number of agents in Do Not Disturb, Make Busy,
Work Timer, Unknown, or Ringing

UnavailablePercent the percentage of time the agent was set in Do Not Disturb,
Make Busy, Work Timer, Unknown, or Ringing

Abandoned the total number of calls abandoned before being answered
by an agent for the day

Avg Talk Time the current average time agents spend talking to callers

Avg Time Abn the current average duration callers wait before abandoning
calls

Average Time to Handle the average time it takes for the call to be answered by an
agent

Current Queue Unavailable
the total number of callers that were rerouted after you set
the queue to Unavailable. When youmake the queue
available again, this value resets to zero.

Handled the total number of calls answered by agents for the day

Table 14: Queue statistics in Ignite for Skype
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TERM MEANING

Handled Percent the percentage of calls answered compared to the total
number of calls offered to the ACD queue for the day

Interflowed the total number of calls interflowed by agents for the day

Last15MinutesAbandoned the total number of calls abandoned during the last 15
minutes of business

Last15MinutesAbandonedPercent the percentage of calls abandoned during the last 15
minutes of business

Last15MinutesAverageHandled
the average duration of calls from agent pick up to client
hang up (including hold time) during the last 15minutes of
business

Last15MinutesHandled the total number of calls answered by agents during the last
15minutes of business

Last15MinutesHandledPercent
the percentage of calls answered in the last 15minutes of
business, compared to the total number of calls offered to
the ACD queue for the day

Last15MinutesInterFlowed the total number of calls interflowed during the last 15
minutes of business

Last15MinutesOffered the total number of calls offered to the queue in the last 15
minutes of business

Last15MinutesServiceLevelPercent the percentage of calls answered within your Service Level
Time value in the last 15minutes of business

Last15MinutesUnavailable

the total number of times, in the last 15minutes of business,
callers dialed the queue and were rerouted because no
agents were logged on to the queue or you set the queue to
Unavailable

LastHourAbandoned the total number of calls abandoned during the last hour of
business

LastHourAbandonedPercent the percentage of calls that were abandoned in the last hour
of business.

LastHourAverageHandled the average duration of calls from agent pick up to client
hang up (including hold time) during the last hour of business

LastHourHandled the total number of calls answered by agents during the last
hour of business

Table 14: Queue statistics in Ignite for Skype (continued)
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TERM MEANING

LastHourHandledPercent
the percentage of calls answered in the last hour of
business, compared to the total number of calls offered to
the ACD queue for the day

LastHourInterFlowed the total number of calls interflowed during the last hour of
business

LastHourOffered the total number of calls offered to the queue in the last hour
of business

LastHourServiceLevelPercent the percentage of calls answered within your Service Level
Time value in the last hour

LastHourTimeToHandle the predicted duration callers, who call in the last hour of
business, wait before being answered by an agent

LastHourUnavailable

the total number of times, in the last hour of business,
callers dialed the queue and were rerouted because no
agents were logged on to the queue or you set the queue to
Unavailable

Offered the total number of calls offered to the queue

Requeued the total number of calls re-queued for the day

Svc Lvl % the percentage of calls answered within your Service Level
Time value over the day

Total Queue Unavailable
the total number of times during the day callers dialed the
queue and were rerouted because no agents were logged on
to the queue or you set the queue to Unavailable

Total Talk Time the current total time agents spend talking to callers

Table 14: Queue statistics in Ignite for Skype (continued)

To view queue statistics

1. Click theDashboard button in Ignite for Skype.
2. Click Queue Stats.
3. Click eitherDashboard orGrid, depending on which view you want to display.

You can click and drag to change the order and width of the columns in the Grid view.
4. To change the data display in the Dashboard view click on the data table to toggle to the bar

chart and vice versa.
5. To see one queue only, type the queue's name in the search box.
6. To return to the all-queue display, remove the text from the search box.
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SETTING ANDREMOVING MAKE BUSY ANDDO NOT
DISTURB

Agents can place themselves in and remove themselves fromMake Busy and DoNot Disturb, with
or without a reason code, using theMake Busy and DoNot Disturb buttons in Ignite for Skype. (See
Figure 43.) Make Busy and DoNot Disturb reason codes display in reports and Contact Center
Client real-timemonitors.

Although agents can set their presence using the Skype for Business presence indicator, we
recommend they use theMake Busy and DoNot Disturb buttons in Ignite for Skype. By doing so,
the agent can set their ownMake Busy and DoNot Disturb reason codes. This will producemore
accurate records of agent activities.

When agents are in theMake Busy and DoNot Disturb states they cannot receive ACD calls.
Agents in Make Busy can receive calls dialed directly to their extension. A non-ACD call sent to an
agent in Do Not Disturb will receive a busy signal or, if programmed, be forwarded to a voicemail.
MiContact Center for Skype enables agents to switch betweenMake Busy and DoNot Disturb
reason codes in Ignite for Skype without having to first clear their states. For example, an agent in a
Make Busy state can switch directly between 'Support' and 'Lunch' reason codes, or betweenMake
Busy and DoNot Disturb states. Agents switching directly between states or reason codes do not
become falsely available for ACD calls.

NOTE:EachMake Busy or Do Not Disturb state and reason code in which an agent places
themselves is considered unique and will be included inMake Busy and DND reports.
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Figure 43: Setting Make Busy

To set Make Busy and DoNot Disturb

1. Click theMake Busy button or theDo Not Disturb button in Ignite for Skype.
The reason codes pane opens.

2. Select aMake Busy Reason or Do Not Disturb reason code from the list.

To removeMake Busy and DoNot Disturb reason codes

1. Click theMake Busy button or theDo Not Disturb button in Ignite for Skype. (See Figure
44.)
The reason codes pane opens with your state selected.

2. Click Remove: (reason for Make Busy or Do Not Disturb).
Your state appears as Available for ACD - <Skype for Business State>.
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Figure 44: Removing Do Not Disturb

DISABLING THE SET TO BUSYONDESKTOP LOCK
IGNITE FORSKYPEOPTION

By default, Skype for Business clients set to the Busy state when your PC locks, setting Ignite for
Skype to SystemMake Busy (or NoMake Busy Reason Code). This prevents you from receiving
ACD calls. If you are using a headset that enables you to work away from your desktop for extended
periods of time, however, this may impede you from receiving calls. This can be disabled on a client
PC basis, enabling you to continue to receive calls after your desktop locks.

To disable Set to Busy on Desktop Lock on a client

1. Open the following directory: <drive>>:\Program Files (x86)\prairieFyre Software
Inc\CCM\Applications\Ignite

2. Open the file LyncIgnite.exe.config in Notepad.
3. Navigate to <add key=“SetBusyOnDesktopLock” value=”true”/>.
4. Change value=“true” to value=“false”.
5. Click File=>Save and close Notepad.
6. Restart the Ignite for Skype client.
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CANCELINGWORK TIMER
If Work Timer is enabled on a queue, agents who answer calls for that queue are placed in aWork
Timer state after completing a call. For information on placing queues inWork Timer, see
"Configuring general information for queues" on page 63. TheWork Timer state provides time for the
agent to complete after-call work. When theWork Timer expires, the agent is automatically placed
back into an Idle state. TheWork Timer can be canceled by the supervisor in Contact Center Client
(see "Canceling agents inWork Timer" on page 237) or by the agent in the Ignite for Skype toolbar.
Canceling theWork Timer immediately makes the agent available to take calls unless there is
another state modifier applied, such as Make Busy or Do Not Disturb.

When an agent is inWork Timer they cannot receive calls. At any time, an agent can cancel Work
Timer. However, if an agent removes themselves fromWork Timer they cannot place themselves
back intoWork Timer.

To cancel Work Timer

l Click theCancel Work Timer button in Ignite for Skype.

COMMUNICATING USING THE EMERGENCY ROUTING
CHAT IVR

If you do not have access to Contact Center Client or YourSite Explorer or the Enterprise Server is
offline in a configuration with an offboarded Router, you can continue tomanage your contact center
using the Emergency Routing Chat IVR. Using simple commands, the Emergency Chat IVR
communicates directly with the router, enabling you to view agent-group-queue associations and
identification information, log agents in and out of agent groups, join agents to or remove agents from
agent groups, open and close queues, view queue statistics and queue information, see a list of calls
waiting in queue, and set or remove DoNot Disturb andMake Busy for individual agents or agents
as part of groups or queues. Table 15 lists each Emergency Chat IVR command and result.

NOTE:Youmust be assigned the security role 'Enterprise Administrator' in order to issue
commands via the Emergency Routing Chat IVR.

To issue commands via the Emergency Routing Chat IVR

1. In Skype for Business, double-click prairieFyre Enterprise ACD, located in the list of
contacts.
If your business uses multiple routers, the prairieFyre Enterprise ACD contact namewill be
appended with the associated Skype for Business server pool name.
NOTE:Before typing commands, disable emoticons in Skype for Business (Options
menu>Tools>Options>General>Deselect 'Show emoticons in instant messages'>OK),
otherwise when the SIP address contains an emoticon hot key combination, the emoticon will
display.

2. To see a list of commands and how to use them, type help in the Conversation window,
otherwise, type the command you want to send to the routers.
NOTE:Some commands require a SIP address for the agent, group, or queue. For example,
to open a queue, type qopen sip:myqueue@mycompany.com.
For a list of commands, see Table 15.

3. Press Enter.
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COMMAND RESULT

QUERYGROUPS

If you enter an agent SIP address this query displays a list of
the default agent groups the agent is associated with, along
with the agent's Reporting Number and Name

If you enter a queue SIP address this query displays a list of
the agent groups associated with the queue, along with the
queue's Reporting Number and Name

ALOGIN Makes agent available to ACD and logs them into their
default ACD agent groups

ALOGOUT Logs agent out of all currently logged in agent groups and out
of the System

AGENTGROUPLOGIN Logs in all agents in the specified agent group

AJOIN Joins agent to specified agent group

ALEAVE Removes the agent from the specified agent group

QOPEN Opens the specified queue

QCLOSE Closes the specified queue to any new incoming calls

QSTAT
Returns the following statistics for the specified queue:
Longest Call Waiting, Calls Waiting, Longest Idle Agent, and
the current state of the queue

QCALLINFO
Displays a list of calls, including ANI, Call ID, and
TimeReceived, that are currently waiting in the specified
queue

SETDND Places agent in Do Not Disturb state

REMOVEDND Removes agent from DoNot Disturb state

SETGROUPDND Places agents in specified agent group in DoNot Disturb
state

REMOVEGROUPDND Removes agents in specified agent group from DoNot
Disturb state

SETQUEUEDND Places agents in specified queue in DoNot Disturb state

REMOVEQUEUEDND Removes agents in specified queue from DoNot Disturb
state

SETMKB Places agent in Make Busy state

Table 15: Emergency Chat IVR commands
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COMMAND RESULT

REMOVEMKB Removes agent fromMake Busy state

SETGROUPMKB Places agents in specified agent group inMake Busy state

REMOVEGROUPMKB Removes agents in specified agent group fromMake Busy
state

SETQUEUEMKB Places agents in specified queue inMake Busy state

REMOVEQUEUEMKB Removes agents in specified queue fromMake Busy state

SYSTEM
Displays a list of all queues, total calls waiting per queue, the
number of agents logged in to the queue, and the current
queue state

HELP Lists all Emergency Chat IVR commands with examples

Table 15: Emergency Chat IVR commands (continued)
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REPORTS
The Reporter and Scheduled Reports applications provide detailed performance statistics. You use
Reporter to produce on-demand reports, and Scheduled Reports to automate report generation. You
can generate reports for day of week, day of month, week, or 15, 30, or 60-minute intervals, and for
over-midnight shifts. You can create presentation-quality tables and charts in Microsoft Excel .xls
format.

The prairieFyre Service analyzes the raw telephone system data with respect to the YourSite
Explorer configuration details. The service then writes the statistical data to Structured Query
Language (SQL). It is this statistical data that sources the reports.

Youmust install Excel on the Enterprise Server to generate reports. If you intend email reports with
Scheduled Reports, youmust set up contacts and contact groups to which you will email reports.

UNDERSTANDING REPORTS
To createmeaningful reports youmust understand reporting concepts.

Service Level is the standardmeasurement of customer service because it provides themost
accurate representation of the customers’ experience. An appropriate Service Level objective is one
that

l Satisfies callers’ expectations for service
l Keeps abandonment in check (at less than five percent)
l Minimizes expenses andmaximizes revenue

Understanding the following terms will help you define your corporate Service Level objective.

Offered

All of the calls received by the ACD queue, regardless of how they are handled or routed, are referred
to as offered calls. Offered contacts include ACD handled calls, abandoned (long) calls, and
interflowed (long) calls. ACD requeued contacts, queue unavailable (path available) contacts, and
abandoned (short) calls are not considered to be offered contacts. The Erlang C equation uses
offered contacts and Average Talk Time data in calculating the agents required.

Handled

Handled calls are calls answered by agents. If an agent answers a call and then forwards it to
another agent or supervisor before the Short Handle time threshold, the call is classified as an ACD
Short Handle Call. You define a Short Handle time threshold for queues.

Abandoned

Abandoned calls are calls that do not reach agents because callers hang up. A call is considered a
Call Abandoned (Long) call when the caller hangs up after the Short Abandon time threshold. If you
define a Short Abandon time of 6 seconds, and a caller hangs up after 7 seconds, the call is
considered a Call Abandoned (Long) call. A call is considered a Call Abandoned (Short) call when the
caller hangs up at or before the Short Abandon time threshold. You define a Short Abandon time
threshold for queues.
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Interflowed

Interflow is a mechanism that directs a call waiting in queue to another answer point. When a call
has been waiting in queue for longer than the interflow time defined in the system, the call is
interflowed and the interflow timer starts. If the interflow timer expires, the call is re-directed to yet
another answer point. The interflow timer runs independently of the overflow timer.

The interflowed statistic represents the number of contacts removed from a queue and sent to
another answer point. Calls Interflowed (Short) calls are calls that interflow before the Short Abandon
time threshold. Calls Interflowed (Long) calls are calls that interflow after theShort Abandon time
threshold.

The Dial Out of Queue feature is a user-initiated interflow feature which removes a call from queue
and sends it to an alternate answer point. A Dial Out of Queue call is considered a non-ACD call in
the reports.

Service Level time

TheService Level time is the time used in calculating the queue service objective, such as 80
percent (Service Level percent) of calls answered within 120 seconds (Service Level time). You
specify a service objective for queues.

Service Level Count

TheService Level Count is the number of contacts answered within the specified Service Level
Time.

Service Level percent

Service Level Percent = Service Level Count ÷ ACD offered.

For calls, the Service Level percent is the number of calls which are handled, abandoned, and
interflowed before the Service Level time, compared to the total number of calls handled, abandoned,
and interflowed. A more detailed equation outlining how Service Level percent is calculated is as
follows:

The Service Level percent = (Handled + Abandoned (Long) + Interflowed (Long)) within the Service
Level time ÷ Total (Handled + Abandoned (Long) + Interflowed (Long)).

In Figure 45, the Service Level objective is to handle 80 percent of calls in less than 30 seconds.
Calls that wait in queue for 60 seconds are routed to voicemail.
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Figure 45: Service Level percent

SETTING THESERVICE LEVELOBJECTIVE
An appropriate Service Level objective is one that

l Satisfies customers’ expectations for service
l Keeps abandonment in check (at less than five percent)
l Minimizes expenses andmaximizes revenue
l Meets with the approval and support of agents, supervisors, and senior management

Queue Service Level objective
You set the queue Service Level objective in YourSite Explorer. See "Adding queues" on page 63.

The voice statistics defaults are

l Service Level percent = 80%
l Service Level time = 20 seconds
l Short abandon threshold = 6 seconds
l Short handle threshold = 20 seconds
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l Overflow = 0 seconds
l Interflow = 0 seconds
l Wrap-up time is disabled by default. We recommend you enableWrap-up time and set it for 1
second.

REPORT TYPES
For a complete description of report types and fields, see theMiContact Center for Microsoft Skype
Reports Guide.

Voice reports provide detailed information about call performance. Voice reports can be generated on
the following devices: Employee, Agent and Agent group, Queue andQueue group, Team,
Extension, DNIS, and Forecast.

RECOMMENDED TOP-FIVE REPORTS
Mitel recommends every contact center use the following top-five reports:

Queue Performance by Period

TheQueue Performance by Period report shows traffic level highs and lows and the Service Level
you provide at these times. Generate this report each day and watch for trends in the traffic level,
abandon rate, and Service Level.

Queue Group Performance by Queue

TheQueueGroup Performance by Queue report compares queues and provides information on the
performance of your entire contact center.

Queue Group (Answer, Handle, Abandon) Spectrum by Queue

The spectrum reports provide valuable information on how calls are dispersed in your contact center.
You can configure answer, handle, and abandon thresholds, and describe the percent breakdown by
time for

l Calls Answered -Which call waited in queue for the greatest duration before an agent
answered? How quickly aremost calls answered?

l Calls Handled -What was the greatest duration an agent spoke to a caller? How quickly do
most agents complete a call?

l Calls Abandoned -What was the greatest duration a caller waited before hanging up?What
was the average time a caller waited in queue before hanging up?

Agent Group Performance by Period

The Agent Group Performance by Period report enables you to identify trends in agent group
performance.

Agent Group Event by Period (hh:mm:ss)

The Agent Group Event by Period (hh:mm:ss) report enables you to compare the performance of
agents who perform similar jobs. This report provides the shift time by agent, and a variety of call
counts and peg counts for phone use.
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USING REPORTS TO IDENTIFY PROBLEMS
The recommended top five reports help you to identify problems that affect your Service Level
objectives. Table 16 and Table 17 address frequently asked questions.

WHAT DO I WATCH FOR IN
THE QUEUE REPORTS?

HOW DO I FIND THE SOURCE OF THE PROBLEM
AND RESOLVE IT?

A drop in Service Level

When does the Service Level drop during the day?

1. Check the Agent Group Performance by Period
report to see the distribution. How many agents
were logged on throughout the day?

2. Examine agent talk times. Do you have a
chatterbox agent?

3. Generate a forecast report with your Service
Level goals to determine the number of agents
required by period for the day. Compare the
forecast statistics to the AverageManned Agent
statistic in the Agent Group Performance by
Period report. Have you scheduled enough
agents to meet your Service Level objective?
Why are some queues not meeting their Service
Level goals while others are?
Check the Agent Group Performance by Queue
report. Are some agent groups overworked?

High abandon callers

Why did the callers hang up?

1. Check the Average Delay to Abandon statistic.
Did the callers hang up because they were
impatient? Did callers wait a long time in queue?
Were agent talk times excessive during this
time? If so, why?

2. Generate the Queue andQueueGroup Abandon
and Unavailable Trace report and then call back
the customers to determine why they
abandoned their calls.

A high requeue count (because it
decreases the Average Speed of
Answer time and the Service

Level)

Are agents forgetting to set themselves as Unavailable on
their Skype for Business Clients before they leave their
desks?

Check the Agent Group Performance by Period
report to see which agents are experiencing
requeues. Remind agents to use the
Unavailable option.

Table 16: Solving problems with queue reports
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WHAT DO I WATCH FOR IN
THE AGENT REPORTS?

HOW DO I FIND THE SOURCE OF THE PROBLEM
AND RESOLVE IT?

Extremely high or low performance
statistics

Do some agents perform 20-30% worse than other
agents?

1. Silent Monitor agents periodically to ensure
they are properly trained to handle callers'
needs, and are not chatting unnecessarily.

2. Check Outbound or Non-ACD statistics for
peg counts and times.

3. Generate an Agent Inbound or Outbound
Trace report to see a list of all calls. Are
agents spending toomuch time on personal
calls?

Do some agents perform 20-30% better than other
agents?

1. High ACD/Non-ACD/Outbound call counts is
not a problem if agents aremaintaining high
Service Levels. Monitor agents periodically to
ensure they are providing a high quality of
service, but not rushing callers.

2. Check the ACD Call Count <20 seconds
statistic in the Agent Event by Period report.
Not many voice transactions can occur in
less than 20 seconds. This could indicate that
agents are 'padding' their ACD handle
statistics by prematurely terminating calls.

High unavailable statistics

Are agents accumulating Unavailable time andMake
Busy peg counts?

1. Check the Agent Event by Period (hh:mm:ss)
report to evaluate individual statistics.
Determine how muchMake Busy and DoNot
Disturb (DND) time agents are logging. Be
sure agents are adhering to your contact
center policies regarding when to useMake
Busy and DoNot Disturb. Check if your
agents are using Unavailable instead of
logging out.

2. Ensure agents are usingMake Busy with
Reason Codes. Assign reasons with which
agents go intoMake Busy. Track Make Busy
use by generating the Agent Performance by
Make Busy / DND Code report.

Table 17: Solving problems with agent reports
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REPORTER
Using the Reporter application, you can generate on-demand reports. You can restrict access to any
or all of the reports with advanced security roles using report lists. See "Creating and applying
security roles" on page 78.

REPORTEROPTIONS
The complete list of Reporter options follows.

l Report type specifies the report name.
l Start date and End date specify the range of dates used in the report. You can pick any
calendar date as the start date and any later date in the calendar year as the end date.

l Start hour and End hour specify the hours of the day included in the report.
l Days to include specifies the days of the week to include in the report.
l Report mode specifies the report period: 15, 30, or 60minutes.
l Email the report to emails the report spreadsheet and graph to the email address either
selected in the email to list or manually typed in. You add contacts and contact groups to the
email to list under theMy options menu.

l Print the report check box prints the report spreadsheet.
l Include the charts when printing prints the report spreadsheet and graph.

SETTING UPCONTACTSANDCONTACTGROUPS
Before you generate a report, if you want to email that report, it is recommended youmust set up

l My email contacts, which includes personal email addresses
l My email contact groups, which includes mailing lists comprised of global contacts andMy
email contacts

Setting up email contacts for emailing reports
To set up groups for emailing reports

1. Click My options=>My contacts=>My email contacts.
TheMy email contacts window opens.

2. Click Add.
The Add contact window opens.

3. Type the first name, last name, and email address of the person to whom you will email
reports.

4. Click Save.

Setting up email contact groups for emailing reports
If you intend to email the report to more than one recipient youmust add the recipients to amailing
list and then associate the recipients with a group.
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To set up groups for emailing reports

1. Click My options=>My contacts=>My email contact groups.
TheMy email contacts window opens.

2. Click Add.
The Add contact window opens.

3. Type the name and description of the email group to which you will email reports.
4. Click Save.

The new email contact group opens on theMy email contact groups window.
5. Across from the record of the contact group, click Members.
6. UnderAvailable contacts, select the check boxes of the contacts you want to add to the

group.
7. Click Add>>.

GENERATING ON-DEMANDREPORTS
You can generate on-demand reports on licensed employees only. The number of employees you
license in YourSite Explorer must be consistent with your software license.

Generating reports
NOTE: The only ACD stream-based report that will work with the over-midnight setting enabled is
the Agent Shift by Period report.

The following steps detail how to generate a Voice Agent Group Performance by Period report.

To generate a report

1. Click Reporter=>Voice=>Agent reports.
The Basic tab appears.
See Figure 46.

2. AfterReport type, select theAgent Group Performance by Period report.
3. AfterAgent group, click one or more agent group.

Hold down the <Shift> key or <Ctrl> key to select more than one agent group.
NOTE: If you want one report that spans two days (for example, from December 3 at 9 P.M. to
December 4 at 5 A.M.), thenmake the Start date and the End date the date the shift begins
(December 3). If youmake the Start date the date the shift begins (December 3) and the End
date the date the shift ends (December 4), you will generate a report that spans three days
(December 3 from 9 P.M. to December 5, 5 A.M.). The time span for each shift cannot exceed
24 hours.

4. AfterStart date and End date, specify the start and end dates for the report.
5. AfterStart hour and End hour, specify the start and end hours for the report.
6. After Interval, specify the time interval in which the statistics will appear in the report.
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7. If your contact center does not operate 24 hours a day, afterReport mode, click Default.
8. If you want to run a report over midnight, click Over midnight.

TheOver midnight report mode is most appropriate for 24-hour contact centers.
9. AfterDays to include, select the days of the week to include in the report.
10. Click the Filter tab.

NOTE: The Filter tab is available for Forecast andMake Busy / DND Code reports only. For
all other report types, skip to step 12.

11. Specify the filtering options to include in the report.
12. Click theAdvanced tab.
13. If you want to create a separate report for each day in the date range you selected, select the

Create one report for each day in the selected date range check box.
14. AfterReport output language, select the language used in the report output.
15. If you want to email the report, select theEmail to check box and specify to whom you will

email the report:
l A contact group, select the this contact group check box, and select a group
l One contact only, select the this contact check box, and select a contact
l A contact that is not listed, select the this email address check box, and type the email
address

You add contacts and contact groups to the Email to list under My options=>My contacts.
16. If you want to print the report spreadsheet, select thePrint the report check box.
17. If you want to print the report chart, select the Include charts when printing check box.
18. Click Submit.

The Report submitted screen appears.
19. Click View Report Inbox.

The Report Inbox window opens, listing all created reports.
20. Click View to open a report.

The report opens inMicrosoft Excel.
NOTE:Protected View is aMicrosoft Office security feature that can impact your ability to
view Excel reports. If you use Excel 2010 or 2013 to view reports, configure the following in
Excel:

l Ensure the following Protected View options are not enabled:
l Enable Protected View for files originating from the Internet
l Enable Protected View for files located in potentially unsafe locations
l Enable Protected View for Outlook attachments
l Enable Data Execution Preventionmode

l Ensure that the following Trusted Location option is selected:
l Allow Trusted Locations onmy network (not recommended).
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Figure 46: Reporter: Basic tab

Emailing reports
To email a report

1. After selecting a report to email, click theAdvanced tab.
2. AfterReport output language, select the language of the report from the list.
3. If you want to email the report spreadsheet, underExcel distribution, select either the this

contact group or this contact check box.
4. Or, if you want to email to a specific address, select the this email address check box and

type the email address.
5. Click Submit.

The Report submitted screen opens.
6. Click View report inbox.
7. AfterComplete, click View.

Printing reports
To print a report

1. After selecting a report to print, click theAdvanced tab.
2. AfterReport output language, select the language of the report from the list.
3. If you want to print the report spreadsheet, underExcel distribution, select thePrint the

report check box.
4. Click Submit.

The Report submitted screen opens.
5. Click View report inbox.
6. AfterComplete, click View.

SCHEDULEDREPORTS
You use Scheduled Reports to automate the generation of voice reports. You can restrict user
access to any or all of the reports with advanced security roles. See "Creating and applying security
roles" on page 78.
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SCHEDULEDREPORTSOPTIONS
To create a scheduled report youmust complete the following options on the properties and
distribution tabs.

l Schedule name is a user defined name to describe the contents of the schedule.
l Schedule will run specifies how often the report will be generated.
l At defines when the scheduled report will be generated.
l Reports time span defines the dates of the report activity to appear in the report.
l Output language specifies the language used in the report tables and charts.
l Email the report to defines the Email contact group to which you are sending the report.
l Print the report indicates that the scheduled report will be printed every time it is generated.

GENERATING SCHEDULEDREPORTS
To generate a scheduled report, youmust follow these steps:

1. Create a report schedule.
2. Add reports to the schedule.

Creating report schedules
You can create schedules for Contact Center Management Reports and Contact Center
Management User Reports.

Using Contact Center Management reports schedules, you can

l Generate reports on all contact center devices.
l Distribute reports to yourself and to a contact, a contact group, or a specific email address.

Using Contact Center Management User reports schedules, you can

l Generate reports on agents and employees.
l Distribute reports automatically to yourself and to the individuals within the agent groups,
employee groups, and/or teams you select.

NOTE: If you select printing andmailing options, Reporting Service prints and emails all of the
reports included in the schedule on the date the system generates the reports.

Creating Contact Center Management report schedules
To create a schedule for Contact Center Management reports

1. Click Reporter=>Scheduled Reports.
The Contact Center Management Report schedules tab opens.

2. Click Next>>.
See Figure 47.

3. AfterSchedule name, type a schedule name.
4. AfterSchedule will run, select the schedule frequency, for example, every day, every

Wednesday, or the start of month.
When you select the day, all of the reports associated with the schedule will be generated that
day, every week.
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5. After at, click the time of day the schedule will be activated.
For example, if you select Wednesday at 7:00 A.M., all of the reports associated with the
schedule will be generated every Wednesday at 7:00 A.M.
NOTE:Reports are based on the data in the CCM database. We recommend you schedule
your reports for after the nightly maintenance routine runs, that is, after 2:00 A.M., to ensure
the reports are based on the entire day’s raw Skype for Business Server data.

6. AfterReports time span, select a time span.
If you select Year to date, the report output includes all of the days from January 1 to the
present date. If you select From given start date to current date you will produce reports for the
period specified.

7. Click theDistribution tab.
8. If you want to email the report to a contact group, underExcel distribution, select theEmail

the report to check box, select the this contact group check box, and then select a group.
NOTE:You add contacts and contact groups to the email to list under My options=>My
contacts.

9. If you want to email the report to one contact only, select theEmail the report to check box,
select the this contact check box, and then select a contact.

10. If you want to email the report to a contact that is not listed, select theEmail the report to
check box, select the this email address check box, and then type an email address.
NOTE:You add contacts and contact groups to the email to list under My options=>My
contacts.

11. If you want to print the report spreadsheet, underExcel distribution, select thePrint the
report check box.

12. If you also want to print the report graphs, select the Include charts when printing check
box.

13. Click Save.
14. Add the reports you want to generate using the schedule you just created.

See "Adding Contact Center Management reports to schedules" on page 173.

Figure 47: Scheduled Reports: Properties tab
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Creating Contact Center Management User report schedules
To create a schedule to automatically email agents/employees their reports

1. Click Reporter=>Scheduled Reports.
2. Click theContact Center Management User report schedules tab.
3. Click Next>>.

The Properties tab opens.
4. AfterSchedule name, type a schedule name.
5. AfterSchedule will run, select the schedule frequency, for example, every day, every

Wednesday, or the start of month.
When you select the day, all of the reports associated with the schedule will be generated that
day, every week.

6. After at, click the time of day the schedule will be activated.
For example, if you select Wednesday at 7:00 A.M., all of the reports associated with the
schedule will be generated every Wednesday at 7:00 A.M.
NOTE:Reports are based on the data in the SQL database. We recommend you schedule
your reports for after the nightly maintenance routine runs, that is, after 2:00 A.M., to ensure
the reports are based on the entire day’s raw telephone system data.

7. AfterReports time span, select a time span.
If you select Year to date, the report output includes all of the days from January 1 to the
present date. If you select From given start date to current date you will produce reports for
your fiscal year.

8. Click theDistribution tab.
You can email reports to members of agent groups, employee groups, and teams.

9. Click the type of group(s) to which you want to email agent and employee reports.
10. Within each type of group, select the check boxes of the groups to which you will email

reports.
11. Click Save.
12. Add reports you want to automatically distribute to the agent group(s), employee group(s) and

teams you selected. 
See "Adding agent and employee reports to Contact Center Management User report
schedules" on page 173.

Adding reports to schedules
NOTE:Before you can add reports to a schedule, youmust create and save the schedule.
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Adding Contact Center Management reports to schedules
To add a report to a Contact Center Management report schedule

1. On theManage schedulewindow, click Add report.
2. Select a report category, for exampleQueue reports.
3. AfterReport type, select a report to add to the schedule.
4. AfterQueue, select the queue(s) for which you will generate reports.
5. AfterDays to include, select the days of the week to include in the report (for example, if you

select a date range of September 1 to September 30, and select Wed and Friday as the days
to include, you will produce a report for theWednesdays and Fridays that fall between
September 1 and September 30).

6. AfterStart hour andEnd hour, select a start hour and end hour for the report.
7. If you are generating an event by period report, after Interval, select the time interval for

reporting.
NOTE: If you want to generate a report that spans two days (for example, from December 3 at
9 P.M. to December 4 at 5 A.M.), then select December 3 for the Start date and the End date.
The time span for each shift cannot exceed 24 hours.

8. AfterReport mode, select Default orOver midnight.
9. Click theAdvanced tab.
10. AfterReport Output language, select a language.
11. Click Submit.

Adding agent and employee reports to Contact Center Management
User report schedules
To add agent and employee reports to a Contact Center Management User reports schedule

1. On theManage schedule window, click Add report.
2. Select a report category, for example agent reports.
3. UnderReport type, select the report you want to add to the schedule.
4. AfterStart hour andEnd hour, select a start hour and end hour for the report.
5. If you are generating an event by period report, after Interval, select the time interval for

reporting.
6. AfterReport mode, select eitherDefault orOver midnight.
7. AfterDays to include, select the days of the week to include in the report (for example, if you

select a date range of September 1 to 30, and select Wednesday and Friday as the days to
include, you will produce a report for theWednesdays and Fridays that fall between
September 1 and September 30).

8. Click theAdvanced tab.
9. AfterReport Output language, select a language.
10. Click Submit.
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Generating scheduled reports immediately
If you want to generate your scheduled reports at a specific time (other than immediately), you
specify the date and time they will be generated when you create the schedule. See "Creating report
schedules" on page 170.

To generate scheduled reports immediately

1. Click Reporter=>Scheduled Reports.
2. AfterSelect a schedule, select the schedule you want to generate.
3. Click Execute schedule now.

The Execute schedule now window opens.
4. In theStart date andEnd date calendars, select start and end dates for the report.
5. Click Submit.

The reports associated with the schedule are generated immediately and placed in your
Report Inbox.

REPORT INBOX
The Report Inbox section of Contact Center Management displays the on-demand, scheduled, and
forecast reports generated under your user name over the past 30 days. Inbox manager deletes
reports from your inbox by date range.

NOTE:

l In Report Inbox, if the report status is Pending for an extended period of time, start Contact
Center Client and confirm the Enterprise Server IP address and your user name and password
are correct by logging in. If you log in automatically, log out from Contact Center Client and log
in with your user name, password, and Enterprise Server IP address.

l In Report Inbox, if Data Limit Exceeded appears, re-generate the report using a shorter time
span.

Report Inbox includes

l Today’s reports displays all of the reports generated today under your user name.
l Yesterday’s reports displays all of the reports generated yesterday under your user name.
l All of your reports displays all of the reports generated under your user name over the last 30
days.

l Inbox Manager deletes reports from your inbox by date range.
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REPORTER INBOXOPTIONS
Report Inbox has the following options.

l Report type lists the report name.
l Media server defines themedia server used in reporting.
l Reporting specifies the reporting number of the device or device group as configured on the
telephone system.

l Name is the name of the device or device group.
l Request date is the date and time the report was generated.
l Status field confirms if your report is ready. When Complete appears in the status field the
report is waiting in your Report inbox. When Pending appears, the report is not ready. No data
means no records were available for the parameters you specified. Failedmeans the report did
not generate. If a report fails, the Reporting Service logs errors in the NT Event log.

l View displays reports generated inMicrosoft Excel.
l Delete deletes reports from your report inbox.

VIEWING REPORTS
To view report details

1. Click View Report Inbox (upon submitting a report) or click Report Inbox=>Today’s
reports.

2. Select theAutomatically refresh this page every 10 seconds check box to automatically
update the Status column.
The Status column indicates if your reports are ready:

l Complete: The report is waiting in your report inbox.
l Pending: The report is not ready.
l No data: No records were available for the parameters you specified.
l Data limit exceeded: The time span selected was too great. Select a shorter time span
and re-generate the report.

l Failed: The report did not generate. If a report fails, Inbox Manager logs errors in the
event log. Clicking Re-submit regenerates the report.

3. Click View to view the report spreadsheet and chart.

EDITING REPORTS INEXCEL
You can graph specific data by highlighting one or more columns of data in the Excel spreadsheet
and using the Excel Chart Wizard. For more information, seeMicrosoft Excel Help.
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DELETING REPORTS
Maintenance Service deletes any reports that are 30 days or older from your report inbox. Youmust
save any reports you want to retain beyond 30 days to your hard drive or network directory.

Report Writer uses the following criteria to determine a report’s age. For on-demand reports, the
request date governs the report’s age. For scheduled reports, the date the system generates the
report governs the report’s age. Inbox manager does not delete reports you schedule to generate in
the future.

To delete all of the reports submitted on a given date

1. Click Report Inbox=>Inbox manager.
2. Select fixed dates or a date range for deleting reports.
3. Select the status type(s).
4. Click Delete.

The Inbox manager deletes all of the reports submitted on the date(s) you specified.

CONFIGURING USERPRINTERSETTINGS
All sending of email and network printing is handled from the Enterprise Server. Local printing is
handled from the client computer.

To configure user printer settings

1. In YourSite Explorer, click YourSite=>Employees.
2. Click theUser account tab.
3. UnderReport distribution, type the name of theNetwork printer.

NOTE:
l The printer path name is case sensitive.
l The network printer MUST be installed on the server where Reporting Service is
running.

4. Select whether you want to send printed reports to the employee's desktop printer or use the
employee's email address for report distribution.
If you select Send printed reports to the employee's desktop printer, report printing is
administered by the Contact Center Client application running on the client desktop computer.



Chapter 8
FORECASTING

Forecasting terms
Forecasting tool
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FORECASTING
Forecasting involves taking historical data generated by your Skype for Business Standard Edition
Server or Enterprise Pool and using it to predict future traffic volumes and patterns. Forecasting is
the basis for estimating required resources, such as agents and workstations. You take a year or
more of ACD queue traffic data, examine trends in Call Load patterns and determine the ACD
Handling Times of the calls. After you run a forecast, you examine the data andmake adjustments
based on current contact center conditions. You can tweak the forecast by adding or reducing calls,
based on your intuition and information gathered by yourself and others. See "Step #3 Forecast the
Call Load" on page 15 for more information on forecast concepts.

FORECASTING TERMS
Conducting a forecast involves accurately estimating Time to Handle, Wrap Up Time, and ACD
Calls Offered values. The following terms are used in forecasting resource requirements:

l Service Level percent
You can predict the agent requirement for your Service Level percent and Service Level time
targets by applying the Erlang C equation to the estimated Call Load and average ACD
Handling Time.
See "Understanding reports" on page 160.

l Service Level time
See "Understanding reports" on page 160.

l Wrap Up time
WrapUp time is the time an agent spends completing transactions associated with a call after
the agent hangs up. TheWrap Up time is a standardized period. If an agent requires additional
time to complete paperwork or online transactions, the agent can leave the ACD queue
temporarily for this purpose.

l Agent Efficiency percent
Agent Efficiency percent is the percentage of time agents spend on ACD calls relative to the
time agents are scheduled to work. Agent efficiency is calculated using a straight linear
relationship. For example, 50% agent efficiency means that twomore agents are required to
handle the forecasted workload. An Agent Efficiency percentage of 100 is unrealistic. Agents
routinely take breaks, perform other non-ACD duties, make outgoing calls, and place
themselves in Make Busy.

l Average Talk time
Average Talk time is the average time agents spend talking to callers.

l Calls Offered
See "Understanding reports" on page 160.

l Manned Agents
Manned Agents is the average number of agents who were logged on for the interval of time
being forecasted.

l Time to Handle
Time to Handle is the average time calls wait in queue before agents handle them.
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l ACD Handling time
ACD Handling time is the talk time plus the hold time. If an agent calls a supervisor in search
of more information (while the caller is on hold) and/or transfers or conferences the call, the
system adds these times to the ACD Handling Time value.
For example, an agent speaks to a caller for twominutes and then puts the caller on hold for
threeminutes and tries to solve the problem. This might include a call to the supervisor. The
agent then initiates a conference call with the caller and a third party and they speak for three
minutes and resolve the issue. Therefore, the ACD Handling Time for the agent is 2 + 3 + 3 =
8minutes.

l Call Load
The term Call Load is to the combined effect of the number of calls received by the ACD
queue and their duration, or the calls offered x (average ACD Handling time + averageWrap
Up time).

FORECASTING TOOL
You use the Forecasting tool to create forecasts based on historical contact center traffic volumes.
You can then perform 'what-if' scenarios and optimize the balance between the agents scheduled
and your Service Level objectives.

To forecast resource requirements you

1. Load historical data.
2. Modify historical data if required.
3. Perform a forecast.
4. Print the forecast.

LOADING HISTORICALDATA
When you load historical data, you include data over a historical period that best represents the call
center activity for the time period. You can select sequential or non-sequential dates (for example,
Monday, Wednesday, and Friday) to use in the forecast.

To load historical data

1. In Contact Center Client, click Tools=>Forecasting.
NOTE:You can load historical data for a queue or queue group. If you are using the forecast to
build a schedule, select historical data from the same queue group with which the schedule is
associated. This data will best represent the agents required for your schedule.

2. Click Load historical data.
The Forecasting window opens.

3. UnderQueues orQueue groups, click on the queue or queue groups you want to use as the
source of historical data.
NOTE:You can select one or more specific dates and/or date ranges of historical data.
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4. If you want to add a specific date, under Historical date(s) for the forecast, click Specific day.
l Select a date.
l Click Select dates.
l Repeat step 4 to addmore dates.

5. If you want to add data from a date range, click Date range.
l AfterEvery, select the date frequency.
l Select the check boxes for one or more days of the week.
l After From and To, select the start and end dates of the historical data period used for
the forecast.

l Click Select dates.
l Repeat step 5 to addmore date ranges.

6. AfterStart hour andEnd hour, select the time frame for historical data.
The Interval value, in minutes, is the time increment by which the forecast will be displayed.
For example, if you schedule your employee shifts in 30minute increments, select 30minutes
as the Interval value.

7. After Interval, select the schedule interval: 15, 30, or 60minutes.
8. Click Submit.

The forecast table is populated with historical data.

MODIFYING HISTORICALDATA
Youmust load historical data before you canmodify it. After you perform a forecast and run 'what-if'
scenarios, the changes youmake to the historical data (for example, Calls Offered and Average Talk
time) affect the agents required.

Modifying Average Talk time
You canmodify the Average Talk time value for one day or several days simultaneously.

Tomodify the Average Talk time parameter on the forecast grid

1. Click Modify...=>Average Talk time.
See Figure 48.

2. UnderSpecify how you want to change the Average Talk Time value(s), specify how you
want to modify Average Talk time:

l Add seconds to or subtract seconds from the value
l Increase or decrease by a percent of the value
l Select a fixed value

3. UnderApply the changes to the following data source, specify if you want to modify the
original value or the current grid value.

4. UnderApply to days, select the days for which you want to modify Average Talk time.
5. Click Apply.
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Figure 48: Average Talk Time window

Modifying Calls Offered
You canmodify the Calls Offered value for one or several time intervals simultaneously.

Tomodify the Calls Offered parameter on the forecast grid

1. Click Modify...=>Calls Offered.
See Figure 49.

2. UnderSpecify how you want to change the Calls Offered value(s), specify how you want
to modify Calls Offered:

l Add calls to or subtract calls from the values
l Increase or decrease by a percent of the values
l Select a fixed value

3. UnderApply the changes to the following data source, specify if you want to modify the
original value or the current grid value.

4. UnderApply to times, select the days and time interval for which you want to modify Calls
Offered.

5. Click Apply.
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Figure 49: Calls Offered window

Modifying the weekly total for Calls Offered
You canmodify the Calls Offered values for an entire week simultaneously. Modifying these values
changes the number of Calls Offered while maintaining the same proportion of calls across all time
intervals. For example, if you increase the weekly total by 10 percent, an interval with 10 calls will
change to 11. However, an interval with zero calls will remain zero.

Tomodify the Calls Offered parameter on the forecast grid

1. Click Tools=>Forecasting.
2. Click Modify...=>Weekly total.

See Figure 50.
3. UnderSpecify how you want to change the weekly total, specify how you want to modify

Calls Offered over the week:
l Increase or decrease by a percent of the values
l Select a fixed value

4. UnderApply to totals, specify if you want to modify the original values or the current grid
values.

5. Click Apply.
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Figure 50: Weekly total for Calls Offered window

PERFORMING FORECASTS
NOTE:Youmust load historical data before you can perform a forecast. See "Loading historical
data" on page 179.

To run a forecast

1. Specify the Service Level %, Service Level Time, Wrap Up Time, and Agent Efficiency % you
expect for the queue or queue group.

2. Click Perform forecast.
You can perform what-if scenarios on the historical data using different Service Level
objectives until you are satisfied with the forecast.

PRINTING FORECASTS
After you generate forecast data you can print it.

To print a forecast

1. Click Export Forecast.
The Forecast data export window opens.

2. Click Printer.
3. Click Export.

The print preview window opens.
4. Click the print direct icon, or click the print icon, specify your printer options, and click OK.
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SAVING FORECASTSASEXCEL FILES
After you generate forecast data you can export it to aMicrosoft Excel spreadsheet.

To export a forecast as an Excel file

1. Click Export Forecast.
The Forecast data export window opens.

2. Click Microsoft Excel.
3. Click Export.

The forecast opens in aMicrosoft Excel spreadsheet you canmodify and save.



Chapter 9
DATA MINING 

ACD Inspector
SMDR Inspector
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DATA MINING
The data-mining tools comprise

l ACD Inspector
ACD Inspector searches for agent and ACD queue event records.

l SMDR Inspector
SMDR Inspector searches through SMDR data to find specific contact center events.

ACD INSPECTOR
ACD Inspector searches through voice data by accessing agent and ACD queue event records. For
example, using ACD Inspector, you can find the exact time an agent logs off at lunch. You can run a
search and examine the activities of individual agents or all of the agents in a particular agent group
or customer service queue during that time interval. You can also search on specific agent states
and other parameters, such as the number of calls waiting and the number of active agents. The
search follows a wild card format. Your specifications do not have to be exact. You canmake the
search as inclusive or exclusive as you wish. The results are placed in an easy-to-interpret grid that
can be printed or saved to file. You can verify that your reports are valid by conducting searches
against raw voice data.

There are four types of search result tabs:

l Agent events
l Queue events
l Date events
l Exception events

RUNNING SEARCHES INACD INSPECTOR
When you run a search, ACD Inspector searches through the raw voice data on the local hard drive.
Each search requires the following information:

Select dates/Delete dates

The Select dates button specifies the date range within which you want to search. The Delete dates
button deletes days within the range you selected. The date is displayedmonth first, then day, then
year.

Select media servers

The Select media servers check boxes specify the origin of the data used in the search. Currently
you can search on voice activity only.

In addition to the date andmedia server parameters, the ACD Inspector has the following search
criteria tabs:

l Agent events
l Queue events
l Option events

You can use the Reset criteria button to reset all of the search parameters to their default settings.
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Agent events criteria for searches
NOTE:When conducting a search, if you accept the default settings—all check boxes—the search
output will contain all of the event records. You can clear check boxes to narrow down your search.
For example, if you clear all of the agent states except for the Agent login and Agent logout check
boxes, the agent event search output will include log on and log off event records only.

When you click Tools=>Datamining=>ACD Inspector in Contact Center Client, the Agent events
tab opens. It displays the agent event criteria used in the search. (See Figure 51.)

Figure 51: ACD Inspector main window - Agent events tab

The Agent events tab has the following search criteria

Agent information

The Agent information boxes specify the agent’s ID and extension number, and line numbers for one
or more telephone lines to which the agent connects. You can search for agent information records
for a particular agent, or for all of the agents. The agent information specifies the Agent ID for the
media server you have already selected.
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Agent events

The Agent events criteria are listed and automatically selected.

Idle event modifiers

The idle event modifier check boxes provide additional agent event searches. You can select one or
more check boxes to include records for agents who are in the following states: unknown, idle, DND,
Make Busy, and both DND andMake Busy.

NOTE:When conducting a search, if you accept the default settings the search output will contain
all of the event records. You can clear check boxes to narrow down your search.

ACD queue

The ACD queue specifies the queue to which your agent belongs. For example, if the agent belongs
to Tech Support, then you specify the Tech support queue. When you enter an ACD queue number
and an agent number (in the Agent ID box), the search results contain records for all of the calls the
agent receives from the queue.

Table 18 describes the ACD information provided by the Agent events tab.

AGENT EVENTS DESCRIPTION

Agent Login This record is produced whenever an agent successfully logs on.

Agent Logout

This record is produced whenever an agent successfully logs off. If
agent A is currently logged on extension X and agent B logs on to
extension X, a log off record is automatically produced for A. This is
followed by the log on record for B. Make Busy is automatically
enabled on the extension when the agent logs out. No removeMake
Busy record is produced. The extension number is the prime line of
the ACD set which an agent is logged on.

Agent Set Do Not
Disturb

The records do not differentiate between setting DND locally and
remotely. The extension number reported is always the prime line of
the ACD extension. A set DND record will be produced for the
following conditions:

l Setting DND locally by using the DND access code
l Setting DND remotely by using the remote DND access code
l Setting DND remotely by using the attendant console features
key

Table 18: Agent events criteria
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AGENT EVENTS DESCRIPTION

Agent Remove Do
Not Disturb

The extension number is always the prime line of the ACD
extension. A clear DND record will be produced for the following
conditions:

l Clearing DND locally by using an access code
l Clearing DND remotely by using the Cancel Remote DND
access code

l Clearing DND remotely by using the attendant console feature
key

l Clearing DND by using the Cancel All Features access code
l Clearing DND by using the Cancel All DND feature on the
attendant console

l Agent logging in on an extension in DND

Agent Set Make
Busy

This record is produced whenever an extension is placed in the
Make Busy state. A record is not produced when an agent logs out
because Set Make Busy is implied when an agent log out record is
received. The extension number is always the prime line of the ACD
extension.

Agent Remove
Make Busy

This is similar to Set Make Busy. No record is produced when the
agent logs on. The removeMake Busy is implied by the log in
record. The extension number is always the prime line of the ACD
extension.

Agent Answer
ACD

This record is produced whenever an agent answers a call that was
directed to the ACD queue. The event record contains the Agent ID
and queue number (hunt group pilot number to which the call was
placed).

Agent Answer
Personal A record of all of the non-ACD calls are included in this category.

Agent Make
Outbound

This record is produced whenever an agent originates a call and
enters a conversation. A record is not produced under the following
conditions: entering a feature access code, dialing an invalid
number, or hanging up before the called party answers. An agent
extension number is always the prime line of the ACD set that
originated the call.

Table 18: Agent events criteria (continued)



MiContact Center for Microsoft Skype User Guide

190

AGENT EVENTS DESCRIPTION

Agent Idle

If work timer is in effect, the Agent Idle record is produced when the
work timer expires or when it is canceled. If the agent enters Make
Busy while work timer is in effect, an Agent Idle record is produced
followed immediately by a set Make Busy record. A record is not
produced to show the end of the call or the start of the work timer.
This entire period is treated as part of the time to process the call.

If work timer is not in effect, the Agent Idle record is produced at the
end of a call, not when the agent hangs up. For example, if the agent
presses the HANG-UP softkey and remains off hook for 5 seconds,
the record is produced when the HANG-UP is pressed, not when
the agent actually goes on hook. The extension number is always
the prime line of the ACD set that is now idle.

Agent Work timer
Stat

This record is produced when an agent terminates an ACD call and
the work timer is started for that agent. If the work timer cannot be
started, an idle event record is produced instead.

Agent Remove
Work timer This record is produced when the work timer expires for that agent.

Agent Hold Active
When an agent places a call on hold, a record is produced. If the
agent places another call or answers a call on a second line, the
second call will be recorded independently of the first.

Agent Hold
Retrieve

When the held call is retrieved, a record is produced, indicating that
the agent is now busy on that line.

Agent Hold
Abandon When the held call is abandoned, a record is produced for that line.

Agent Ringing
ACD This record is produced when the telephone rings with an ACD call.

Interactive Contact
Center Queue Set
DND Request

This record is produced when the agent set the queue in DND.

Interactive Contact
Center Queue Set

DND

A record is produced when the supervisor puts a queue in DND and
when the Contact Center Management system puts a queue in
DND. In YourSite Explorer you set the hours of operation for the
business. The Contact Center Management system reads these
hours of operation and will put this queue in DND during off hours.

Table 18: Agent events criteria (continued)
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AGENT EVENTS DESCRIPTION

Interactive Contact
Center Queue
Remove DND

Request

This record is produced when the agent removed the queue from
DND.

Interactive Contact
Center Queue
Remove DND

A record is produced when the supervisor removes the queue from
DND andwhen the Contact Center Management system removes
the queue from DND. In YourSite Explorer you set the hours of
operation for the business. The Contact Center Management
system reads these hours of operation and will remove this queue
from DND during business hours.

Interactive Contact
Center Agent Login

Request
This record is produced when the agent logged on.

Interactive Contact
Center Agent Login This record is produced when the supervisor logged on the agent.

Interactive Contact
Center Agent
Logout Request

This record is produced when the agent logged off.

Interactive Contact
Center Agent

Logout
This record is produced when the supervisor logged off the agent.

Interactive Contact
Center Set MKB
with Reason Code

Request

This record is produced when the agent sets himself as Make Busy.

Interactive Contact
Center Set MKB
with Reason Code

This record is produced when the supervisor sets the agent in Make
Busy.

Interactive Contact
Center

RemoveMKB
Request

This record is produced when the agent sets himself in Make Busy.

Interactive Contact
Center Remove

MKB

This record is produced when the supervisor removed the agent
fromMake Busy.

Table 18: Agent events criteria (continued)
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AGENT EVENTS DESCRIPTION

Interactive Contact
Center Set DND

Request
This record is produced when the agent sets himself as DND.

Interactive Contact
Center Remove

DND

This record is produced when the supervisor removed the agent
from DND.

Interactive Contact
Center Sync

Queue

This record is produced when Interactive Contact Center queues
are synchronized tomatch the telephone system queues. In
YourSite Explorer you can select this queue to be synchronized with
the telephone system data each night. That means that the
information in Contact Center Management will be changed to
reflect what is programmed on the telephone system.

Interactive Contact
Center Sync Agent

Group

This record is produced when Interactive Contact Center agent
groups are synchronized tomatch the telephone system queues.

Interactive Contact
Center Sync Agent

This record is produced when Interactive Contact Center agents are
synchronized tomatch the telephone system queues.

Interactive Contact
Center Sync
Started

This record is produced when the synchronization between the
Contact Center Management database and the telephone system is
started.

Interactive Contact
Center Sync
Finished

This record is produced when the synchronization between the
Contact Center Management database and the telephone system is
finished.

Table 18: Agent events criteria (continued)

Queue events criteria for searches
When performing a queue events search, you can search on the following criteria:

l Agent group statistics
l Queue statistics
l Date

TheQueue events tab has the following search criteria:

Queue information

TheQueue information box specifies the ACD queue or agent group used in the search. When you
type an ACD queue or agent group number, the search results contain records specific to that ACD
queue or agent group.
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Queue event

When you select all three queue event check boxes (Agent Group statistics, Queue statistics,
Date), the search results contain records for all of the agent groups and queues, and all of the
telephone system refresh cycles. The telephone system performs a re-synchronization and
generates a refresh record every time it notices the date or hour has changed (once an hour).

Agent information

The Agent information boxes specify the range of values for the Agents Available statistic used in
the search. For example, if you select a range of 5 to 10, the search results contain records for all of
the calls during periods when 5 to 10 agents were logged on to the ACD, but not in Make Busy or Do
Not Disturb.

Calls waiting/Longest waiting settings

The Calls waiting settings and Longest waiting settings boxes specify ranges of values for the Calls
waiting and Longest waiting statistics. For example, selecting a range from 10 to 999 in the Calls
waiting box produces all of the records for calls received during periods whenmore than 10 callers
waited in queue.

TheQueue events tab displays the queue event criteria used in the search. (See Figure 52.)
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Figure 52: ACD search criteria - Queue events tab

Option events criteria for searches
TheOption events tab displays the refresh records, error, and information criteria used in the search.
(See Figure 53.)

TheOption events tab has the following search criteria:

Time ranges

The Time ranges boxes specify the time interval used for the search. The time interval applies to
searches on agent and queue events.
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Exception records

Collector Service tags telephone system records that contain errors with an E (telephone system 1)
or e (telephone system 2). Under Exception records, you select the Error records check box to
include these records in the search output.

Collector Service writes a log record to the data stream upon start up. It tags the log record with an I
to indicate it is an information record. You select the Information records check box to include log
records in the search output. ACD Inspector displays the error and information search result records
on the Exception records tab.

Output record count

TheOutput record count specifies themaximum number of rows of records to display.

Figure 53: ACD search criteria - Option events tab

RUNNING AGENTEVENTSSEARCHES
NOTE:When you run a search on Agent Answer ACD, type the Agent ID but do not type the agent’s
extension. Once answered, an ACD call is not pegged as an extension but is pegged as ACD. You
will get no data if you type the agent’s extension. You can run an Agent events search to find all of
the records of when agent 2005 was on ACD and used Set Make Busy.
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To run an Agent events search

1. In Contact Center Client, click Tools=>Datamining=>ACD Inspector.
TheAgent events tab of theACD Inspector criteria tab opens.

2. Click Select dates and select March 3, 2009 toMarch 5, 2009.
3. TheMedia server field is automatically populated.

NOTE:When you run a search on Agent answer ACD, type the Agent ID but do not type the
agent’s extension. Once answered, an ACD call is not pegged as an extension but is pegged
as ACD. You will get no data if you type the agent’s extension.

4. UnderAgent information, type the Agent ID, 2009.
5. UnderAgent events, if you are not selecting all events, clearSelect all.
6. Select theAgent event(s) you want to search on, in this case, Agent answer ACD, Set

Make Busy, andRemove Make Busy.
You can leave theACD queue blank.

7. Click Start search.
The ACD Inspector results - Agent events tab opens.

Agent events search results
This section describes the records produced when you run searches in ACD Inspector. Table 19
describes the ACD information provided by the Agent events tab. The Agent events tab displays the
ACD activity for agents 1341, 1342, and 1343 (See Figure 54.)

Figure 54: ACD search results - Agent events tab
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COLUMN
HEADING DESCRIPTION

Media server TheMedia server box identifies the source of the event record.

Function/Event The Function/Event box displays the criteria for which you searched - in this case
Agent answer ACD, Agent set Make Busy, Agent removeMake Busy.

Date The Date box displays the date of the event record (month/day/year).

Time The Time box displays the time the event occurred.

Extension
Queue ID

The Extension Queue ID displays the Extension or ACD queue used for the call. The
Extension Agent ID column contains the extensions when a search involves the
extension (such as Make Busy). It contains Queue IDs when no extension
information is requested (such as Agent Answer ACD).

Agent ID The Agent ID box displays the agent number for the agent involved in the call.

Line The Line number box displays the telephone line the agent used to pick up or
originate the call.

Idle Event
Modifier The Idle Event Modifier box indicates when the agent is idle.

Table 19: Agent events result information

Narrowing an Agent events search
You can use theOptions tab in conjunction with the Agent events search or the Queue events
search. Using the Options tab, you narrow down the time frame for either search.

You can run an Agent events search to find all of the records for a specific agent who was on ACD
and when that agent used Set Make Busy. Then you narrow the search with the Options tab to
search between 9:00 A.M. and 11:00 A.M. only. The ACD Inspector results on the Agent events tab
display the ACD activity and theMake Busy activity for agent 2005 between 9:00 A.M. and 11:00
A.M. (See Figure 55.)

To run an Agent events/Options events search

1. In Contact Center Client, click Tools=>Data mining=>ACD Inspector.
TheAgent events tab of theACD Inspector criteria tab opens.

2. Click Select dates and select March 3, 2014 toMarch 5, 2014.
3. TheMedia server field is automatically populated.

NOTE:When you run a search on Agent answer ACD, type the Agent ID but do not type the
agent’s extension. Once answered, an ACD call is not pegged as an extension but is pegged
as ACD. You will get no data if you type the agent’s extension.

4. UnderAgent information, type the Agent ID, 2005.
5. UnderAgent events, if you will are not selecting all events, clearSelect all.
6. Select theAgent event(s) you want to search on, in this case, Agent answer ACD, Set

Make Busy, andRemove Make Busy.
You can leave the ACD queue blank.
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7. Click theOptions tab.
8. Under Time ranges, select theStart at andEnd at times to define the Agent events search

parameters.
In this example, the start time is 9:00 A.M. and the end time is 11:00 A.M.

9. Click Start search.
The ACD Inspector results - Agent events tab opens.

Figure 55: ACD search results - Agent events tab

RUNNING QUEUEEVENTSSEARCHES
You can run aQueue events search to determine when you had too few agents available to answer
calls for a particular queue. In the following example, you will search for amaximum of two agents
and local calls that waited between one and threeminutes.

To run aQueue events search

1. In Contact Center Client, click Tools=>Datamining=>ACD Inspector.
TheAgent events tab of theACD Inspector criteria tab opens.

2. Click theQueue events tab.
3. Click Select dates and select March 1, 2014 andMarch 4, 2014.
4. TheMedia server field is automatically populated.
5. UnderQueue information, type the ACD Queue, p280.
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6. UnderQueue event, select Queue stats.
7. UnderAgent information, type 0-2 agents.

In this example, you want to know when you have only two agents scheduled to answer the
queue.

8. UnderCalls waiting settings, select 0-999 Local calls waiting.
In this example, you want to know the number of calls waiting on the telephone system to
which your agent is connected. If you have only one telephone system, you do not have any
remote calls waiting.

9. Under Longest waiting settings, select 1-3minutes.
In this example, you want to know the number of local calls that waited between 1-3minutes.
You think waiting up to aminute is acceptable, so you did not search for calls that wait less
than aminute. If you have only one telephone system, you do not search for the remote
longest waiting.

10. Click Start search.
The ACD Inspector results - Agent events tab opens.

11. Click theQueue events tab.

Queue events search results
TheQueue events tab displays the number of calls that waited between one and threeminutes (one
call), when there were amaximum of two agents available, for the dates selected, for queue 280.
(See Figure 56.)

Figure 56: ACD search results - Queue events tab

Table 20 describes the ACD information provided by the Queue events tab.
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COLUMN
HEADING DESCRIPTION

Media server TheMedia server box identifies the source of the event record.

Function/Event The Function/Event box indicates whether the event record is for a queue or an
agent group.

Date The Date box displays the date of the event record (month/day/year).

Time The Time box displays the time the event occurred (in seconds).

Queue/Agent
group TheQueue/Agent group box displays the queue or agent group number.

Agents
available

The Agents available box displays the current number of agents logged on to the
ACD system, who are not in Make Busy or Do Not Disturb.

CW (Number of
local calls
waiting)

The CW box displays the number of local callers waiting for an available agent.

LW (Longest
local call
waiting)

The LW box displays the wait time for the caller waiting the longest in queue for
an available agent.

Rem CW
(Number of
remote calls
waiting)

When you have networked ACD (more than one telephone system networked
together), the Rem CW box displays the number of remote callers waiting for an
available agent.

Rem LW
(Longest
remote call
waiting)

When you have networked ACD (more than one telephone system networked
together), the Rem LW box displays the wait time for the caller waiting the
longest in a remote queue for an available agent.

Table 20: Queue events result information

Narrowing aQueue events search
You use theOptions tab in conjunction with the Agent events search or the Queue events search.
Using the Options tab, you can narrow down the time frame for either search.

You can run aQueue events search to find when you have too few agents available to answer calls
for a particular queue. In the following example, you will search for amaximum of two agents and
local calls that waited between one and threeminutes. Then you narrow the search with the Options
tab to search between 9:00 A.M. and 11:00 A.M. only.
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To run aQueue events/Options events search

1. In Contact Center Client, click Tools=>Data mining=>ACD Inspector.
TheAgent events tab of theACD Inspector criteria tab opens.

2. Click theQueue events tab.
3. Click Select dates and select March 1, 2003 toMarch 4, 2003.
4. TheMedia server field is automatically populated.
5. UnderQueue information, type the ACD Queue, p280.
6. UnderQueue event, select Queue stats.
7. UnderAgent information, type 0-2 agents.

In this example, you want to know when you have only two agents scheduled to answer the
queue.

8. UnderCalls waiting settings, select 0-999 Local calls waiting.
In this example, you want to know the number of calls waiting on the telephone system to
which your agent is connected. If you have only one telephone system, you do not have any
remote calls waiting.

9. Under Longest waiting settings, select 1-3minutes.
In this example, you want to know the number of local calls that waited between 1-3minutes.
You think waiting up to aminute is acceptable, so you did not search for calls less than a
minute. If you have only one telephone system, you do not search for the remote longest
waiting.

10. Click theOptions tab.
11. Under Time ranges, select theStart at andEnd at times to define the Agent events search

parameters.
In this example, the start time is 9:00 A.M. and the end time is 11:00 A.M.

12. Click Start search.
The ACD Inspector results - Agent events tab opens.

13. Click theQueue events tab.

TheQueue events tab displays the number of calls that waited between one and threeminutes,
when there was amaximum of two agents available, for the dates selected, between 9:00 A.M. and
11:00 A.M. for queue 280. There was only one call that waited between one and threeminutes in the
selected time frame and queue. (See Figure 57.)
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Figure 57: ACD search results - Queue events tab

RUNNINGWILDCARDQUEUEEVENTSSEARCHES
When performing searches on theQueue Events tab, you can enter aP800 under Queue information
and the search will produce records involving Queue 800 only. Alternatively, you can run wild card
searches. When you perform wild card searches, you use * to represent the wild card. For example,
if you enter '*00' under Queue information on theQueue events tab, the search will produce records
for all of the Queues or Agent groups that end in '00' (for example, 200, 300).

To run a wild card Queue events search, where all of the queues end in '00'

1. In Contact Center Client, click Tools=>Datamining=>ACD Inspector.
TheAgent events tab of theACD Inspector criteria tab opens.

2. Click theQueue events tab.
3. Click Select dates and select February 9, 2003 and February 10, 2003.
4. TheMedia server field is automatically populated.
5. UnderQueue information, type *00.

In this example, you are searching for all of the queues that end in '00'.
6. UnderQueue event, select Queue stats.
7. UnderAgent information, type 0-2 agents.

In this example, you want to know when you have only two agents scheduled to answer the
queue.

8. UnderCalls waiting setting, select 0-999 Local calls waiting.
In this example, you want to know the number of calls waiting on the telephone system to
which your agent is connected. If you have only one telephone system, you do not have any
remote calls waiting.
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9. Under Longest waiting settings, select 1-3minutes.
In this example, you want to know the number of local calls that waited between 1-3minutes.
You think waiting up to aminute is acceptable, so you did not search for calls that wait less
than aminute. If you have only one telephone system, you do not search for the remote
longest waiting.

10. Click Start search.
The ACD Inspector results - Agent events tab opens.

11. Click theQueue events tab.
See Figure 58.

Figure 58: ACD Wild card search results - Queue events tab

Wild card queue events search results
TheQueue events tab displays the Queue statistics when there was amaximum of two agents
available, for the dates selected, for all of the queues that end in '00'. TheQueue statistics in this
case are the records produced after re-synchronization. A refresh record is produced every time the
system notices the date or hour has changed (once an hour).
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RUNNING SEARCHESFORERRORAND INFORMATION
RECORDS
Using the Options tab, you can run a search for error and information records. The error messages
are records of sequence errors. The information records are records of when the Collector restarts.

To run an exception events search

1. Click theACD Inspector criteria tab.
2. Click theOptions tab.
3. Click Select dates and select a date.
4. TheMedia server field is automatically populated.
5. Under Time ranges, type theStart at andEnd at times.
6. UnderException records ensure theError records and/or Information records check

boxes are selected.
7. UnderOutput record count, select themaximum number of records you want to display.
8. Click Start search.

The ACD Inspector results - Agent events tab opens.
9. Click theException events tab.

Exception events search results
Table 21 describes the ACD information provided by the Exception events tab.

COLUMN
HEADING DESCRIPTION

Media server TheMedia server box identifies the source of the event record.

Record The Function/Event box displays refresh records. The refresh event signifies the
start of a new cycle of group and queue statistics.

Table 21: Exception event result information

SMDR INSPECTOR
SMDR Inspector searches through SMDR data to find specific contact center events. For example,
suppose you receive a complaint from a caller who waited 16minutes in queue for a customer
service agent, sometime between 1:00 P.M. and 1:30 P.M. sometime last week. In a single session,
you can search through data frommultiple days to find a specific event. The search follows a wild
card format. Your specifications do not have to be exact. You canmake the search as inclusive or
exclusive as you wish. The results are placed in an easy-to-interpret grid that can be printed or saved
to file. You can verify that your reports are valid by conducting searches against raw voice data.
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Common SMDR Inspector searches include searches for all of the records on

l Queue P001
l Calls that were sent to agent group 23
l The queue for which agent 8000 answered calls
l Outbound calls made by agent 2311 (internal and external)
l DNIS that start with 89

The search result tabs consist of the following:

l SMDR search results
l Exception results

RUNNING SEARCHES INSMDR INSPECTOR
When you run a search, SMDR Inspector searches through the raw voice data on the local hard
drive. Each search requires the following information:

Select dates/Delete dates

The Select dates button specifies the date range within which you want to search. The Delete dates
button deletes days within the range you selected. The date is displayedmonth first, then day, then
year.

Select media servers

The Select media servers check boxes specify the origin of the data used in the search. Currently
you can search on voice activity only.

In addition to the date andmedia server parameters, SMDR Inspector has the following search
criteria tabs:

l Call parties
l Call types
l Options

Call parties criteria for searches
The Call parties criteria helps you to find call events such as, what calls an agent received (Called
party), what calls an agent made (Calling party), or what extension the call was transferred to (Third
party). (See Figure 59.)

The Call parties tab search options are as follows.

Digits dialed

The Digits dialed box specifies the queue number of the queue that picks up the call (for inbound
calls). The ANI digits box specifies the area code and telephone number for an inbound call. The
search results contain records that match the data the user typed in the ANI field.

The DNIS digits box specifies the phone number the caller dialed. The DNIS could be product
specific or it could specify demographic variables or marketing targets.



MiContact Center for Microsoft Skype User Guide

206

Outbound calls

TheOutbound calls box specifies the telephone number the agent dials (for outbound calls).

Call parties

The Calling party box specifies the extension or agent number (for an outbound call) or the trunk
number (for an inbound call) used in the search.

The Called party box specifies the answering extension or the trunk number (for an outbound call)
used in the search.

The Third party box searches for call records on the extension number used in a transfer.

Call identification

The Call identification box specifies the call IDs assigned to a call segment.

The Sequence ID box specifies the sequence number assigned to the call record by the telephone
system.

The Associated ID box specifies the number attached to associated data records of the call
assigned by the telephone system.
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Figure 59: SMDR search criteria - Call parties tab

Call types criteria for searches
The Call types tab displays the types of calls the agent receives, for example, ACD or non-ACD,
abandoned, interflowed, requeued, unavailable, or outbound calls. (See Figure 60.)

The Call types tab search options are as follows.

Call types

The Call types check boxes specify one or more categories of calls used in the search. The
telephone system generates an Unavailable (Queue unavailable calls) event record when a caller
dials a queue and the queue is not available (in DND) or there are no agents logged on to handle the
call.
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Answer supervision

The Answer supervision check box searches for instances where calls were answered by the called
party. If you have answer supervision and youmake an outbound call but the called party does not
answer (you hang up) then an SMDR record is generated with no duration. If you do not have answer
supervision then no SMDR record is generated at all.

Busy call

The Busy call check box searches for call records on queues or extensions the caller dials but finds
busy.

Error by caller

The Error by caller check box searches for call records on numbers the caller dials that are not
recognized by the telephone system.

TAFAS answered

The TAFAS Answered check box searches for call records that involve calls manually picked up by
agents at alternate extensions. In a TAFAS answered call, an employee hears another employee's
phone ring and dials a number to pick up the call.

Internal call

The Internal call check box searches for call records on calls between employees that do not involve
trunks.

Blank

The Blank check box searches for call records that have no data in the Call completion box. That is,
when the check box is selected, the search output contains records where there is nothing recorded
in the Call completion box.

Attendant involved

The Attendant involved options specify whether or not call records for calls involving an automated
attendant are used in the search.

Transfer/Conference

The Transfer/Conference check box searches for records on transferred or conferenced calls.

Speed call/Forward

The Speed call/Forward check boxes search for call records involving a speed dial and/or
conference function. When the Blank check box is selected, the search output contains records
where there is nothing recorded in the Speed or Fwd check boxes.

System ID

The System ID check box searches for call records that pertain to a specific telephone system. In a
multi-site enterprise, you program each telephone system with a 3-digit system ID number. You can
distinguish records by their system ID number. The telephone system appends it to all of the SMDR
records.
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Figure 60: SMDR search criteria - Call types tab

Options criteria for searches
When you click Tools=>Datamining=>SMDR Inspector in Contact Center Client, the Options tab
opens. TheOption criteria work in conjunction with the Call parties criteria and the Call types criteria
to narrow down the search. (See Figure 61.)

TheOptions tab search options are as follows.

Time ranges

The Time ranges boxes specify the time interval used for the search.

Call duration

The Call duration boxes specify a range of values for the Call duration statistic used in the search.
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Time to answer

The Time to answer boxes specify a range of values for the Time to answer statistic used in the
search. For example, if you select a time to answer of 240 to 999 seconds, the search records
include calls that were answered by an agent after waiting at least 240 seconds to be answered.

Exception records

The Collector Service tags telephone system records that contain errors with an E (telephone
system 1) or e (telephone system 2). You select the Error records check box to include these records
in the search output.

The Collector Service writes a log record to the data stream upon start up. It tags the log record with
an I to indicate it is an information record. You select the Information records check box to include
log records in the search output. ACD Inspector displays the error and information search result
records on the Exception Records tab.

Output record count

TheOutput record count specifies themaximum number of rows of records to display.

Figure 61: SMDR search criteria - Options tab
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SMDR search results information
The SMDR Search results tab shows the search results for Call parties, Call types, andOptions
searches. Table 22 describes the SMDR information provided by the SMDR Search results tab.

COLUMN
HEADING DESCRIPTION

Media server TheMedia server box identifies the source of the event record.

Start time
The Start time of a call is reported in hours andminutes in either a 12- or 24-
hour format. If a 12-hour clock is used, the letterP indicates P.M.
(HH:mmp)

Date The Date box displays the date of the event record (month/day/year).

Total duration

The duration of a call is reported in hours, minutes and seconds
(hh:mm:ss). Leading zeros are output (Maximum time = 99 hours, 59
minutes, 59 seconds). If the call duration exceeds 100 hours, a call duration
of 99 hours, 99minutes, 99 seconds will be recorded.

Calling party

The Calling party is the identity of the party that/who originated the call. It
may be a station, an attendant, or an incoming trunk, as described below:

(a) Station number as Calling party (cccc). A station number (extension
number or agent ID) may be one to four digits (0-9, *, #) which are left-
justified (that is, no leading zeros).

(b) Attendant as Calling party (ATTm). Calls originated by an attendant that
do not involve a third party are reported as a calling party by ATT, followed
by the console number. When the console number is in the range of 10
through 99, the format is modified to be ATmm. If an attendant calls an
outside party on behalf of a station or trunk, that station or trunk is reported
as the caller but the attendant flag symbol [*] is shown in the Attendant was
Involved box.

(c) Trunk number as Calling party (Tnnn or Xnnn). When the originating
party is an incoming CO trunk, Tnnn is shown on the record, where nnn is
the number of the trunk. If the trunk number is less than three digits long, it
is left-padded with zeros. If the extended digit length option is enabled, the
trunk number nnnnmay be up to four digits long, left-justified and without
leading zeros. When the originating party is an incoming non-CO trunk,
Xnnn is shown in the trunks record. The T orX ensures that CO trunks and
COAttendant trunks can be distinguished from tie trunks. The trunk
number is the trunk ID specified during customer data entry in the Trunk
Assignment form.

Attendant flag
This 1-digit box contains an asterisk [*] when a call is assisted by, or
initially answered by, an attendant. This flag will not be shown if a call is
transferred to an attendant.

Table 22: SMDR search results information
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COLUMN
HEADING DESCRIPTION

Time to answer
(Time to Ans)

This is the number of seconds from the time an incoming external call rings
the destination until the call is answered. If a call is never answered, this
box displays three asterisk [***]. Leading zeros are output and the box
remains at 999 when an overflow is reached. If the Call Distribution (MCD)
feature package is installed, and theMCD report transfers option is
enabled, this box contains the total time to answer regardless of the
number of times the call is rerouted. This box does not apply to Internal
SMDR.

NOTE: Time to answer does not include the duration the request waits in
queue outside of regular business hours.

Digits dialed

External SMDR

External SMDR records the digits dialed on the outgoing trunk. A maximum
of 26 digits is recorded. This number is reduced to 20 when the Report
Meter Pulses option is selected in CDE. This box does not include the
trunk group access code on outgoing calls. The digits recorded are the
actual digits outpulsed on the trunk after digit modification has been
performed. On incoming calls, the digits dialed in on the trunk are recorded.
The digits dialed field contains the digits the telephone system used to
route the call. For an incoming call this could be the extension or the path to
which the call is being routed. For outgoing calls this is the number the
caller dialed. Whenmore than 26/20 digits are dialed, the remaining digits
are ignored.

If theMCD option is enabled, each device is listed whenever the call is
rerouted, rather than the last device as in non-MCD loads. To reflect the
MCD option, the Digits dialed on the Trunk box displays dd1 ddd2 ddd3.

Internal SMDR

Internal SMDR records the digits dialed on an internal line. Up to 26 digits
are recorded.

Table 22: SMDR search results information (continued)
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COLUMN
HEADING DESCRIPTION

Call completion flag

External SMDR (Outgoing calls)

This reports the completion status of an outgoing call in so far as the
telephone system is able to determine it. When an outgoing call fails toll-
deny checking and is dropped, this box contains a T. When the trunk group
is programmed to receiveAnswer Supervision and a supervision is
received, anA is reported. When the trunk group is programmed for Toll
Reversal and a supervision is received, a T is reported.

External SMDR (Incoming calls)

The telephone system canmonitor the outcome of a call and can provide a
comprehensive report on call completion. When the station or hunt group to
which a call is directed is busy, aB is recorded. When an incoming trunk
accesses an invalid number and receives reorder tone, anE is reported. An
E is also reported for incomplete calls. A T is reported if the incoming trunk
is answered with Trunk Answer From Any Station (TAFAS) and if an
outgoing trunk call is toll denied, or if the call is Pickup answered.

When an incoming call is forwarded by an attendant to a busy station, aB
is shown in the call completion status box, the number called is shown as
the third party, and the Attendant is shown as the called party.

Internal SMDR

An I indicates that an internal call was completed.

Speed Call or Call forward flags (S or F)

This box contains anS when the number is speed dialed, and an Fwhen an
external call is forwarded through the external call forward feature

If Internal SMDR is enabled, an F is also recorded when an internal call is
forwarded through the call forward feature. However, for internal calls the
Third Party box does not contain the number of the station that initiated the
call forward feature. The Third Party box is left blank because the Digit
dialed box identifies the station that has call forward enabled.

Speed call forward

The Speed call/Forward check boxes search for call records involving a
speed dial and/or conference function. When the Blank check box is
selected, the search output contains records where there is nothing
recorded in the Speed or Fwd check boxes.

Called party

A Called party can be a station number, an attendant, or for outgoing calls,
the outgoing trunk number. The Called party output format is identical to
that used for the Calling party. SeeCalling party. For incoming calls to an
attendant, the called party is recorded as the attendant unless the attendant
transfers a call to a station. For direct-in-lines, it would be the station
number. On outgoing calls handled by an attendant, the called party would
be the outgoing trunk’s ID.

Table 22: SMDR search results information (continued)
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COLUMN
HEADING DESCRIPTION

Transfer/Conference
call (Trans Conf)

This box identifies calls involving three or more parties. It contains a T for
supervised transfers, X for unsupervised transfers (that is, transfer in to
busy reports a T, transfer in to ringing reports anX), and aC for 3-way
conversations or conferences.

Third party

The Third party box contains the number of the station to which a trunk call
has been transferred. When several transfers take place during a trunk call,
the first party is the only one reported, as long as MCD Report transfers =
No, and Record transfers = No.

If an external call is made to a station whose call forwarding is set to an
external number, the Third party box contains the number of the station that
initiated the call forward feature. For internal calls, the Third Party box is left
blank because the Digit dialed box identifies the station that has external
call forward enabled.

Account Code

Enabling the report Account Codes option in the SMDR Options
Assignment form allows an Account Code of two to 12 digits to be recorded
here, if one is used tomake a call. Leading zeros are reported if they are
entered.

Route optimization
flag

At the starting and end nodes of a network call a flag will be shown in this
box if route optimization has taken place. A route optimized call involves
two trunks to the same party: the pre-optimization trunk and the post-
optimization trunk. An SMDR record will be produced for both trunks, which
will be distinguished by a lower case r for the pre-optimization trunk, and an
upper case R for the post-optimization trunk. Route optimization is
available with theMSDN/DPNSS Voice IV feature package only.

ANI/DNIS
ANI/DNIS digits are recorded in this box. ANI and DINS numbers can be
up to 10 digits in length, and are recorded for incoming calls on ANI/DNIS
trunks. COS option ANI/DNIS reportingmust be enabled.

System identifier

This optional 3-digit box may contain values from 000 to 999. 000 indicates
that no identifier has been entered. In the absence of a System identifier, a
Node identifier is printed (when programmed). Whenmore than one node
identifier exists, the first one on the programmed list is printed. When both a
System ID and a Node ID are programmed, the System ID takes
precedence. Programming of System Identifiers and Node Identifiers is
described in the Customer data entry volume.

Call ID The Call ID box specifies the call number to which the record relates.

Call ID seq The Sequence ID box specifies the sequence number assigned to the call
record.

Table 22: SMDR search results information (continued)



SMDR Inspector

215

COLUMN
HEADING DESCRIPTION

Assoc call ID The Associated ID box specifies the number attached to associated data
records of the call.

System ID

This optional 3-digit box may contain values from 000 to 999. 000 indicates
that no identifier has been entered. In the absence of a System identifier, a
Node identifier is printed (when programmed). Whenmore than one node
identifier exists, the first one on the programmed list is printed. When both a
System ID and a Node ID are programmed, the System ID takes
precedence. Programming of System Identifiers and Node Identifiers is
described in the Customer data entry volume.

Record See "SMDR record boxes" on page 215.

Table 22: SMDR search results information (continued)

SMDR record boxes
This section describes the SMDR search output records available.

The telephone system records SMDR data in a tabular format. Table 23 provides information used to
interpret the SMDR Inspector search output. It summarizes the SMDR record boxes and provides
themeaning of the symbols used.

NAME FORMAT DEFINITION NOTES

Date mm/dd
mm = Month

dd = Day

mm = 01 - 12

dd = 01 - 31

Start time hh:mmp

hh = Hours

mm = Minutes

p = pm

hh = 00 - 12 or 00 - 23

mm = 00 - 59

p = P.M. (12-hour clock)

Duration of
call

hh:mm:ss

hhhh:mm:ss

hh:mm:ss = duration in
hours:minutes:seconds

hhhh:mm:ss = duration in
hours:minutes: seconds

hh = 00 - 99

mm = 00 - 99

ss = 00 - 99

hhhh = 0000 - 9999

mm = 00 - 99

ss = 00 - 99

Table 23: Summary of boxes in SMDR records



MiContact Center for Microsoft Skype User Guide

216

NAME FORMAT DEFINITION NOTES

Calling
party

pppp

cccc = Extension #

Tnnn = Trunk # (CO)

Xnnn = Trunk # (non-CO)

ATTm = Attendant

c = 0 - 9, *, #

nnn = 000 - 999

m = Console # (ATmm for Attendant
00 - 99)

c = 0 - 9, *, #

nnnn = 0000 - 9999

mm = Console #
ppppppp

ccccccc = Extension #

Tnnnn = Trunk # (CO)

Xnnnn = Trunk # (Non-CO)

ATTmm = Attendant

Attendant f
* = Attendant

-- = Attendant not involved
Attendant answered or initiated the
call, then transferred it to an extension

Time to
answer ttt ttt = time in seconds (000 -

999) *** = Call unanswered
Leading zeros output. Incoming calls
only.

Digits
dialed on
the trunk

xx...x

x...x y...y

or

Tx...x y...y

(Network
Format)

Up to 26 (20 if metering)
digits dialed on the trunk

Network Format: up to 26
digits (20 if metering) in
total

x = 0 - 9, *, #

y = 0 - 9, *, #

x...x = Node ID & Extension # (up to
14 digits)

y...y = actual digits dialed

Tx...x = Node ID & Trunk #

Call
completion
status

h

A = Answer supervision

B = Called party busy

E = Caller error

I = Internal call

T = Toll-denied, TAFAS
answered, or Pickup
answered

Outgoing

Incoming Direct/Dial-in

Incoming/Dial-in incoming

Incoming/Outgoing

Table 23: Summary of boxes in SMDR records (continued)
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NAME FORMAT DEFINITION NOTES

Speed call
or Call fwd
flags

S or F

S = Number was Speed
called

F = External call forwarded
through External call fwd
feature or internal call
forwarded through Call
forward feature

Outgoing

Called party

qqqq

cccc = Extension #

Tnnn = Trunk # (CO)

Xnnn = Trunk # (non-CO)

ATTm = Attendant

c = 0 - 9, *, #

nnn = Range specified in telephone
system form programming

m = Console # (ATmm for Attendant
00 - 99)

c = 0 - 9, *, #

nnnn = 0000 - 9999

mm = Console #

qqqqqqq

ccccccc = Extension #

Tnnnn = Trunk # (CO)

Xnnnn = Trunk # (non-CO)

ATTmm = Attendant

Transfer/
Conference
call

K

T = Supervised transfer

X = Unsupervised transfer

C = 3-Way or Conference

R = re-queue call

U = Path unavailable

I = Interflow

Third party
rrrr

rrrrrrr

cccc = Extension #

cccccccc = Extension #

c = 0 - 9, *, #

c = 0 - 9, *, #

Account
Code (opt.) aa....a Length of 2 to 12 digits a = 0 - 9, space-filled

Route
optimization
flag (opt.)

s

r = pre-optimization trunk

R = post-optimization trunk

- = Space (no route
optimization)

Table 23: Summary of boxes in SMDR records (continued)
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NAME FORMAT DEFINITION NOTES

System
identifier
(optional)

iii Entered by System ID

i = 0 - 9

iii = 000 - 999

000 = No code entered

In the absence of a System ID, a Node
ID is printed (if programmed). When
both System ID and Node ID are
programmed, System ID takes
precedence.

ANI/DNIS xx...xxxxxxx

Format

-aaaaaaaaaa-dddddddddd

- = blank

a = ANIS digit

d = DNIS digit

Extended digit length
format

-aaaaaaaaaa-ddddddd

For Extended digit length format only
the 7 right most DNIS digits are
recorded.

Table 23: Summary of boxes in SMDR records (continued)

RUNNING CALL PARTIESSEARCHES
You can run a Call party search to find out who called agent 2005 onMarch 10, 2004.

To run a Call parties search

1. Click theSMDR Inspector criteria tab.
TheCall parties tab opens.

2. Click Select dates and select March 10, 2004.
3. TheMedia server field is automatically populated.
4. UnderCall parties, type the Called party, agent ID 2005.
5. Click Start search.

The SMDR Inspector results - SMDR Search results window opens.

Call parties search results
The SMDR Search results tab displays the results of who called agent 2005. The agent’s extension
is 1106. He answers calls that come to queue 280 and dial zeros (which is extension 1290). On line
one of the results, an outside call dialed the agent’s extension. On line two, the agent answered a
call from his queue (P280). On line three, we see that extension 1107 called the agent. On line four,
we see that extension 1112 called his extension. (See Figure 62.)
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Figure 62: SMDR search results tab - Call parties search

RUNNING CALL TYPESSEARCHES
You run a Call types search when you want to narrow down the Call parties search. Previously, you
have completed a Call parties search for agent 2005 (Call parties tab). Now you want to narrow the
search to include only Answer non-ACD call types.

To run a Call types search

1. Click theSMDR Inspector criteria tab.
TheCall parties tab opens.

2. Click Select dates and select March 10, 2004.
3. TheMedia server field is automatically populated.
4. UnderCall parties, type the Called party, agent ID 2005.
5. Click theCall types tab.
6. UnderCall types, clear the check boxes for all of the criteria but Answer non-ACD.
7. Click Start search.

The SMDR Inspector results - SMDR Search results window opens.
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Call types search results
The SMDR search results tab displays the call parties/call type results. All of the non-ACD calls
received by agent 2005 onMarch 10, 2004 are displayed. They included external and internal calls
where the caller dialed the agent’s extension (1106), and all of the dial zero calls. (ACD calls are
calls that are sent through the queue.) (See Figure 63.)

Figure 63: SMDR search results - Call types search

RUNNING OPTIONSEARCHES
You runOption searches to further narrow downCall types and Call parties searches. Previously,
you ran a Call parties search for agent 2005 and then a Call types search to include only Answer non-
ACD calls. Now you want to search for Answer non-ACD calls for agent 2005 that occurred between
9:00 A.M. and 1:00 P.M.

To run anOptions search

1. Click theSMDR Inspector criteria tab.
TheCall parties tab opens.

2. Click Select dates and select March 10, 2004.
3. TheMedia server field is automatically populated.
4. UnderCall parties, type the Called party, agent ID 2005.
5. Click theCall types tab.
6. UnderCall types, clear the check boxes for all of the criteria but Answer non-ACD.
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7. Click theOptions tab.
8. Under Time ranges, after theStart At time, type 9:00:00.
9. Under Time ranges, after theEnd At time, type 12:59:59.
10. Click Start search.

The SMDR Inspector results - SMDR Search results window opens.

Options search results
The SMDR search results tab displays the call parties/call type/options results. All of the non-ACD
calls received by agent 2005 onMarch 10, 2004 between 9:00 A.M. and 1:00 P.M. are displayed.
They include external and internal calls where the caller dialed the agent’s extension (1106), and all
of the dial zero calls. (ACD calls are calls that are sent through the queue.) (See Figure 64.)

For more information on SMDR search results, see "SMDR search results information" on page 211.

Figure 64: SMDR search results - Options search
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RUNNING SEARCHESFORERRORAND INFORMATION
RECORDS
Using the Option tab you can run a search for error and information records. The error messages are
records of sequence errors. The information records are records of when the Collector restarts.

Previously, you ran a Call parties search for agent 2005, and then a Call types to include Answer
non-ACD that occurred between 9:00 A.M. and 1:00 P.M.

To run an Exception event search

1. Click theSMDR Inspector criteria tab.
TheCall Parties tab opens.

2. Click Select dates and select March 10, 2004.
3. TheMedia server field is automatically populated.
4. UnderCall parties, type the Called party, agent ID 2005.
5. Click theCall types tab.
6. UnderCall types, clear the check boxes for all of the criteria but Answer non-ACD.
7. Click theOptions tab.
8. Under Time ranges, after theStart At time, type 9:00:00.
9. Under Time ranges, after theEnd At time, type 12:59:59.
10. UnderExceptions, select theError records and Information records check boxes.
11. Click Start search.

The SMDR Inspector results - SMDR Search results window opens.

Exception search results
There was an information record produced every fiveminutes. Either the alarm is set incorrectly (the
system thinks it should be receiving data because the business hours indicate the business is open)
or the connection has died. The Exception results tab displays error and information records. (See
Figure 65.)

The Exception search has the following results information:

Media server

TheMedia server box identifies the source of the event record.

Record

The Data record box displays detailed information about the exception record.
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Figure 65: SMDR search results - Exception results tab

WILDCARDSEARCHES
NOTE: To search for a string of numbers within a digits dialed string, enclose the string of numbers
in parenthesis, such as '8905'. The search will produce records that include 8905 only in the digits
dialed string.

When performing searches on theQueue Events tab, you can enter aP800 under Queue information
and the search will produce records involving Queue 800 only. Alternatively, you can run wild card
searches. When you perform wild card searches, you use * to represent the wild card. For example,
if you enter '*00' under Queue information on theQueue events tab, the search will produce records
for all of the Queues or Agent groups that end in '00' (for example, 200, 300).
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EXPORTING SEARCHRESULTS
You can save the ACD Inspector and SMDR Inspector search results in the following formats:

l HTML
l Microsoft Excel
l Microsoft Access
l XML
l Text

To export the search results

1. Click Save search.
The Inspector Search Results Export window opens.

2. Select the format in which you want the search results saved: HTML,Microsoft Excel,
Microsoft Access, XML, or Text.

3. Click Next.
4. Click the ellipses to select the location where you want to save the file.
5. After File name, type the file name.
6. Click Save.
7. Click Next.
8. Click Next to confirm the format in which you want to save the file and the location of the file.

A window opens with themessage 'Inspector Search Results export to [export type]
complete.'

9. Click OK.
10. Click Finish.

A window opens with themessage 'Would you like to view/open this file now?'
11. If you want to view the file immediately, click Yes.

The file opens.



Chapter 10
DATA COLLECTION

NetworkMonitor
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DATA COLLECTION
You use real-time and historical data tomanage your contact center. Real-time data is used to
monitor the current Call Load and agent availability andmakeminute-to-minute adjustments.
Historical information is used for forecasting, staffing, and scheduling.

The prairieFyre Collector Service (v5) writes SMDR and ACD data to text files. The text files are
located on the Enterprise Server in C:\Program Files\prairieFyre Software
Inc\CCM\DataDirectory\Node_x, but may be stored elsewhere and is based on the DataDir registry
value.

NETWORKMONITOR
The Network Monitor application resides in Contact Center Client. Network Monitor provides
information on the status of media server real-time data collection. You can verify if alarms are
enabled for your media servers and if themedia servers are reporting any alarms. The Contact
Center Client icon in your system tray is marked with a red line and blinks when the system is
reporting alarms.

The following network alarms are available:

l Invalid configuration
l Node offline
l PC time drift
l SMDR record error
l ACD sequence number error
l SMDR link down
l SMDR data timeout
l ACD link down
l ACD data timeout

Table 24 describes the Skype for Business-specific alarms that display in Network Monitor.
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ALARM DESCRIPTION

Lync Certificates

At the Enterprise level in YourSite Explorer an administrator can
configure how far in advance they want to be notified that their
Lync Certificate is going to expire.

Within the specified date range the alarm message will display
until the certificate is renewed.

When the certificate has expired an error alarm message will
display advising you that the certificate has expired; the
Enterprise Routers will no longer authenticate to Lync.

SIP Listener If the connection to the SIP Listener is lost an error alarm
message will display.

SIP Listener Disk
Space

If the disk space on the computer housing the SIP Listener is low
(passes a configured space threshold) this alarm will display.

Enterprise Routers

If the entire connection to the Enterprise Routers is lost an error
alarm message will display.

If the connection state of the Router Application endpoint to Lync
changes, for example, to disconnected, an error alarm message
will display. When the Router is in this state it will not be able to
handle any calls.

Table 24: Lync-specific alarms

VIEWING NETWORKMONITOR
NOTE:When you open Contact Center Client, it automatically points Network Monitor to the
Enterprise Server default IP address. If you havemore than one server at your site, ensure that
Contact Center Client is pointing to the correct server.

Network Monitor is available to users whose security permissions permit them to use Network
Monitor.

To view Network Monitor

1. Click Start=>Programs=>prairieFyre Software Inc=>Contact Center Client.
2. Type your user name and password and verify the Enterprise Server IP address.
3. If you use Secure Socket Layer, select SSL.
4. Click Log on.

The Contact Center Client window opens.
5. Click View=>Network Monitor.
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Opening the NetworkMonitor
After you view Network Monitor, you canminimize or close it. When you close Network Monitor, it
resides in the Network Monitor toolbar.

To open Network Monitor from the toolbar

l Double-click the Network Monitor toolbar.
Network Monitor opens.

VIEWING ALARMS
In Network Monitor, the Enterprise andMedia server windows display critical alarms and warning
alarms. Critical alarms are activated when prairieFyre Collector Service (v5) is not receiving data,
the Enterprise Server disk space is low, and in other instances where the Enterprise Server is
prevented from functioning optimally. When there is a critical alarm, Network Monitor displays the
alarm and you are emailed a notification. Warning alarms are activated when license violations
occur, duplicate records are created, and for other non-critical issues. When there is a warning
alarm, the Contact Center Client icon in the System Tray blinks. (See Figure 66.)

NOTE:Youmust configure settings for your SMTP server in YourSite Explorer in order to receive
alarm notifications by email.

In YourSite Explorer, you can configure alarms to notify you if prairieFyre Collector Service (v5) is
not receiving data or if the server disk space is low. See "Configuring node alarms" on page 53.

To view a summary of alarms and the status of the Enterprise Server

l In the Enterprise window, underDescription, view if there are any critical alarms and if the
Enterprise Server is online.

To view the status of the alarms

l In theMedia servers window, view any Critical alarms andWarning alarms.
TheMedia Servers window displays all critical and non-critical alarms for themedia servers
installed on the Enterprise Server and remote servers.

To view data and system alarms with Administrative tools:

l On the Enterprise Server, click Start=>Settings=>Control Panel=>Administrative
tools=>Event viewer to view more information on the error.
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Figure 66: Network Monitor
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VERIFYINGMEDIASERVERSARERECEIVING DATA
The Data link window displays the following information:

l SMDR/ACD displays SMDR/ACD records as they arrive from the telephone system.
l Records today displays the total number of SMDR/ACD records received by Collector
Service for the day that were valid SMDR or ACD records.

l Last received displays the date and time Collector Service received the SMDR/ACD record
last sent.

l Clear records clears the records displayed on the Data links window.
l Reset SMDR link/Reset ACD link button resets the SMDR/ACD data link from the telephone
system to Collector Service when SMDR data stream/ACD data stream shows no data is
streaming. If you attempt to reset the link and data does not start streaming, check your
cabling connections from the telephone system to the TCP/IP sockets of the server.

To verify amedia server is receiving Skype for Business Server data

l In theMedia Servers window, under themedia server, click Data link.
The Data link window opens.
See Figure 67.

Figure 67: Data link window
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To reset the data links

1. In theMedia Servers window, under themedia server, click Data link.
The Data link window opens.

2. If no data is streaming in the SMDR or ACD panes, click Reset SMDR/ACD link.

CONFIGURING ENTERPRISEANDMEDIASERVERALARM
NOTIFICATIONS
You can define alarm notifications that alert you when the Enterprise Server andmedia servers are
not functioning optimally. You can specify the severity of and performance thresholds for each
server malfunction.

Client notifications are specific to each computer. You can be notified of enterprise andmedia server
alarms in several ways:

l A pop-up notification opens on your desktop.
l A sound prompt, such as a beep or .wav file, plays.
l You are notified by email.
l Contact Center Client opens on top of all open applications.

To configure notifications

1. Add alarm thresholds.
2. Specify threshold colors.
3. Specify threshold notification.

Adding alarm thresholds
When configuring thresholds for alarms, youmust specify the following alarms as warnings rather
than critical alarms (because these alarms will always be warnings when they are active):

l No alarms configured
l PBX PC time drift
l ACD sequence number error
l Alarm outside of business hours
l Maintenance

You configure all other alarms as critical because they will have a severity of critical when they are
triggered.

In addition to configuring an alarm threshold with a severity of warning or critical (for a specific
alarm), you can configure an alarm threshold with a severity of normal. Network Monitor then notifies
you when the alarm is cleared.
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To add performance thresholds for enterprise andmedia server alarms

1. In Network Monitor, right-click the Enterprise window (to configure enterprise alarm
notifications) or theMedia server window (to configuremedia server alarm notifications) and
select Set enterprise notifications orSet media server notifications.
The Set alarms window opens.

2. UnderDevices, select the enterprise server or one or more servers/media servers or select
theSelect all check box to select all servers/media servers.

3. In thePerformance variables list, select an alarm type.
4. UnderAlarm Thresholds, click Add a value.
5. Under Severity select Normal,Warning, orCritical.
6. Click OK.

Specifying threshold colors
To configure performance threshold colors

1. For the alarm threshold for which you want to specify colors, underBackground, click the
arrow.
A color palate opens.

2. Select a color.
3. Under Font color, click the arrow.

A color palate opens.
4. Select the font color for the alarm threshold.
5. Click OK.

Specifying threshold notification
You can configure performance threshold sound and pop-up window notifications

To configure performance threshold sound notification

1. For the alarm threshold for which you want to be notified by a sound, underSound, select the
check box.
The Sound window opens.

2. Specify the alarm triggering properties.
3. Specify the sound you want played when the alarm is triggered.
4. Click Save.

To configure performance threshold pop-up window notification

1. For the alarm threshold for which you want to be notified by a pop-up window, underPop-up,
select the check box.
The Pop-up window opens.

2. AfterDuration, type the number of seconds you want the pop-up alarm to be displayed when
threshold conditions are satisfied.

3. If you want to display the pop-up alarm on top of all of the other applications, select theKeep
this message visible on mouse over check box.



Network Monitor

233

4. Optionally, click the Format font button to specify font attributes for the pop-up alarm
message.

5. In the text box, type themessage for the performance threshold and click theAdd a variable
button to insert performance variables. (for example, type CW P001 = <calls waiting
variable>).

6. Click Save.

To specify that Contact Center Client opens on top of all other applications when a performance
threshold is satisfied

l For the alarm threshold for which you want to be notified, underBring to front, select the
check box.

To configure performance threshold email notification

1. For the alarm threshold for which you want to be notified, or notify others by email, under
Email, select the check box.
The Email window opens.

2. AfterDistribution, specify which contacts are to be notified by email when threshold
conditions are satisfied.
See "Emailing reports" on page 169.

3. AfterSubject, type the subject of the email to be sent (for example, type Calls Wtg in Sales
Queue 1 >10!).

4. In themessage box, type the body of the email.
5. Click Save.



Chapter 11
INTERACTIVE CONTACT CENTER

Starting Contact Center Client
Queue Control
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INTERACTIVE CONTACT CENTER
Interactive Contact Center enables supervisors to control the availability of agents and
ACD queues.

In Contact Center Client, using Interactive Contact Center functionality, supervisors can

l Log agents on and off
l Remove agents from particular queues and place them in other queues
l Place agents in Make Busy or Do Not Disturb
l Place queues in DoNot Disturb

Supervisors can control agents on the following Contact Center Client monitors

l Agent State by Position, Employee State by Position, and Extension State by Position
l Agent State by Time, Agent State by Queue by Time, and Employee State by Time

Agent control gives you control over individual agents. Monitor control gives you control over all of
the agents in themonitor.

You can restrict individual supervisors frommanaging particular monitors and devices in the Contact
Center Management website (YourSite=>Security).

STARTING CONTACT CENTERCLIENT
To access Interactive Contact Center functionality youmust first open Contact Center Client. After
starting Contact Center Client, you can choose tominimize it to either the system tray or the
taskbar, depending on your operating system.

NOTE: Launching client-side applications from the task bar causes them to bypass the Updater
Service process. To ensure successful updates from the Enterprise Server, after an upgrade close
all client-side applications for 15minutes or reopen them from the Start menu/Start screen.

To start Contact Center Client

1. Click Start=>Programs=>prairieFyre Software=>Contact Center Client.
2. Type your user name and password and verify the Enterprise Server IP address.

When logged intoWindows as a domain authenticated user with Active Directory
authentication a username and passwordmay not be required.

3. If you use Secure Socket Layer, select SSL.
4. Click Log on.

To display Contact Center Client in the taskbar

1. In Contact Center Client, click Tools=>Options.
2. UnderDevice control, clear theHide when minimized check box and click OK.

Contact Center Client, whenminimized, will display in the taskbar.
3. To save the profile, click File=>Save as.
4. Type aName for the profile and click OK.

The profile is saved and will automatically be applied each time you open Contact Center
Client.
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Hiding theMonitor control option
When you right-click a device on a real-timemonitor amenu is displayed. If you have Interactive
Contact Center and you are permitted to use agent and queue control, you will see aMonitor control
option on this menu. If you do not useMonitor control, you can hide this option so it is not displayed
on themenu.

To hide theMonitor control option

1. In Contact Center Client, click Tools=>Options.
2. Select theDisplay monitor device control option check box.
3. Click OK.

Logging on an agent
In the following example wewill use the Agent State by Positionmonitor to illustrate Agent control.
After an agent is logged on, the supervisor can add or remove the agent from agent groups.

NOTE:

l To control agent presence in Interactive Contact Center, youmust have the "May control the
real-time presence of agents in Interactive Contact Center" security role enabled. See
"Configuring security" on page 81.

l Agents may leave or join agent groups but not queues. Agents become absent from a queue
indirectly if they leave all agent groups associated with that queue. An agent who is present in
an agent group which is associated to all queues would be disassociated from all queues
simultaneously if they became absent in their agent group.

To log on an agent

1. In Contact Center Client, click View=>Real time to view the supervisor monitor icons.
2. Click Position=>Agent State by Position.
3. Select agents to monitor.
4. Click OK.

Contact Center Client displays the devices across themonitor in the order you specified.
5. Right-click the cell of an agent who is logged off and click Agent control=>Log on.

The Agent join/leave window opens.
6. Select the agent group(s) you want the agent to join.
7. Click OK.

To add or remove an agent from an agent group

1. Right-click the cell of an agent who is logged on and click Agent control=>Join/leave agent
group.

2. Select the agent group(s) to which you want to add the agent.
3. Similarly, deselect the agent group(s) from which you want to remove the agent.
4. Click OK.

Logging off an agent
To log off an agent

l Right-click the cell of an agent who is logged on and click Agent control=>Log off.
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Logging off all of the agents on amonitor
To log off all of the agents

l Right-click themonitor and click Monitor control=>Log off.

Placing agents in Make Busy
To place an agent on amonitor in Make Busy

l Right-click the cell of an agent who is logged on and click Agent control=>Set Make
Busy=>reason code.

To place all of the agents on amonitor in Make Busy

l Right-click themonitor and click Monitor control=>Set Make Busy=>reason code.

Removing agents from Make Busy
To remove an agent fromMake Busy

l Right-click the cell of an agent who is in Make Busy and click Agent control=>Remove
Make Busy.

To remove all of the agents on amonitor fromMake Busy

l Right-click themonitor and click Monitor control=>Remove Make Busy.

Placing agents in DoNot Disturb
To place an agent in Do Not Disturb

l Right-click the cell of an agent who is logged on and click Agent control=>Set Do Not
Disturb=>reason code.

To place all of the agents on amonitor in Do Not Disturb

l Right-click themonitor and click Monitor control=>Set Do Not Disturb=>reason code.

Removing agents from DoNot Disturb
To remove an agent from DoNot Disturb

l Right-click the cell of an agent who is in Do Not Disturb and click Agent control=>Remove
Do Not Disturb.

To remove all of the agents on amonitor from DoNot Disturb

l Right-click themonitor and click Monitor control=>Remove Do Not Disturb.

Canceling agents inWork Timer
To cancel an agent inWork Timer

l Right-click the cell of an agent who is inWork Timer and click Agent control=>Cancel Work
Timer.

To cancel all of the agents on amonitor inWork Timer

l Right-click themonitor and click Monitor control=>Cancel Work Timer.
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QUEUE CONTROL
Using the Interactive Contact Center feature of Contact Center Client, you can control queues on
theQueue Now monitor.

Manually controlling queues
NOTE:

l You can see queue statistics during business hours as long as the business schedule you
configure in YourSite Explorer is consistent with your company’s hours of operation.

l Manual queue control overrides queue schedules.

Interactive Contact Center Queue control enables you to control individual queues. Monitor control
enables you to control all of the queues on amonitor.

Hiding the Monitor control option
When you right-click a device on a real-timemonitor amenu is displayed. If you are permitted to use
agent and queue control, you will see aMonitor control option on this menu. If you do not useMonitor
control, you can hide this option so it is not displayed on themenu.

To hide theMonitor control option

1. In Contact Center Client, click Tools=>Options.
2. Select theDisplay monitor device control option check box.
3. Click OK.

Placing queues in Do Not Disturb
Usingmanual queue control, you can place queues in and remove queues from DoNot Disturb on
the Queue Now monitor. A call will not enter a queue that is in Do Not Disturb. Instead the call is
sent to an unavailable answer point. If there is no unavailable answer point configured for the queue,
the caller will hear a dead air and the call will disconnect. For information on configuring unavailable
answer points, see "Configuring alternate queue endpoints" on page 67.

Queues placedmanually into Do Not Disturb will stay in Do Not Disturb until manually returned to
ACD. See "Removing queues from DoNot Disturb" on page 239.

To place a queue in DoNot Disturb

l Right-click the cell of an active queue and click Queue control=>Set Do Not Disturb.
See Figure 68.



MiContact Center for Microsoft Skype User Guide

239

Figure 68: Placing a queue in Do Not Disturb

To place all of the queues on amonitor in Do Not Disturb

l Right-click themonitor and click Monitor control=>Set Do Not Disturb.

Removing queues from Do Not Disturb
To remove a queue from DoNot Disturb

l Right-click the cell of a queue that is in Do Not Disturb and click Queue control=>Remove
Do Not Disturb.

To remove all of the queues on amonitor from DoNot Disturb

l Right-click themonitor and click Monitor control=>Remove Do Not Disturb.
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MiCONTACT CENTER for MICROSOFT SKYPE –
IVR ROUTING

IVR Routing is an integrated voice processing solution that enables you to effectively route contacts
using visual workflows. With MiContact Center for Skype Version 5.10.9, you can optionally choose
to front end your Skype for Business 5.10.9 server with the IVR Routing application.

GENERAL INFORMATION FORSYSTEM
ADMINISTRATORS

MiContact Center for Microsoft Skype – IVR Routing intercepts calls for specific SIP endpoints that
are programmed on the Skype for Business server. Using a canvas, IVR Routing enables you to
design workflows by dragging and dropping activities that channel calls based on available call
variables and workflow tasks.

TheMiContact Center for Skype platform continues to providemessages to callers in queue, music
on hold, real-time and reporting for voice, dial out of queue capability, and forecasting, and is home to
all queues and agents.

In this integration, each IVR Routing server will be administered locally with YourSite Explorer, using
a remote access method to the Contact Center Solutions Version 7.1 Enterprise Server.
Administrators modify workflows and run reports remotely on each IVR Routing server
independently.

Redundancy is achieved by deployingmultiple IVR Routing servers and configuring threshold
settings in YourSite Explorer that direct calls from one server to another when the primary server is
not available.

Due to the nature of the integration between IVR Routing andMiContact Center for Skype, some
IVR Routing features are not applicable and will not be available. For more information, see
"MiContact Center for Microsoft Skype – IVR Routing exceptions" on page 242. For a detailed
description of standard IVR Routing features, see theContact Center Solutions User Guide.

For hardware and software specifications and application licensing information, see theMiContact
Center for Microsoft Skype System Engineering Guide.

For installation instructions, see theMiContact Center for Microsoft Skype Installation Guide.

Mitel's MiContact Center for Skype deploys an Interactive Voice Response (IVR) solution using
Microsoft's Unified Communications Managed API 4.0 (UCMA 4.0), which is not officially supported
by Microsoft with Microsoft Lync 2010. However recognizingmany end users still useMicrosoft
Lync 2010, Mitel performed a risk assessment to determine whether Mitel could support Microsoft
Lync 2010 usingMicrosoft UCMA 4.0. After analysis and testing, Mitel believes that the risk is low
that problems with theMitel MiContact Center for Skype usingMicrosoft UCMA 4.0 should occur.
However, if a problem does arise and it is identified as aMicrosoft UCMA 4.0 interaction with
Microsoft Lync 2010 issue, then the end user may be required to upgrade toMicrosoft Lync 2013 at
their expense to address such issues.
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The above Summary is provided for information purposes only, and is provided with no
representations or warranties of any kind, or conditions of accuracy. Mitel shall have no liability or
responsibility to you whatsoever for any damages, losses, or expenses incurred by you as a result of
your receipt, use or reliance on the Summary.

MiCONTACTCENTER for MICROSOFTSKYPE – IVRROUTING
EXCEPTIONS
Some of the features available in Contact Center Solutions IVR Routing are not applicable to a
Microsoft Skype for Business deployment. In addition, due to the standalone nature of the
IVR Routing application, full integration is not yet possible. In a future release of MiContact Center
for Skype, IVR Routing will bemore fully integrated, enabling all applicable functionality.

There are some features that are offered within MiContact Center for Microsoft Skype – IVR Routing
that are not available in Contact Center Solutions IVR Routing. These include:

l Twoweb-based real-timemonitors that display callback and endpoint information
l New reports and charts (IVR RoutingMedia Server - Concurrent Connections, Concurrent
Connections by End Point, by Destination, and Performance by Period by End Point)

l Fewer restrictions onmedia file types for sounds

Following is a list of features that are not yet supported in MiContact Center for Microsoft Skype –
IVR Routing. For more information, see "ConfiguringMiContact Center for Microsoft Skype – IVR
Routing" on page 244.

l Hunt groups
l Estimated wait timemessaging
l Redirect activity
l RADs (Skype for Business queue announcements take the place of RADs)
l UPiQ
l Inqueue workflows
l Automatic callback processing and distribution
l IVR configured screen pop
NOTE:MiContact Center for Microsoft Skype – IVR Routing supports screen pops containing
data gathered with the Collect Digits activity and held in the LastCollectedDigits variable or
returned in the Query or Execute activity and held in the LastQueryResult. For more
information, see "Configuring Contact Center Screen Pop" on page 43.

l PCI compliant workflows
l Routing will use the following queue statistics only: ‘Agents Available’, ‘Agents Unavailable’,
‘Agents Idle’, ‘Longest Wait Time’, ‘Calls Waiting’, ‘Average time to Abandon’, ‘Average Time
to Answer’, and ‘Path DND’

l Callback reports
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DEPLOYMENTSCENARIOS
IVR Routing can be deployed differently depending on your setup and contact center needs. In all
scenarios, each IVR Routing server is configured andmaintained separately. The following
deployment scenarios are available:

l IVR Routing with MiContact Center for Skype, where IVR Routing is used as amethod for
routing calls and no other Contact Center Solutions Version 7.1 features are accessed.

l IVR Routing andMultimedia Contact Center are both integrated with MiContact Center for
Skype.

l IVR Routing as a standalone product without aMiContact Center for Skype server.
NOTE:Queue condition statistics are not available in this scenario.

SUGGESTEDCONFIGURATIONS
The following section describes themost common configurations for MiContact Center for Microsoft
Skype – IVR Routing.

Configuration 1
In aMiContact Center for Skype environment:

l IVR Routing installed as a standalone on its own server.
l IVR Routing receives queue statistics from the 5.10.9 Skype for Business server.

Configuration 2
In aMiContact Center for Skype environment:

l Multiple IVR Routing servers are deployed to form a redundant system. Inbound calls are
handled by the primary IVR Routing server. If the call is unanswered after a set time, the
secondary IVR Routing server is offered the call.

l Each IVR Routing instance is installed as a standalone on its own server.
l An IVR Routing Redundant/Remote Starter Pack is required for each redundant server.
l The database for the redundant server(s) is automatically populated from the primary IVR
Routing server.

l IVR Routing receives queue statistics from the 5.10.9 Skype for Business server.

Configuration 3
In aMicrosoft Skype for Business environment:

l One ormore standalone IVR Routing servers are deployed as an IVR Routing system for
Skype for Business site(s).

l The IVR Routing instance is installed as a standalone on its own server and cannot be co-
located with Microsoft Skype for Business server roles.
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Configuration 4
In aMicrosoft Skype for Business environment:

l Standalone IVR Routing servers are deployed as an IVR system for Skype for Business site
(s).

l Multiple IVR Routing servers are deployed to form a redundant system. Inbound calls are
handled by the primary IVR Routing server. If the call is unanswered after a set time, the
secondary IVR Routing server is offered the call.

l An IVR Routing Redundant/Remote Starter Pack is required for each redundant server.

GENERAL INFORMATION FORSUPERVISORS AND
AGENTS

IVR Routing is primarily an administrator’s tool but there are workflow reports generated based on
routing that are of interest to supervisors. These reports are available by accessing the CCMWeb
reporting application on the 7.1 Enterprise Server or theMitel Contact Center Management web
shortcut on client machines. See theMiContact Center for Microsoft Skype Reports Guide for more
information regarding reports.

During the installation, the Client Component Pack installs a shortcut onto client desktops that
agents and supervisors can use to launch the web based real-time callback and endpoint monitors.
The Callback monitor displays callback requests and enables agents or supervisors to handle or
distribute these requests. The IVR endpoint monitor displays inbound and outbound call information.

CONFIGURING MiCONTACT CENTER for MICROSOFT
SKYPE – IVR ROUTING

You configureMiContact Center for Microsoft Skype – IVR Routing in the following order.

1. In YourSite Explorer, underEnterprise, set up your MiContact Center for Microsoft Skype –
IVR Routing Enterprise structure.

2. UnderEnterprise, set up your Skype for Business media server.
3. Under IVR Routing, set up your MiContact Center for Microsoft Skype – IVR Routing

devices and workflows.

PRE-CONFIGURATION
Review the following before configuringMiContact Center for Microsoft Skype – IVR Routing:

l Before starting YourSite Explorer to configureMiContact Center for Microsoft Skype – IVR
Routing, run Active Directory synchronization
See "Running Active Directory synchronization" on page 245.

l Youmust have access to both your MiContact Center for Skype Enterprise Server and your
MiContact Center for Microsoft Skype – IVR Routing Server. It is recommended that you
remote into your MiContact Center for Microsoft Skype – IVR Routing Server from your
.5.10.9 Enterprise Server.



MiContact Center for Microsoft Skype User Guide

245

l Youmust log into YourSite Explorer withWindows Authentication or you will not be able to
provisionMicrosoft Skype for Business within YourSite Explorer. TheWindows
Authentication user must be part of RBAC with the following roles:

l CSAdministrator
l RTCUniversalServerAdmins
l RTCUniversalUserAdmins

l Ensure that 5.10.9 devices havemeaningful names as those names will be used when you
create routing conditions in MiContact Center for Microsoft Skype – IVR Routing.

l To provision on aWindows 8 64-bit client, youmust run YourSite Explorer as an Administrator

Running Active Directory synchronization
You can synchronize your system with Active Directory at any time from within YourSite Explorer.
Active Directory is a directory service created by Microsoft that is used for managing a domain.
Active Directory Synchronization will align Active Directory security groups and users between
MiContact Center for Skype Enterprise server and the server.

At any time, you can optionally re-synchronize or reset all client computers runningMiContact
Center for Microsoft Skype – IVR Routing and applications and refresh them with the latest
configuration changes. Re-synchronizing will send a delta of the latest configuration changes to
client computers, while resetting will completely drop client computer configurations and send the
latest configurations from YourSite Explorer.

When you run Active Directory synchronization, employees and employee groups in YourSite
Explorer are synchronized with users in Active Directory groups. Existing employees can also be
associated with specific Active Directory users.

To run Active Directory synchronization

1. In YourSite Explorer, underYourSite, click Enterprise orEmployees.
2. On the ribbon, click Active Directory.
3. UnderSync frequency (hh:mm), select how often you want automatic synchronization to

occur.
4. Click Select Sync paths.

The Select paths to sync window opens.
5. Click > or < to add or remove Active Directory entities from the Active Directory tree on the

left to the selected items list on the right and click OK.
The list of selected items on the right includes the Active Directory entities that will be
synchronized.

6. UnderSecurity Role, click theBrowse button and select a default security role to apply to
newly created employees.

7. Click OK.
8. UnderSites, click theBrowse button and select a default site to apply to newly created

employees.
9. Click OK.
10. Click Run.

Active Directory synchronization is initiated and pertinent information is updated in YourSite
Explorer.
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To send recent configuration changes to client computers

1. In YourSite Explorer, underYourSite, click Enterprise orEmployees.
2. On the ribbon, click Tools.
3. Click Re-synchronize clients.

To completely reset client computers with the latest YourSite database configuration information

1. In YourSite Explorer, underYourSite, click Enterprise orEmployees.
2. On the ribbon, click Tools.
3. Click Reset clients.

To associate an existing employee with an Active Directory user

1. In YourSite Explorer, underYourSite, click Employee.
2. Select the employee you want to associate with an Active Directory user.
3. On the ribbon, click Active Directory.
4. Click Pick user.
5. Select a user from the Active Directory tree and click OK.
6. Click Save.

CONFIGURING YOURMiCONTACTCENTER for MICROSOFT
SKYPE – IVRROUTING ENTERPRISESETTINGS
Youmust configureMiContact Center for Microsoft Skype – IVR Routing Enterprise settings. Most
of these settings are populated during installation, but somemay require adjustment from the default
settings. The procedures for configuring the Enterprise settings can be found in the Enterprise setup
section of the Configuration chapter of theContact Center Solutions User Guidewith the following
differences:

l The addition of MiContact Center for Skype Server configuration on theEnterprise tab.
See "Specifying theMiContact Center for Skype Enterprise Server IP address" on page 246.

l TheMaintenance tab inMiContact Center for Microsoft Skype – IVR Routing Enterprise does
not have thePurge Life cycle reports older than option.

SPECIFYING THEMiCONTACTCENTER for SKYPE
ENTERPRISESERVER IPADDRESS
Tomake available Skype for Business queue statistics and populate the Skype for Business Server
Monitor’s Callback Requests monitor with agents to handle callbacks, youmust specify your
MiContact Center for Skype Enterprise Server's IP address.

To specify theMiContact Center for Skype server's IP Address

1. Click YourSite Explorer=>Enterprise.
2. In theEnterprise tab, under Lync Server, type theCC Lync (5.10) IP Address.
3. Click Save.



MiContact Center for Microsoft Skype User Guide

247

CONFIGURINGMEDIASERVERS
To useMiContact Center for Microsoft Skype – IVR Routing, youmust addMicrosoft Skype for
Business Pool media servers to your IVR Routing environment. EachMicrosoft Skype for Business
Pool media server represents a single pool configured on the Skype for Business Front End Server.
This enables IVR Routing to intercept calls to SIP endpoints on the Skype for Business Front End
server and route them through workflows and subroutines to the queues and agents on your
MiContact Center for Skype Enterprise Server.

NOTE:

l Do not delete the trusted application pool as other items may bemapped to it.
l You cannot have two application pools on the same computer.
l The same computer cannot be assigned tomultiple pools.

You can add one Lync media server per pool configured on the Skype for Business Front End Server.
To configure aMicrosoft Skype for Business Pool media server, youmust

l Add aMicrosoft Skype for Business Pool media server
l Specify Microsoft Skype for Business Pool media server location settings
l Apply routing rules to aMicrosoft Skype for Business Pool media server
l Associate computers to aMicrosoft Skype for Business Pool media server
l Add application endpoints to a Skype for Business media server

Adding aMicrosoft Skype for Business Pool media server
A Microsoft Skype for Business Pool media server represents a single Skype for Business pool on
the Skype for Business Front End Server. Once added in YourSite Explorer, most of the
configuration is automatically populated based on existing settings. The pools must already be
provisioned on the Skype for Business Front End Server.

NOTE: As it lacks Powershell 3.0, Windows Vista SP2 is not supported as a client computer
operating system for adding aMicrosoft Skype for Business Pool media server using YourSite
Explorer.

To add a Skype for Business media server

1. Click YourSite=>Media servers.
2. Click Add=>Microsoft Lync Pool.
3. AfterPool Name, select theMicrosoft Lync Pool from the drop-downmenu.

NOTE: Pools must be configured on the Skype for Business Front End Server.
4. AfterPool State, select Normal orEmergency from the drop-downmenu.

NOTE: This field is used with the Set Device and Set SystemMode of Operation activity. You
can use this field to change themedia server's mode outside of aManagement subroutine.

5. Enter thePort number for the Skype for Business media server.
By default, the port is 5061, whichmaps to the Skype for Business Listening port. This should
not be changed unless you havemodified the port number on the Skype for Business Front
End server.

6. Click Save.
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Specifying Skype for Businessmedia server location settings
Location settings for Skype for Business media servers are used with the Outbound workflow and
external Transfer activity destination. You specify your country, area, and the range of digits defining
numbers as internal, local external, and long distance external.

To specify the Skype for Business media server location settings

1. Click YourSite=>Media Servers.
2. Select a Skype for Business media server.
3. Click the Location tab.
4. AfterCountry, select the country in which themedia server resides.
5. AfterArea, select the area in which themedia server resides.
6. AfterMinimum digits to dial locally, specify theminimum number of digits required for a

local external call.
NOTE:Digits less than theminimum are treated as internal calls.

7. After Maximum digits to dial locally, specify themaximum number of digits required for a local
external call.
NOTE:Digits exceeding themaximum are treated as long distance external calls.

8. Click Save.

Applying routing rules to Skype for Businessmedia servers
After adding a Skype for Business media server, youmust build inbound and outbound workflows to
create the routing rules for directing inbound and outbound calls in your contact center. You can
either build the workflow directly in the Skype for Business media server’s Inbound andOutbound
canvases, or you can build a workflow in IVR Routing=>Workflows and associate the completed
workflows to your Skype for Business media server.

For information on building workflows, see "Building workflows" on page 249.

Associating computers to Skype for Businessmedia servers
After adding a Skype for Business media server, youmust add the associated computers and
servers, such as remote instances of MiContact Center for Microsoft Skype – IVR Routing. By
default, your MiContact Center for Microsoft Skype – IVR Routing server will have been added.

If you have other instances of IVR Routing on other servers, you can add them here to add
redundancy to your contact center. By setting a threshold, you control how long a call is offered to an
instance of MiContact Center for Microsoft Skype – IVR Routing before being offered to the next
instance of MiContact Center for Microsoft Skype – IVR Routing. You only need to set the
thresholds on the primary instance of MiContact Center for Microsoft Skype – IVR Routing. The
remoteMiContact Center for Microsoft Skype – IVR Routing instances do not require computers to
be added or thresholds to be set. When you run the remote server installation file on your remote
instances of IVR Routing, they are automatically added to the Available members in the Computer
tab.
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To associate a computer to a Skype for Business media server

1. Click YourSite=>Media servers.
2. Select a Lync media server.
3. Click theComputers tab.
4. UnderAvailable members, select a computer and click > to associate it to themedia server.
5. To set a threshold, under the Threshold column, set the time a call is offered to this instance

of MiContact Center for Microsoft Skype – IVR Routing.
6. Click Save.

Adding application endpoints to Skype for Businessmedia servers
When you create a Skype for Business media server, it automatically generates an endpoint on the
Skype for Business media server’s pool on the Front End Server. All calls coming to this endpoint
are routed through the Skype for Business media server’s Inbound workflow. Additional endpoints
from the associatedMicrosoft Skype for Business pool can be added to route calls through the
Skype for Business media server’s workflows.

To add an application endpoint to a Lync media server

1. Click YourSite=>Media servers.
2. Select a Skype for Business media server.
3. Click theApplication Endpoints tab.
4. Click theAdd button.
5. Under theName column, enter the endpoint name.
6. Under theSIP Address column, enter the endpoint SIP Address.

NOTE: You cannot change the endpoint SIP address after saving the endpoint.
7. Under Line URI, enter the endpoint Line URI.
8. Click Save.

BUILDINGWORKFLOWS
Workflows are the pathways callers use to reach areas and individuals in your organization.
Workflows dictate the prompts callers hear, the inputs requested by the system, and the available
routing options.

Workflows can identify customers and determine their service needs by phone number, numbers
dialed, and the digits entered to reach specific areas of your organization. Proper workflow
configuration is necessary to direct callers to the agents, departments, and employees best qualified
to handle their requests.

The following sections explain workflows available in IVR Routing, and general workflow
configuration procedures.
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NOTE:

l The functions performed when a caller contacts your organization depend on the activities
included in the workflow and how the activities are configured. For more information, see
"Activities" on page 256.

l If your contact center routinely handles a high volume of calls, for optimal traffic handling, we
recommend using subroutines in your workflows or increasing the number of available ports
for your workflows. For more information on subroutines, see "Building subroutines" on page
251.

l Workflows must be associated to a Skype for Business media server in order to go live in the
system. For more information, see "Associating workflows tomedia servers" on page 250.

Workflow types
Workflows are categorized in two types:

l Inbound—directs incoming calls to the agents, departments, and employees best qualified to
handle their requests

l Outbound—makes outgoing calls to external and internal numbers. Once connected, an
Outbound workflow can play the connected party a greeting or ask them to enter information
into IVR Routing. Outbound workflows can also transfer a connected party to a queue
automatically or based on responses in an optionmenu.

Each workflow type offers a specific selection of IVR Routing activities with which to build the
workflow. For more information, see "Activities" on page 256.

The IVR Routing chapter of Contact Center Solutions User Guide contains information on the
following workflow configuration procedures:

l Adding new Inbound andOutbound workflows
Workflows are added with Add=>Lync Voice.
Only Inbound andOutbound workflows can be added.

l Naming workflows
l Copying workflows
l Cutting, pasting, and copying workflow items
l Deleting workflows
l Importing and exporting subroutines and workflows
l Saving and copying workflows as images
l Locating workflow items in the Search field
l Associating workflows tomedia servers
See "Associating workflows tomedia servers" on page 250.

Associating workflows to media servers
Workflows must be associated to a Skype for Business media server in order to go live in the
system. You can only associate a single Inbound workflow and a single Outbound workflow to a
Skype for Business media server. After associating anOutbound workflow to a Skype for Business
media server, the ‘Always run’ check box in theWorkflows and Properties pane can be used to
enable and disable workflow execution.
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The following procedures explain how to

l Associate a workflow to a Skype for Business media server
l Make live anOutbound workflow

To associate a workflow to a Skype for Business media server

1. Click IVR Routing=>Workflows.
2. Select a workflow.
3. Click Media Server Membership.
4. UnderAvailable members, select theSkype for Business media server and click >.
5. Click Save.

Tomake anOutbound workflow live

1. Click IVR Routing=>Workflows.
2. Select anOutboundworkflow.
3. In theProperties pane, select Always run.
4. AfterSimultaneous calls, set the number of calls the workflow canmake at once.
5. Click Save.

BUILDING SUBROUTINES
Subroutines are portions of workflows that can be reused inmultiple workflows. Subroutines create
commonworkflow activity groups that can be easily reused, encapsulating common activity groups
in one single activity. Subroutines can be reused across workflows or within a single workflow,
which helps keep workflows manageable and enables rapid workflow creation. They also facilitate
workflow updates by requiring only one change to affect all workflows that use the subroutine.

With a few exceptions, subroutines and workflows function almost identically. Subroutines are
configured as Inbound, Outbound, Management, and Callback Inbound. Subroutines are configured
using activities, with specific activities available to each type of subroutine. This enables you to use
subroutines to access activities not normally available to your workflow type.

For information on building subroutines, see the IVR Routing chapter of theContact Center
Solutions User Guide.

CONFIGURING PROMPTS
Prompts are audio clips that provide callers with information during a call. Associated with activities,
prompts play messages when callers reach the associated activity in a workflow. Prompts can be
individual wave files or multiple wave files joined together to form custommessages. To see a list of
pre-configured prompts, go to 'IVR Routing=>Prompts'

For information on prompts and their configuration, see the IVR Routing chapter of theContact
Center Solutions User Guide, noting the following differences:

l You cannot create prompts based on queue statistics
l MiContact Center for Microsoft Skype – IVR Routing prompts support wav, wma, andmp3
audio file formats
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CONFIGURING CALLBACKS
Callbacks are specialized workflows and subroutines that enable customers to leave a request for a
return call (callback) from the contact center. These requests are collected and displayed in the
Skype for Business Server Monitor’s Callback Requests monitor, where they can bemanually
assigned to or picked by agents, allowing the agents to call back the customer. For more information
about the workflows and subroutines that enable your contact center to offer callbacks, see "IVR
Routing default subroutines" on page 267.

Two kinds of callbacks are available with IVR Routing

l Voice—Voice callbacks are initiated by the customer. The customer’s call is removed from
the queue and a callback request is resubmitted to the Callback Requests monitor. This
option can be provided by including a Callback Request in a workflow. For an overview of the
default inbound voice subroutine workflow, see "Default Inbound Voice Callback subroutine"
on page 267.

l Web—Web callbacks enable customers to submit callback requests using a website,
removing the need for customers to call the contact center in order to be placed in queue to
speak to an agent. For information about enabling web callbacks, see "Enabling web
callbacks" on page 252.

Supervisors and agents canmonitor and assign, reset, mark as complete, or reject callbacks using
the web-based Callback Requests monitor. For more information, see "Callback Requests monitor"
on page 271.

Enabling callbacks
Voice andWeb callbacks are enabled in different ways. Voice callbacks are enabled by placing a
Callback Request activity into a workflow, configuring the activity’s inbound subroutine, thenmaking
the workflow available to a queue through a dial out option. For information about dial out of queue,
see "Configuring Dial Out of Queue" on page 69. For information on the default Inbound Callback
subroutine, see "Configuring the web callback template" on page 253.

Web callbacks require a webpage to be set up to submit callbacks. IVR Routing includes a template
to use as your web callback submission page. For details of the template and configuring the
template for use, see "Configuring the web callback template" on page 253.

Enabling web callbacks
Web callbacks require both queues enabled to receive web callbacks and a webpage configured to
allow customers to submit callback requests to a contact center.

1. Set themaximum number of web callbacks an IP address can submit per hour.
See "Setting themaximum number of web callbacks an IP address can submit per hour" on
page 253.

2. Configure a web callback request page for your contact center.
See "Configuring the web callback template" on page 253.
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Setting the maximum number of web callbacks an IP address can submit
per hour
Youmust specify themaximum number of web callback requests that can be generated by a single
IP address per hour. By default, the value is 3. This setting helps limit the number of callback
requests a single IP can submit, preventing a single contact from flooding a contact center with
callback requests.

To configure themaximum number of web callback requests that can be generated by a single IP
address per hour

1. Click IVR Routing=>Workflows.
2. In theConfiguration tab, underMax Per Hour Per IP Address, select the number of

callbacks that can be submitted from a single IP address in an hour.
3. Click Save.

Configuring the web callback template
MiContact Center for Microsoft Skype – IVR Routing includes a template web callback request page
that can be customized for your contact center. MiContact Center for Microsoft Skype – IVR
Routing configures the web callback template in the sameway as Contact Center Solutions IVR
Routing, with the following differences:

l You do not need to change the default web callback subroutine
l You do not need to obtain web callback subroutine information from SQL

For information on how to configure the web callback template, see theContact Center Solutions
User Guide.

Enabling voice callbacks in conjunction with MiContact Center for
Microsoft Skype - Multimedia Contact Center
If you are licensed for bothMiContact Center for Microsoft Skype – IVR Routing andMiContact
Center for Microsoft Skype - Multimedia Contact Center, you can configure email queues to deliver
voice callback requests as emails, with the callback information included in the body of the email
and the recordingmade with the callback request as an attachment. This enables MiContact Center
for Skype to automatically deliver voice callback requests using ACD to agents as an alternative to
assigning callbacks to agents using the Callback Requests monitor.

Delivering voice callbacks toMiContact Center for Microsoft Skype - Multimedia Contact Center
email queues is accomplished by adding an email activity after the Save Callback activity in an
Inbound Callback subroutine. You can populate an email using callback variables created when the
callback request is saved.

Before enabling email queues to receive voice callback requests, youmust have the following
already configured:

l An Inbound Callback subroutine
MiContact Center for Microsoft Skype – IVR Routing includes a default Inbound Callback
subroutine. For more information, see "Default Inbound Voice Callback subroutine" on page
267.

l A SMTP server
l An email queue
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For information on configuring email queues, see the Contact Center Solutions Multimedia Contact
Center Installation and Deployment Guide.

To enable email queues to receive voice callback requests

1. Click YourSite=>IVR Routing.
2. Click Subroutines.
3. Select your Inbound Callback subroutine.
4. After theSave Callback activity, add anEmail activity.
5. Right-click theEmail activity and select Edit SMTP Server.
6. Select theSMTP Server and click OK.
7. Right-click theEmail activity and select Edit Email Template.
8. Configure the email template fields as follows:

l From: [any valid email address]
l To: [the destination email queue]
l Subject: New callback
l Attachment: <drive>\Program Files (x86)\prairieFyre Software
Inc\CCM\Ivr\Media\Recording\en-US\<<LastRecordingFilename>>

l Body:
You have a new voice callback
ANI: <<ANI>>
Phone number: <<CallbackClientNumber>>
Preferred callback time: <<CallbackPreferredDateTime>>
NOTE: The <<CallbackPreferredDateTime>> variable requires the
day/month/year/time of day format of DDMMYYYYTTTTXX, where XX is either ‘26’ for
AM or ’76’ for PM.

9. Click OK.
10. Click Save.

CONFIGURING RULES
You use rules to provide call conditions that are evaluated at the runtime of the workflow. They
enabled you to compare against a broad range of conditions in a single workflow activity, reducing
workflow clutter and enabling precise routing. For information on configuring rules, see the IVR
Routing chapter of theContact Center Solutions User Guide, noting the following differences:

l You can only create Voice andOutbound rules
l Only ANI, DNIS, Emergency, and Schedule are available as routing conditions
See the procedures below.

To add an ANI routing condition to a rule

1. UnderRouting Rules, click Add.
2. From the second column, click ANI.
3. From the third column, click the – button.
4. Click Add.
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5. In the third column, select an operator from the drop-down list.
6. In the fourth column, select eitherValue orVariable.
7. ForValue, type in theANI number.
8. ForVariable, select a variable from the drop-down list.
9. To add another ANI condition, click Add and repeat steps 5-8.
10. Click OK.

To add a DNIS routing condition to a rule

1. UnderRouting Rules, click Add.
2. From the second column, click DNIS.
3. From the third column, click the – button.
4. Click Add.
5. In the third column, select an operator from the drop-down list.
6. In the fourth column, select eitherValue orVariable.
7. ForValue, type in theDNIS number.
8. ForVariable, select a variable from the drop-down list.
9. To add another DNIS condition, click Add and repeat steps 5-8.
10. Click OK.

CONFIGURING HOLIDAYS
Holidays can be configured for dates that affect your contact center functionality.

To configure a holiday

1. Click IVR Routing=>Holidays.
2. Click Add.
3. AfterName, type the name of the holiday.
4. If this holiday is a company holiday and you want to receive warnings when trying to schedule

employees for this day, select This holiday is a company holiday.
5. Specify the pattern of the holiday.

l If the holiday always falls on the same day of themonth, select Every and specify the
month and date the holiday falls on.

l If the holiday has a pattern of falling on a certain day, week, andmonth, select The and
specify the pattern, day of week, andmonth.

l If the holiday is a calculated holiday, such as Good Friday or Easter Monday, select
Calculated holiday and specify the holiday.

6. Click Save.
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CONFIGURING DATAPROVIDERS
You can create a connection to a data provider located on a local or an external server to access
information about incoming callers. For example, the data providers query can be configured to
retrieve customer information based on ANI, DNIS, collected digits, or variables. IVR Routing can
addMicrosoft Excel worksheets, Microsoft SQL servers, and Lightweight Directory Access Protocol
(LDAP) as data providers to query for data. IVR Routing can also import ODBC connections
configured using theWindows ODBC Data Source Administrator.

IVR Routing supports the following reference platforms for ODBC connections:

l IBM DB2
l Oracle Database
l MySQL
l Microsoft Access
l PostgreSQL

For information on configuring data providers, see the IVR Routing chapter of theContact Center
Solutions User Guide.

CONFIGURING VARIABLES
Variables are used inmultiple activities and to perform various tasks, including:

l Storing information for later use
l Collecting user data
l Performing database queries
l Building simple or complex conditions

Variables can be used for different activities such as:

l Transferring a call to a different queue based on customer class
l Playing different prompts based on account balance
l Holding collected digits for use later in a database query

Only <LastCollectedDigits>,<LastQueryResult>, and <DNIS> can be used to populate information
in screen pop, providing agents with call information generated in the workflow.

For information on variables, see the IVR Routing chapter of theContact Center Solutions User
Guide.

ACTIVITIES
You use IVR Routing’s activities to build workflows and subroutines and configure routing conditions
that send customers to your MiContact Center for Skype queues. Activities perform a range of
functions, such as answering and transferring calls, collecting caller-entered digits, playing
customized prompts, and running database queries to retrieve caller information. The following
sections explain the activities available in IVR Routing and how you can configure activities to build
workflows, subroutines, and routing conditions.
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Information about each activity and its configuration in IVR Routing can be found in the IVR Routing
chapter of theContact Center Solutions User Guide.

There are some exceptions and configuration differences for activities between theMiContact
Center for Microsoft Skype – IVR Routing version and the Contact Center Solutions IVR Routing
version, which are detailed below.

Activities available in MiContact Center for Microsoft Skype – IVR
Routing
Table 25 lists the activities used to create IVR Routing workflows and subroutines. The table lists
the activity, shows the activity's icon, and lists the activity's availability according to workflow and
subroutine type. If an activity has any differences in configuration or use betweenMiContact Center
for Microsoft Skype – IVR Routing and Contact Center Solutions IVR Routing, the entry contains a
link to the configuration procedures.

ACTIVITY NAME ICON DETAILS

ANI

Available in Inbound workflows

Available in Inbound, Management, and
Callback Inbound subroutines

For configuration differences, see
"Configuring the ANI activity" on page 263.

Answer
Available in Inbound workflows

Available in Inbound, Management, and
Callback Inbound subroutines

Callback Requests

Available in Inbound workflows

Available in Inbound subroutines

For configuration differences, see
"Configuring the Callback Request activity"
on page 263.

Collect Digits

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Date Time Validation Available in Callback Inbound subroutines

Table 25: Activities available in IVR Routing
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ACTIVITY NAME ICON DETAILS

Delay

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

DNIS

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

For configuration differences, see
"Configuring the DNIS activity" on page
264.

Email

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Execute

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Go To

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Hang Up

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Table 25: Activities available in IVR Routing (continued)
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ACTIVITY NAME ICON DETAILS

Language

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Make Call

Available in Outbound workflows

Available in Outbound subroutines

For configuration differences, see
"Configuring theMake Call activity" on page
264.

Management
Available in Inbound workflows

Available in Inbound, Management, and
Callback Inbound subroutines

Menu

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Mode of Operation
Available in Inbound workflows

Available in Inbound andManagement
subroutines

Play

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Query

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Queue

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound, and
Callback Inbound subroutines

Table 25: Activities available in IVR Routing (continued)
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ACTIVITY NAME ICON DETAILS

Record
Available in Inbound workflows

Available in Inbound, Management, and
Callback Inbound subroutines

Rules

Available in Inbound andOutbound

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Save Callback
Available in Outbound workflows

Available in Outbound and Callback Inbound
subroutines

Schedule

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound, and
Callback Inbound subroutines

Set DeviceMode of
Operation

Available in Management subroutines

For configuration differences, see
"Configuring the Set DeviceMode of
Operation activity" on page 266

Set SystemMode of
Operation

Available in Management subroutines

For configuration differences, see
"Configuring the Set SystemMode of
Operation activity" on page 266

Set Variables

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Subroutine

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Table 25: Activities available in IVR Routing (continued)
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ACTIVITY NAME ICON DETAILS

SwampPrompt Available in Management subroutines

Transfer

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

For configuration differences, see
"Configuring the Transfer activity" on page
266

Variable Compare

Available in Inbound andOutbound
workflows

Available in Inbound, Outbound,
Management, and Callback Inbound
subroutines

Table 25: Activities available in IVR Routing (continued)

Understanding activity categories
Activities fall into three categories: conditional, action, and conditional action. Conditional activities
check a condition and branch calls based on that condition. For example, an ANI activity will check
the number from which a customer is calling and branch the call accordingly. Action activities
perform actions within a workflow or subroutine, but do not branch calls. For example, the Play
activity plays callers a prompt.

Conditional action activities perform actions and branch the call based on the result. For example, a
Query activity can retrieve a caller’s account balance and then branch the call to a Play activity that
will recount that information.

Conditions include the following activities:

l ANI
l Variable Compare
l DNIS
l Queue
l Rules
l Schedule

Actions include the following activities:

l Answer
l Callback Request
l Delay
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l Email
l Go To
l Hang up
l Language
l Management
l Play
l Set Variables
l Subroutine
l Swap Prompt

Conditional actions include the following activities:

l Collect Digits
l Date Time Validation
l Execute
l MakeCall
l Menu
l Mode of Operation
l Record
l Query
l Save Callback
l Set DeviceMode of Operation
l Set SystemMode of Operation
l Transfer

Configuring common activity options
Several of IVR Routing's activities share configuration procedures. See the IVR Routing chapter of
theContact Center Solutions User Guide for information on the following procedures for
configurations that are common tomany activities, branches, and branching conditions:

l Adding activities to workflows or subroutines
l Deleting activities or branches from workflows
l Naming activities, activity configurations, and branches
l Configuring activities and branches for reporting
l Configuring an activity’s prompts
l Finding activities in a workflow or subroutine
l Editing branches
l Annotating activities in a workflow or subroutines
l Troubleshooting workflow configuration
l Changing the order in which branches are evaluated
l Building conditions in IVR Routing features and activities

NOTE: Branches route callers to different portions of the workflow. Branching conditions represent
the circumstances a call must match in order to be sent to a particular branch.
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Configuring the ANI activity
The ANI activity branches workflows based on all or part of a customer’s ANI. For information on
configuring the ANI activity, see the IVR Routing chapter of theContact Center Solutions User
Guide, noting the following differences:

l Instead of configuring numbers, ANI in MiContact Center for Microsoft Skype – IVR Routing
relies on conditional values.
See the procedure below.

l ANI expressions / conditions can be grouped.
l You cannot import or export ANI conditions.

To add a branching condition to an ANI activity

1. Right-click theANI activity and select Add Condition.
2. Click Add.
3. In the third column, select an operator from the drop-down list.
4. In the fourth column, select eitherValue orVariable.
5. ForValue, type in theANI number orSIP address.
6. ForVariable, select a variable from the drop-down list.
7. To add another condition, click Add and repeat steps 3-6.
8. Click OK to create the branch or click Add to add the current branch to the workflow while

leaving the dialog box open to create new branches.
9. Click Save.

Configuring the Callback Request activity
The Callback Request activity runs a Callback Inbound subroutine which creates the callback
requests that agents handle using the Callback Requests monitor. For information on configuring the
Callback Request activity, see the IVR Routing chapter of theContact Center Solutions User
Guide, noting the following differences:

l You do not assign an outbound callback subroutine to the Callback Request activity.
MiContact Center for Microsoft Skype – IVR Routing does not use outbound workflows to
make callbacks.

l You enter a SIP address in the Destination field, instead of selecting queues, queue groups, or
variables.
The Destination field is optional in MiContact Center for Microsoft Skype – IVR Routing. See
the procedure below.

To optionally associate a destination to a Callback Request activity

1. Select theCallback Request activity.
2. In theProperties pane, afterDestination, type the dialable number SIP address of the

Callback Request’s destination.
The destination will appear in the Queue field of the Callback Requests monitor. See "The
View pane" on page 272.

3. Click Save.
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To optionally associate a queue or variable as a destination to a Callback Request activity

1. Select theCallback Request activity.
2. In theProperties pane, afterDestination, click ….
3. If associating a queue, click theQueue tab.
4. If associating a variable, click theVariable tab.
5. Select a queue or variable and click OK.
6. Click Save.

Configuring the DNIS activity
The DNIS activity branches workflows based on the number a customer has dialed. For information
on configuring the DNIS activity, see the IVR Routing chapter of theContact Center Solutions User
Guide noting the following differences:

l You cannot import or export DNIS conditions
l Adding a branching condition is performed differently.
See the procedure below.

To add a branching condition to an DNIS activity

1. Right-click theDNIS activity and select Add Condition.
2. Click Add.
3. In the third column, select an operator from the drop-down list.
4. In the fourth column, select eitherValue orVariable.
5. ForValue, type in theDNIS number orSIP address.
6. ForVariable, select a variable from the drop-down list.
7. To add another condition, click Add and repeat steps 3-6.
8. Click OK to create the branch or click Add to add the current branch to the workflow while

leaving the dialog box open to create new branches.
9. Click Save.

Configuring theMake Call activity
TheMake Call activity prompts the associatedMicrosoft Skype for Business Pool media server to
process an outbound call to a specified destination. This destination can be specified directly or can
be retrieved from a data source including a SQL database, an Excel file, aWeb Service call, and
filled into a variable set as the destination.

For information on configuring theMake Call activity, see the IVR Routing chapter of theContact
Center Solutions User Guide, noting the following differences:

l In MiContact Center for Microsoft Skype – IVR Routing, Make Call destinations can be
dialable numbers (including Line URI and SIP addresses), queues, or variables.
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To set a dialable number as the destination

1. Select theMake Call activity.
2. In theProperties pane, afterDestination, type the dialable number.

NOTE: MiContact Center for Microsoft Skype – IVR Routing does not support destination that
include ‘#’ in the Line URI.

3. Click Save.

To set a queue as the destination

1. Select theMake Call activity.
2. In theProperties pane, afterDestination, click….
3. Select a queue and click OK.
4. Click Save.

To set a variable as the destination

1. Select theMake Call activity.
2. In theProperties pane, afterDestination, click….
3. Select a variable and click OK.
4. Click theVariable tab.
5. Click Save.

Configuring the Queue activity
TheQueue activity branches workflows based on real-time queue conditions, enabling you to route
calls based on emerging queue conditions. For information on configuring the Queue activity, see the
IVR Routing chapter of theContact Center Solutions User Guide, noting the following differences:

l The available queue statistics are:
l Agent Idle
l Agents Available
l Agents Unavailable
l Call Load
l ExpectedWait Time
l Longest Wait Time
l Number of Calls Waiting
l Path DND
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Configuring the Set DeviceMode of Operation activity
The Set DeviceMode of Operation activity changes themode of operation for a specific Skype for
Business media server to Normal or Emergency.

For example, if only one of the Skype for Business media servers is experiencing emergency
conditions, you can use the Set DeviceMode of Operation to put that port into Emergency mode
without affecting the entire system’s operations. For information on configuring the Set DeviceMode
of Operation activity, see the IVR Routing chapter of theContact Center Solutions User Guide,
noting the following differences:

l Only Skype for Business media servers can have their mode set.
See the procedure below.

To configure the properties for a Set DeviceMode of Operation activity

1. Select theSet Device Mode of Operation activity
2. To set the variable containing the device dialable number, after Input variable, click the…

button.
The Select a variable dialog box opens.

3. Select an input variable and click OK.
The input variable must be populated with the Skype for Business media server’s Pool ID,
such as through a Collect Digits activity.

4. AfterMode of operation, select eitherNormal orEmergency from the drop-down list.
5. Click Save.

Configuring the Set System Mode of Operation activity
The Set SystemMode of Operation activity changes themode of operation for all Skype for
Business media servers to Normal or Emergency. For more information on the Set SystemMode of
Operation activity, see the IVR Routing chapter of theContact Center Solutions User Guide, noting
the following differences:

l The activity only sets themode of all Skype for Business media servers.

Configuring the Transfer activity
The Transfer activity transfers a caller to a specified destination, enabling you to send callers to a
dialable number (including Line URI and SIP addresses), queue, or variables. For information on
configuring the Callback Request activity, see the IVR Routing chapter of theContact Center
Solutions User Guide, noting the following differences:

l You cannot set an extension or queue group as the destination.
See the procedures below.

l In MiContact Center for Microsoft Skype – IVR Routing, Transfer destinations can be dialable
numbers (including Line URI and SIP addresses) or variables.
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To set a dialable number as the destination

1. Select the Transfer activity.
2. In theProperties pane, afterDestination, type the dialable number.

NOTE: MiContact Center for Microsoft Skype – IVR Routing does not support destinations
that include '#' in the Line URI.

3. Click Save.

To set a queue as the destination

1. Select the Transfer activity.
2. In theProperties pane, afterDestination, click ....
3. Click theQueue tab.
4. Select a queue and click OK.
5. Click Save.

To set a variable as the destination

1. Select the Transfer activity.
2. In theProperties pane, afterDestination, click ....
3. Click theVariable tab.
4. Select a variable and click OK.
5. Click Save.

Passing agents call information in screen pops
Screen pops pass call information to agent desktops. When the system routes a call, information
can be passed to agents via Contact Center Screen Pop. Contact Center Screen Pop is applied
uniformly across queues, providing all agents the same type of call information. MiContact Center
for Skype Screen Pop supports popping information collected in the <LastCollectedDigits>,
<LastQueryResult>, and <DNIS> variables. For more information, see "Configuring Contact Center
Screen Pop" on page 43.

IVRROUTING DEFAULTSUBROUTINES
MiContact Center for Microsoft Skype – IVR Routing includes several default subroutines. These
subroutines are based on common scenarios and demonstrate IVR Routing’s functionality. They can
be adjusted and re-configured according to your business needs.

MiContact Center for Microsoft Skype – IVR Routing includes the following default subroutines:

l Default Inbound Voice Callback Subroutine
l Default Management Subroutine

Default Inbound Voice Callback subroutine
This subroutine workflow is the default workflow for customers in queue to submit voice callbacks.
Callers who leave queue when presented with the option from the Callback Request activity can use
this workflow to leave amessage and set a time to be contacted later.

For information on the Default Inbound Voice Callback subroutine, see the IVR Routing chapter of
theContact Center Solutions User Guide.
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Default Management subroutine
When assigned to aManagement activity in a workflow, the Default Management Plan subroutine
enables authorized callers to remotely perform management operations on their IVR Routing
application. For example, authorized callers can switch the IVR RoutingMode of Operation between
Normal and Emergency mode andmodify the prompts that callers hear.

For information on the Default Management Subroutine, see the IVR Routing chapter of theContact
Center Solutions User Guide.

THE LYNCSERVERMONITOR
The Lync Server monitor is a web-based application that provides supervisors and agents with the
tools to manage and handle callback requests andmonitor active calls in IVR endpoints.

Using the Lync Server monitor, agents and supervisors can:

l Handle callback requests
See "Handling callback requests" on page 278.

l View current and past callback requests
See "The View pane" on page 272.

l View current calls on IVR endpoints
See "Interactive Contact Center" on page 235.

The following sections offer a complete description of the Lync Server monitor’s functions and
procedures for using the Lync Server monitor.

GETTING STARTEDWITHTHELYNCSERVERMONITOR
The Lync Server monitor is a web-based application that connects to theMiContact Center for
Microsoft Skype – IVR Routing server. The Lync Server monitor comprises twomonitors, the
Callback Requests monitor and the IVR Endpoints monitor. By default, the Lync Server monitor
opens to the Callback Requests monitor in the Tile view.

WhenMiContact Center for Microsoft Skype – IVR Routing is installed, a short cut to the Lync
Server monitor is added to the user desktop. (See Figure 69.)

Figure 69: Lync Monitors icon

To open the Lync Server monitor

l Double-click the Lync Monitors icon

To open the Lync Server Monitor in an open browser

l Navigate your browser to <IVR Enterprise Server IP address>/lyncmonitor.
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The Lync Server monitor bar
The Lync Server monitor bar provides agents and supervisors with the options for switching between
the Callback Requests monitor and the IVR Endpoints monitor. The Lync Server monitor bar also
displays the connection status of the Lync Server monitor to theMiContact Center for Microsoft
Skype – IVR Routing server. Figure 70 outlines the Lync Server monitor bar.

Figure 70: Lync Server monitor bar

If the Lync Server monitor bar is unable to connect to theMiContact Center for Microsoft Skype –
IVR Routing server, the Connection status icon will display a Disconnectedmessage. (See Figure
71.)

Figure 71: Connection Status displaying Disconnected message

The Language Setting button enables users to toggle the display language for the Lync Server
monitor. (See Figure 72.)

Figure 72: Language Setting
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The Lync Server monitor bar has a compact display for smaller windows and screens, which places
the links for Callback Requests monitor and IVR Endpoints monitor, as well as the Connection icon
beneath aMenu Icon. (See Figure 73 and Figure 74.)

Figure 73: Lync Server monitor compact view (menu collapsed)

Figure 74: Lync Server monitor compact view (menu expanded)

Changing the display language in the Lync Server monitor
The Lync Server monitor supports displaying callbacks and calls to the IVR Endpoints in the
following languages:

l Chinese (Simplified)
l Dutch
l English (UK)
l English (US)
l French (Canada)
l French (France)
l German
l Italian
l Portuguese (Brazil)
l Russian
l Spanish (Latin American)
l Spanish (Spain)

To change the display language in the Lync Server monitor

1. Click the Language Setting button.
2. Click the language in which you want themonitor to display.
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CALLBACKREQUESTSMONITOR
The Callback Requests monitor provides agents and supervisors with the tools required to efficiently
and effectively process callback requests from callers in a contact center.

Using the Callback Requests monitor, agents and supervisors can

l View the current and historical state of callback requests made to the contact center
NOTE: Callback requests remain in the system for 31 days before being removed.

l Handle callback requests using an intuitive interface

The following sections offer a complete description of the Callback Requests monitor’s functions
and procedures for using the Callback Requests monitor to view and handle callbacks requests.

Getting started with the Callback Requests monitor
The following sections provide a walkthrough of the Callback Requests monitor’s interface. We
recommend agents and supervisors read the following sections to familiarize themselves with the
Callback Requests monitor’s layout and names of components.

Figure 75 illustrates the Callback Requests monitor displaying active callbacks, with the different
sections of the Callback Requests monitor labeled.

Figure 75: Callback Requests monitor

The Callback Requests monitor comprises several different components:

l The Callback Requests bar
See "The Callback Requests bar" on page 271.

l The Snapshot
See "The Snapshot" on page 272.

l The View pane
See "The View pane" on page 272.

l The Callback Request window
See "The Callback Request window" on page 275.

The Callback Requests bar
Figure 76 displays the Callback Requests bar. The Callback Requests bar contains

l Total number of active callback requests
l View buttons
l Filter buttons and fields
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The View buttons are used to switch the display in the view pane between Tile view and Table view.
For more information on the View pane, see "The View pane" on page 272. For information on
changing the view in the View pane or filtering the callback requests displayed in the View pane, see
"Viewing callback requests" on page 276.

Figure 76: Callback Requests bar

For information on using the Callback Requests bar to change the view, see "The View pane" on
page 272. For information on using the filter options in the Callback Requests bar to change the
displayed callback requests, see "Filtering callbacks in the Callback Requests monitor" on page
277.

The Snapshot
The Snapshot provides an overview of how many callbacks of each status type there are in the
contact center. The Snapshot cannot be interacted with. (See Figure 77.)

Figure 77: Snapshot

The View pane
The View pane displays the active callback requests in the contact center. The Callback Requests
monitor has two views that can display in the View pane: Table view and Tile view. By default, the
Tile view opens first. Both views offers the same information about each callback:

Each callback entry displays the following callback request information:

l Name—the name derived from the caller’s ANI or entered on the web callback request form
l Phone number—the caller’s ANI or the number entered on the web callback request form
l Queue—the queue the caller dialed out of to leave a callback or the queue selected by the
caller in the web callback request form

l Agent Handling—the agent assigned to handle the callback request
l Status—the status of the callback request:

l New—a callback that has not been assigned to an agent
l In Progress—a callback that has been assigned to an agent
l Complete—a callback that has beenmarked as complete by an agent
l Rejected—a callback that has been rejected by an agent

l Received—the date the callback request was made
l Available—the availability of the customer, either set to immediately or to the date and time
specified by the caller when they made the callback request

l Caller location—the region from which the callback was made from
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Callbacks requests that are rejected and completed remain in themonitor for the day they are
completed and then are removed. You can view historical rejected and completed callbacks by
filtering by date. For more information, see "Filtering callbacks in the Callback Requests monitor" on
page 277.

The Tile view
The Tile view offers an easy to process view of callbacks in your contact center, grouped by their
status. (See Figure 78.)

Figure 78: Tile view

Each tile in the Tile view offers a compact display of the callback information. (See Figure 79.)
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Figure 79: Callback Request tile

The Table view
The Table view lists the callbacks made by a contact and its corresponding information in an easy to
process display. (See Figure 80.)

Figure 80: Table view

The Table view’s Action column offers a quick method of managing callbacks without opening the
Callback Request window. The Action column contains small buttons for each callback handling
option. Table 26 describes each action, the corresponding icon, and the callback status in which the
callback status is available.
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ACTION ICON CALLBACK STATUS AVAILABLE

Reset to New In Progress, Rejected, Complete

Dial
In progress, Rejected, Complete

NOTE: Dial is only available in Rejected if the callback is
assigned to an agent

Reject New Request, In progress

Mark Complete In progress

Table 26: Actions

For information on using the buttons in the Action column, see "Managing callbacks requests in the
Table view" on page 279.

The Callback Request window
The Callback Request window is where agents and supervisors can

l View callback information
l Listen to recordedmessages
l Assign a callback to an agent
l Mark a callback as complete
l Reject a callback
l Set a rejected, complete, or in progress as new

See Figure 81 for an example of the Callback Request window.

For information on handling callbacks, see "Handling callback requests" on page 278.

The Callback Request window has four sections:

l Information bar
l Destination bar
l Agent bar
l Action bar
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Figure 81: Callback Request window

VIEWING CALLBACKREQUESTS
Callback requests can be viewed in the View pane in either the Tile view or the Table view. Both
views offer the same information about the incoming callbacks, but in different fashions. For more
information about changing the view, see "Viewing the Callback Requests monitor’s Table and Tile
views" on page 276.

In both views, callback requests can be filtered to display only certain callbacks. For more
information on filtering callback requests displayed in the callback requests monitor, see "Filtering
callbacks in the Callback Requests monitor" on page 277.

Viewing the Callback Requests monitor’s Table and Tile views
The following procedures explain how to

l View the Callback Requests monitor in Table view
l View the Callback Requests monitor in Tile view



MiContact Center for Microsoft Skype User Guide

277

To view the Callback Requests monitor in Table view

l Click Table.

To view the Callback Requests monitor in Tile view

l Click Tile.

Filtering callbacks in the Callback Requests monitor
You can filter callbacks in either Table or Tile view by the status of the callback, the date of the
callback, or by text in the callback fields. The filter is applied to both Table and Tile views, so that
both views will display the same callbacks. If you are filtering by date, Rejected or Completed
callbacks display on the date they were rejected or completed.

You can search in text from the following fields:

l Name
l Phone number
l Queue
l Agent Handling
l Status
l Caller Location

The following procedures explain how to:

l Filter by status
l Filter by date
l Filter by text fields
l Clear status filters
l Clear date filters
l Clear text field filters

The following procedures take place in an open Callback Requests monitor.

To filter by status

l In theCallback Requests bar, after Filter, click the status by which you want to filter.
You can select multiple statuses by which to filter callbacks.

To filter by date

1. In theCallback Requests bar, click in theCalendar field.
2. If you want to filter by the current date, click Today.
3. If you want to filter by another date, click the day by which you want to filter contacts.
4. Click Done.

To filter by text fields

l In the Text Filter field, type the words or letters by which you want to filter.

To clear status filters

l In theCallback Requests bar, after Filter, click the status filter you want to remove.
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To clear date filters

1. In theCallback Requests bar, click in theCalendar field.
2. Click X.

To clear a text field filter

1. In theCallback Requests bar, click the Text Filter field.
2. Click X.

Sorting callback requests in the Table view
In the Table view, callback requests can be sorted by callback request information. Callback
requests can be sorted by all available columns in the Table view except the Actions column. Sorting
can be ascending or descending.

The following procedure takes place in an open Callback Requests monitor in the Table view.

To sort callback requests in the Table view

l Click on the column by which you want to sort the callback requests.

Handling callback requests
When you click on a callback request tile or row, the Callback Request window opens. This window
enables agents and supervisors to review callback information, listen to any recording, and choose
how to handle the request.

The Callback Request monitor enables you to

l Open the Callback request window
l Listen to callback request message
l Reject a callback request
l Reset a callback request to New
l Mark a callback request as complete
l Manage callback requests in the table view

Listen to callback request messages
Whenmaking a callback request, callers can record amessage (if making a voice callback request)
or type amessage (if making a web callback request). Supervisors or agents handling callback
requests can listen to a voice callback request’s recordedmessage or a web callback request’s text-
to-speechmessage.

Messages are stored in .wma format and can be played in any media player application that supports
that format.

The following procedure takes place in an open Callback Request window.

To listen to a callback request message

l In the Information bar, click Listen to recording.
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Assign a callback request
Callback requests must be assigned to an agent to handle. Assigning attaches the agent’s name to
the callback request and changes the state to In Progress, letting other agents and supervisors know
that the callback request is being addressed. If you are assigning a callback to yourself, you can also
choose tomake the callback to the customer at the same time as you assign the callback to
yourself. Agents dial the callbacks manually with Lync tomake the callbacks.

The following procedures take place in an open Callback Request window.

To assign a callback request to an agent

l In theAgent bar, select an agent.

To assign a callback request to yourself andmake the callback immediately

1. In theAgent bar, select yourself.
2. In theAction bar, click Dial.

Reject a callback request
Supervisors and agents can reject callback requests that do not need handling. Rejecting a callback
request changes the callback request’s status to Rejected, indicating that it requires no further
action.

The following procedure takes place in an open Callback Request window

To reject a callback

l In theAction bar, click Reject.

Reset a callback request to New
Supervisors and agents can reset a callback request to New, in case it needs to be rehandled.

The following procedure takes place in an open Callback Request window

To reset a callback request to New

l In theAction bar, click Reset to new.

Mark a callback request complete
When an agent has completed the callback request, they manually close the callback request by
marking it complete.

The following procedure takes place in an open Callback Request window

Tomark a callback complete

l In theAction bar, click Mark Complete.

Managing callbacks requests in the Table view
The following procedures take place in an open Callback Requests monitor set to the Table view

To reset a callback request to new in the Table View

l In the row of an In Progress, Rejected, orCompleted callback, click the Reset to New
button.
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To assign a callback to an agent in the Table View

1. In the row of aNew or In Progress callback request, click theAssign button.
The Callback Request window opens.

2. In theAgent bar, select an agent.
3. Click Assign=>Assign.

To assign a callback request to yourself andmake the callback in the Table View

1. In the row of aNew or In Progress callback request, click theAssign button.
The Callback Request window opens.

2. In theAgent bar, select yourself.
3. In theAction bar, click Assign=>Assign and dial.

To reject a callback in the Table View

l In the row of aNew or In Progress callback request, click theReject button.

Tomark as callback complete in the Table View

l In the row of an In Progress callback request, click theMark Complete button.

THE IVRENDPOINTSMONITOR
The IVR Endpoints monitor enables administrators to view both the different types as well as the
number of the ongoing calls. The IVR Endpoints monitor provides information on ongoing calls in
each endpoint, whether the call is Inbound or Outbound. (See Figure 82.)

Figure 82: IVR Endpoints monitor

Getting started with the IVREndpoints monitor
The following sections provide a walkthrough of the IVR Endpoints monitor’s interface. We
recommend agents and supervisors read the following sections to familiarize themselves with the
IVR Endpoints monitor’s layout and names of components.

Figure 83 illustrates the IVR Endpoints monitor displaying an active call, with the different sections
of the IVR Endpoints monitor labeled.
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Figure 83: IVR Endpoints monitor

IVR Endpoints bar
Figure 84 displays the IVR Endpoints bar. The IVR Endpoints bar contains

l Total number of active calls in IVR Endpoints
l Filter buttons and fields

For information on filtering the calls displayed in the IVR Endpoints monitor, see "Filtering calls in the
IVR Endpoints monitor" on page 282.

Figure 84: IVR Endpoints bar

The View pane
The View pane displays the active calls to IVR Endpoints. Figure 85 displays an active call in the
View pane. Each call entry displays the following call information:

l Caller Name—The caller’s name
l Caller Number—The phone number or SIP address of the caller
l DNIS—The phone number or SIP address entered by the caller
l Computer—The computer currently handling the call
l Status

l Ringing—A call that is establishing itself to an endpoint
l Talking—A call that is active in a workflow or in queue
l Transferring—A call that is in the process of being transferred
l Incoming—A call that is being received by an endpoint, but has not established itself
yet

l Started—When the call entered the IVR system
l Duration (HH:MM:SS)—The current duration of the call



The Lync Server monitor

282

Figure 85: The View pane

Filtering calls in the IVREndpoints monitor
You can filter calls by the type of call or by text in the IVR Endpoints fields. You can search in text
from the following fields:

l Caller Name
l Caller Number
l DNIS
l Computer
l Started

The following procedures explain how to:

l Filter by type
l Filter by text fields
l Clear status filters
l Clear text field filters

The following procedures take place in an open IVR Endpoints monitor.

To filter by type

l In the IVR Endpoints bar, after Filter, click the type of call by which you want to filter.
You can select multiple types by which to filter callbacks.

To filter by text fields

l In theSearch by any field field, type the words or letters by which you want to filter.

To clear status filters

l In the IVR Endpoints bar, after Filter, click the status by which you want to filter.

To clear a text field filter

1. In the IVR Endpoints bar, click theSearch by any field field.
2. Click X.
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MiCONTACT CENTER for MICROSOFT SKYPE -
MULTIMEDIA CONTACT CENTER

WithMiContact Center for Skype Version 5.10.9, you can optionally choose to integrate with
Multimedia Contact Center. Multimedia Contact Center adds email, fax, and chat handling to a
Microsoft Skype for Business voice environment. Email and chat contacts are routed using
workflows, created with a visual, intuitive interface. Fax is supported as an email attachment only.
Also included inMultimedia Contact Center is a Contact Us page that can be used by contact center
website administrators to add live wait time statistics to their corporate website page, enabling
customers to select their preferred communicationmethod based onmedia type availability.
Multimedia reports provide valuable information andmultimedia charts summarize contact center
performance into a single report.

For a full description of all Multimedia Contact Center features, see theMultimedia Contact Center
Installation and Deployment Guide.

GENERAL INFORMATION FORSYSTEM
ADMINISTRATORS

In this implementation, multimedia contacts aremanaged from a server which operates
independently from theMiContact Center for Microsoft Skype voice server. Due to this division of
media type responsibilities, each client desktop will have separate applications (agent and
supervisory) for handling andmonitoring voice and non-voice contacts. Likewise, reports will be
accessible using two CCMWeb shortcuts – one for voice reports (Lync – 5.10.9 Server) and one for
non-voice reports (Multimedia Contact Center – 7.1 Server).

To simplify report interpretation, since the voice reports and non-voice reports originate from
separate servers, we recommend using the same reporting numbers for all employees on each
server so that they match.

In this integration, Multimedia Contact Center is administered locally with YourSite Explorer, using a
remote desktop connection to the Contact Center Solutions 7.1 Enterprise Server.

All voice-related configuration is described in theMiContact Center for Skype documentation and all
non-voice-related configuration is described in theMultimedia Contact Center Installation and
Deployment Guide.

See theMiContact Center for Microsoft Skype Installation Guide for specific instructions regarding
installing theMiContact Center for Microsoft Skype - Multimedia Contact Center integration.

For new installations, refer to theMiContact Center for Skype System Engineering Guide,
Installation Guide, and User Guide to set upMiContact Center for Skype Version 5.10.9 before
installingMiContact Center for Microsoft Skype - Multimedia Contact Center.
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DEPLOYMENT SCENARIOS
Multimedia Contact Center can be deployed differently depending on your setup and contact center
needs. In all scenarios, Multimedia Contact Center is a standalone product and is configured and
maintained outside of theMicrosoft Skype for Business environment. The following deployment
scenarios are available:

l Multimedia Contact Center with MiContact Center for Skype, whereMultimedia Contact
Center is used as amethod for routing and handling non-voice contacts and no other Contact
Center Solutions 7.1 features are accessed.

l Multimedia Contact Center and IVR Routing are both integrated with MiContact Center for
Skype.

l Multimedia Contact Center as a standalone product without aMiContact Center for Skype
server.

NOTE:When you implement Multimedia Contact Center in aMicrosoft Skype for Business
environment, with or without MiContact Center for Skype, Multimedia Contact Center is installed as
a standalone on its own server. If you are also running the IVR Routing integration, Multimedia
Contact Center can optionally be co-located on the same server that houses IVR Routing.

GENERAL INFORMATION FORSUPERVISORS AND
AGENTS

As mentioned above, the Skype for Business environment handles all voice contacts and the
Multimedia Contact Center environment handles all other supportedmedia types. As a result, each
client desktop has co-residing applications to enable handling andmonitoring of all contact types and
report access.

Voice andmultimedia applications run independently of each other. If you set presence, such as
Make Busy, in one application then youmust also set it in the complementary application. Voice and
non-voice applications (Ignite and Contact Center Client) do not communicate with each other.

The following applications reside on the client desktop.

Agent applications:

l Lync Ignite – for handling all voice contacts
l Ignite – for handling all non-voice contacts (email, chat, fax (as email attachment only))

Supervisor applications:

l Lync Contact Center Client – for monitoring and interacting with real-timemonitors associated
to voice activity

l Contact Center Client – for monitoring and interacting with real-timemonitors associated to
non-voice activity (email, chat, fax)

l Lync Contact Center Management (CCMWeb) desktop shortcut for MiContact Center for
Skype Version 5.10.9 voice reports

l Mitel Contact Center Management (CCMWeb) desktop shortcut for Contact Center Solutions
7.1Multimedia Contact Center non-voice reports
Available reports are described in theMiContact Center for Microsoft Skype Reports Guide.
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All voice-related information is described in theMiContact Center for Skype documentation and all
non-voice-related information is described in theMultimedia Contact Center Installation and
Deployment Guide.
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Appendix A
APPLICATIONNOTES
BUILDING ANAUTO ATTENDANT

You can configure auto attendant functionality by converting queues in YourSite Explorer into a
series of menus to provide callers with automated call transfer options. By building your own auto
attendant with queues, you can offer a simplemenu system with up to three tiers of menus, each
with up to twelve dial out of queue destination points.

In planning an auto attendant for your contact center, you should consider the following four
conventions of auto attendants:

l Dialing '0' – Auto attendants are expected to always have an option configured for when a
caller dials '0', such as an operator, voicemail, or a queue

l Timeout – Your auto attendant must have options for when callers do nothing, such as
prompting them with the welcome greeting for the queue again or routing them to another
endpoint

l Failure – Auto attendants are expected to have a location where calls are routed if a transfer
fails

l Default mailbox – Auto attendants are expected to have a location where to send calls if '0' is
not answered

Following are the steps required in order to set up an auto attendant:

1. Record and configure queue announcements
2. ConfigureMusic OnHold
3. Configure empty auto attendant agent group
4. Configure the auto attendant queues

SAMPLEQUEUETYPESFORAUTO ATTENDANTQUEUE
TYPES
An auto attendant’s queues may havemany different possible configurations depending on an
individual contact center’s specific needs. These instructions refer to a sample auto attendant
configuration which uses six different types of queue configurations to build the auto attendant:

l Main Menu queue—This queue serves as the first auto attendant menu callers encounter.
TheMainMenu queue interflows calls that timeout to the No Action Detected queue. For the
Queue Unavailable answer point, theMainMenu queue uses a voicemail endpoint or the
endpoint of a live operator.

l Submenu queues—These queues serve as the general menus for your auto attendant.
Submenu queues interflow calls that timeout back to theMainMenu. For the queue
unavailable answer point, submenu queues use the Failed Transfer queue.
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l No Action Detected queue—This queue serves as the interflow point for when callers take
no action in theMainMenu queue. It informs callers that they have taken no action and offers
them the option of returning to theMainMenu queue or exiting the system via the Exit queue.
The No Action Detected queue interflows calls that timeout to the Exit queue. This queue
does not have any Queue Unavailable answer points configured.

l Failed Transfer queue—This queue is the queue unavailable answer point for all Submenu
queues. It informs callers that the option they have selected is not available and offers them
either the option of a voicemail or live operator end point, returning to theMainMenu, or
exiting the system via the Exit queue. This queue interflows to the Exit queue. The Failed
Transfer queue does not have a queue unavailable answer point configured.

l Exit queue—This queue provides an automatic exit point for calls in the auto attendant. Calls
are routed to the Exit queue either through lack of activity or by caller choice. The Exit queue
is permanently set in Do Not Disturb through a schedule, disconnecting callers after the
Queue Closedmessage plays. When callers connect to this queue, the queue closed
message plays before the caller is disconnected and their call ends. The Exit queue has no
interflow options and has no queue unavailable answer point.

l Destination queue—This queue is a standard contact center queue, staffed with agents,
such as a sales or customer service queue, serving as a destination for calls within the auto
attendant. The auto attendant is not reliant on any particular destination queue configuration
for its functionality, but may benefit from having the queue unavailable answer point for
destination queues set to the Failed Transfer queue.

SAMPLEAUTO ATTENDANTCONFIGURATION
This sample describes a possible auto attendant configuration that uses the six sample types of
queues to build an auto attendant solution providing callers with easy access to sales, customer
support, and billing. The sample auto attendant consists of the following queues and endpoints:

l A MainMenu
l Three Submenus
l A No Action Detected queue
l A Failed Transfer queue
l Nine destination queues

l Three sales queues
l Three customer support queues
l Two billing queues
l An operator queue

l One voicemail endpoint

Figure 86, Figure 87, Figure 88, and Figure 89 explain the structure of the auto attendant, the dial out
of queue call routing options, and the queue unavailable and interflow relationships.

Figure 86 and Figure 87 detail the dial out of queue destination points for the auto attendant. These
destination points reflect the general structure of the auto attendant and the primary call routing
options. Figure 86 outlines the destination points for theMainMenu and Submenus.
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Figure 86: Example auto attendant destination points for Main Menu and Submenus

TheMainMenu offers callers the option of connecting to the three Submenus: Sales, Customer
Support, and Billing. It also offers the option of connecting to an operator queue, which is a
destination queue staffed with agents trained to help transfer customers to their desired endpoint, as
well as a voicemail endpoint, where callers can leave amessage. Each Submenu in turn offers
callers the choice of product-specific destination queues. The Submenus also offer the option of
connecting to the operator queue or returning to theMainMenu.

Figure 87 details the destination points of the Failed Transfer and No Action Detected queues. These
two queues are not accessible to callers as dialable destination points from other queues. Instead,
callers are routed to these queues through queue unavailability and interflow options. Both of these
queues serve to either route the caller back to theMainMenu or finish their interaction with the auto
attendant by leaving amessage with the voicemail endpoint or exiting through the Exit queue.
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Figure 87: Example auto attendant destination points for Failed Transfer and No Action
Detected queues

The No Action Detected queue, in which users arrive because they have failed to take any action in
theMainMenu, offers a dial out back to theMainMenu as well as the option to exit the auto
attendant. The Failed Transfer queue, where callers are routed if they try to enter a queue that is
unavailable, offers callers the choice of returning to theMainMenu, leaving a voicemessage, or
exiting the auto attendant. The Exit queue hangs up on calls after playing the Queue Closed
message.

Figure 88 outlines the unavailability routing relationship between queues in the auto attendant, where
calls are routed to different queues that either enable them to try andmake their connection again or
exit the auto attendant.
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Figure 88: Auto attendant queue unavailable answer points

TheMainMenu routes calls to a voicemail, offering after-hours callers an ideal point of contact with
the contact center. The operator queue also routes calls to voicemail when unavailable. The three
Submenus route calls to the Failed Transfer queue, where callers can be routed back to themain
menu, leave amessage at a voicemail extension, or exit the auto attendant. Destination queues,
such as the product sales queues, also route calls to the Failed Transfer queue.

Figure 89 details the interflow relationship between the sample auto attendant’s component queues,
illustrating where calls are routed to after timing out.
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Figure 89: Auto attendant interflow points

For interflow, the three Submenus interflow into theMainMenu after timing out. TheMainMenu
interflows into the No Action Detected queue. Both No Action Detected and Failed Transfer move
calls out of the auto attendant on timeout to the Exit queue.

Auto attendant call scenarios
Below are three scenarios providing examples of how the sample auto attendant handles calls.

Scenario 1 – Caller wishing to speak with a sales representative for Product Y

A caller calls the contact center looking to speak to a sales representative for Product Y. Their call
arrives at theMainMenu queue and the welcome greeting plays to the caller.

'Welcome toMitel. For Sales, press 1. For Customer Service, press 2. For Billing press 3. For
operator assistance, press 0. To leave amessage, press *'.

The caller presses 1 and is transferred to the Sales Submenu. The welcome greeting for the Sales
Submenu plays.

'Welcome toMitel Sales. To speak with a representative about Product X, press 1. To speak with a
representative about Product Y, press 2. To speak with a representative about Product Z, press 3.
For operator assistance, press 0. To return to themainmenu, press *'.

The caller presses 2 and is transferred to the Product Y queue, where their call is answered and
handled by an agent.

Scenario 2 – Caller contacting an unavailable queue

A caller calls the contact center seeking customer service assistance for the Product Z they
purchased. The call enters theMainMenu queue and the welcome greeting plays.

'Welcome toMitel. For Sales, press 1. For Customer Service, press 2. For Billing press 3. For
operator assistance, press 0. To leave amessage, press *'.
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The caller presses 2 and is transferred to the Customer Service submenu. The welcome greeting
plays.

'Welcome toMitel Customer Service. For assistance with Product X, press 1. For assistance with
Product Y, press 2. For assistance with Product Z, press 3. For operator assistance, press 0. To
return to theMainMenu, press *'.

The caller presses 3. No agents are present in the queue, so the call is transferred to the Failed
Transfer queue. The welcome greeting plays.

'We’re sorry, that option is not available at this time. To return to themainmenu, press 1. To leave a
message, press 2. To exit the system, press 3'.

The caller presses 1 and returns to theMainMenu. The caller repeats their actions to get back to the
Customer Support Submenu and tries once again to connect to customer service for Product Z.
There are still no agents present in the queue, so the call is routed back to the Failed Transfer queue.
This time, the caller presses 2 and is transferred to voicemail, where they leave amessage for
Customer Service and hang up.

Scenario 3 – No caller action

A caller calls the contact center seeking assistance from a sales representative. The call enters the
MainMenu queue and the welcomemessage plays.

'Welcome toMitel. For Sales, press 1. For Customer Service, press 2. For Billing press 3. For
operator assistance, press 0. To leave amessage, press *'.

After hearing the welcomemessage, the caller receives a call on another line. Switching lines, the
caller finds it is an important client with an urgent issue and is unable to return to their call to the
contact center to hang up. Their call to Mitel sits in theMainMenu queue while the welcome
message plays at the specified intervals before the interflow timer expires, where the call then
transfers to the No Action Detected queue. The welcome greeting plays.

'You have not taken any action. To return to themainmenu, press 1. To exit the system, press 2'.

The caller, however, is still on the other line with their client, and cannot take any action. When the
interflow timer expires, the call is interflowed to the Exit queue, where the queue unavailable
message plays.

'Thank you for callingMitel. Good-bye'.

The caller is then disconnected from the auto attendant.

RECORDING ANDCONFIGURING QUEUEANNOUNCEMENTS
Auto attendant requires queue announcements to welcome callers to each queue in the auto
attendant and inform them of the available destination points. Youmust record your own
announcements to use as queue announcements with your auto attendant queues. All
announcements must be in .wma format. The codec required is 32kpbs, 44khz, 16-bit mono, and
CBR (Constant Bit Rate).
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After recording the announcements, youmust configure each with queue announcements so they
can be added to specific queues. Each queue requires its own queue announcement. For
instructions on configuring queue announcements and announcement types available, see
"Configuring queue announcements" on page 60.

The sample auto attendant would require the following announcements configured as the specified
announcement type for queue announcements:

l Main Menu
Welcome greeting:An announcement welcoming callers to the company and a list of the
available destination points

l Submenu
Welcome greeting:An announcement for each submenu queue welcoming callers to the
submenu and a list of the available destination point

l No Activity Detected
Welcome greeting:An announcement informing the callers that they have taken no action
and informing them of the dial out options of returning to theMainMenu or exiting the system

l Exit queue
Queue Closed announcement:An announcement thanking callers and saying good-bye
before they are disconnected

l Failed Transfer
Welcome greeting:An announcement stating that the call failed to transfer to the destination
and informing callers of the dial out options of returning to theMainMenu, leaving a voicemail,
or exiting the system

CONFIGURINGMUSICONHOLDFORAUTO ATTENDANT
It is recommended that before configuring your queues, you configure aMusic OnHold playlist for
your auto attendant queues. Without Music OnHold, your callers will hear silence after the queue
announcement plays.

For information on configuring aMusic OnHold playlist, see "ConfiguringMusic OnHold playlists"
on page 61.

CONFIGURING ANEMPTYAUTO ATTENDANTAGENT
GROUP
Queues require at least one agent group assigned to them. It is recommended that you create an
agent group with no agent membership to use for themandatory agent group.

For information on creating agent groups, see "Adding agent groups" on page 59.

To add an empty auto attendant agent group

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Agent groups.
3. Click Add.
4. AfterName, type Auto Attendant.
5. AfterReporting number, assign an available reporting number.
6. AfterMedia server, click… and select themedia server for the agent group.
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7. Under Reporting and real-time options, select
l Historical reporting only if you want to run reports on an agent group without real time
monitoring.

l Real time and reporting if you want to run reports on an agent group andmonitor it
with basic real time functionality, such as ACD states and statistics and presence.

8. Click Save.
The warningmessage indicating there are nomembers assigned to this groupmay be safely
ignored.

CONFIGURING THEQUEUESFORTHEAUTO ATTENDANT
After configuring your queue announcements andMusic OnHold playlist for auto attendant, you
must create the queues that you will use to build your auto attendant and configure routing, interflow,
and dial out of queue options. As it is likely that many queues will serve as destination points for one
another, it is recommended to do this in two steps, creating the auto attendant queue and then
configuring the queue routing, interflow, and dial out of queue options after all the queues are created.

Auto attendant queues, like normal queues, have a variety of different options available andmay be
configured in different ways. Nomatter the configuration, the Routing tab option 'Allow calls to queue
when no agents are present in this queue' must be selected for a queue to function as an auto
attendant menu as none of the queues have agents logged in to handle calls. The sole exceptions
are Destination queues, which are expected to have agents.

Both interflow and queue unavailable should be used in auto attendant queues. Interflow enables the
auto attendant to move inactive calls to different queues or out of the auto attendant entirely if they
continue to timeout. Queue unavailable answer points route calls to suitable destination points in
cases where the original destination was unavailable, such as when a destination queue has no
agents logged in or if the caller reaches theMainMenu after business hours.

After creating all the queues for the auto attendant, youmust add the dial out of queue destination
points to each queue to complete the auto attendant. For more information, see "Configuring Dial Out
of Queue" on page 69.

The procedures below detail one possible method of configuring the queues for the auto attendant.
The queue types configured are the sample auto attendant queue types, excluding Destination
queues, which are configured as standard queues. For information on configuring a standard queue,
see "Adding queues" on page 63.

This sample configuration assumes the creation of three schedules:

l Standard business hours: The standard business hours for your company
l 24/7 Available:Monday to Friday, 24 hour a day availability
l 24/7 Closed: 'Disable for day' check box enabled for every day during the week

For more information on creating schedules, see "Configuring schedules" on page 52.
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To create queues for an auto attendant

1. In YourSite Explorer, in the left pane, click YourSite.
2. UnderDevices, click Queues.
3. Click Add.
4. UnderCommon, specify theName andReporting number for the queue.

NOTE: To ensure accurate reporting, queue reporting numbers must be unique across both
active and inactive queues.

5. Click ... and select themedia server for the queue.
6. Click OK.
7. UnderConnection Settings, type theSIP Address and Line URI for the queue.

NOTE:
l A queue's SIP address cannot be changed once the queue has been saved. To change
a queue's SIP address, youmust first delete and recreate the queue. You can then type
the new SIP address.

l In amulti-site installation of MiContact Center for Skype with multiple Enterprise
Servers, there is the remote possibility that a queue will be provisioned that uses a Line
URI in use at another Enterprise Server site’s configuration. For troubleshooting
assistance, see the following Knowledge Base article:
http://micc.mitel.com/kb/KnowledgebaseArticle51623.aspx

8. UnderMedia Options, click ... and select aQueue Announcement.
9. Click OK.
10. If you want to enableMusic on Hold, select Use Music on Hold for this queue.

Music on Hold settings are configured on themedia server.
11. Click theMembership tab.
12. UnderAvailable members, select Auto Attendant and click > to move the agent group to

theSelected members list.
13. Click the Business Hours tab.
14. After Business-hour schedule, click ... and select a schedule for the queue.

l If the queue is theMainMenu or a Submenu, select Standard Business Hours
l If the queue is No Action Detected or Failed Transfer, select 24/7 Available
l If the queue is the Exit queue, select 24/7 Closed

15. Click OK.
16. Click Save.
17. Repeat steps 3-16 to create all the queues for your auto attendant.

http://micc.mitel.com/kb/KnowledgebaseArticle51623.aspx
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To configure each queue’s routing, interflow, and dial out of queue options

1. UnderQueues, select the auto attendant queue in which to define the routing, interflow, and
Dial Out of Queue options.
The queue opens in the pane below.

2. Click theRouting options tab.
3. AfterQueue unavailable answer point directory number, type the Line URI or SIP

Address of the endpoint you want calls to be directed to if the queue is unavailable.
l MainMenu: Type the Line URI or SIP Address of a voicemail answer point or live
operator

l Submenu queue: Type the Line URI or SIP Address of the Failed Transfer queue
l Failed Transfer queue: Do not set a Queue unavailable answer point
l NoAction Detected queue: Do not set a Queue unavailable answer point
l Exit queue: Do not set a Queue unavailable answer point

4. Select theAllow calls to queue when no agents are present in this queue check box.
NOTE: This optionmust be selected for all auto attendant queues. If it is not selected, the
queue will not function as a part of an auto attendant.

5. Under Interflow options,
l After Interflow enabled, select Yes. If this queue is the Exit Queue, select No.
l After Interflow timeout, specify the time that will pass before the call is taken from the
auto attendant menu.
The Interflow timeout should be calculated based on the length of themessage, the
interval between themessage repeating, and the amount of time between the final
playing of themessage and interflow. For example, if you had a 10 second long
message that you wanted to play every 20 seconds for a total of 2 times before
interflowing the call after a final 20 seconds to your No Action Detected queue, you
would set the time to aminimum of 60 seconds (10+20+10+20=60 seconds).

l After Interflow point directory number, type the interflow answer point directory
number, Line URI or SIP Address, or click ... to select from a list of optional answer
points, where calls will be interflowed to when the queue is unavailable. Interflow points
can be Line URIs or other SIP addresses.

l MainMenu: Type the directory number, Line URI, or SIP Address of the No
Action Detected queue

l Submenu queue: Type the directory number, Line URI, or SIP Address of the
MainMenu

l Failed Transfer queue: Type the directory number, Line URI, or SIP Address of
the Exit Queue

l NoAction Detected queue: Type the directory number, Line URI, or SIP Address
of the Exit Queue

6. Click the Interactive queue control tab.
7. Select the The queue uses Interactive Contact Center queue control check box to enable

this queue to be interactively controlled using the schedule you specify.
8. Click theDial Out of Queue tab.
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9. AfterEnable Dial Out of Queue after, set the time to 00:00:00.
Alternatively, youmay set the time to be the same length of time as the first announcement
that plays for the queue.

10. UnderDial Out Of Queue Destination Endpoints, in the text box beside the DTMF digits
you want to configure as dial-out options, enter the phone number, SIP address, or Line URI
for each desired destination point.
NOTE:Phone numbers must be entered only as Line URI, without hyphens or parentheses,
e.g. tel:+6135990045. Phone numbers must work when dialed by a Skype for Business client.

11. When you are finished setting the destination points, click Save.
12. Repeat steps 1-11 for each queue in your auto attendant.
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